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CHAPTER-1

BASICS OF COMPUTER

OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the following about a computer system:

1.1
1.2
1.3
1.4

1.5
1.6
1.7

1.8

1.9

1.10
1.11
1.12

Computer system as a data processing tool

Basics of data processing, data processing cycle and information cycle.

Historical evolution of computers and computer generations

Working model of a digital computer and functions of a digital computer

Basic characteristics of digital computer and types of computers

Classification of digital computers

Similarities between human beings and computer system

Factors influencing performance of personal computers (PC), PC as a virtual office
Comparison between computer and calculator

STRUCTURE OF THIS LESSON

Introduction

Computer System as Information Processing System
Data Processing Cycle and Information Cycle
Generations of Computers

1.4.1 First Generation (1946-1959)

1.4.2  Second Generation (1959-1965)

1.4.3  Third Generation (1965-1971)

1.4.4  Fourth Generation (1971-1985)

1.4.5 Fifth Generation (Beyond 1985 And Till-Date)
Digital Computer and its Functioning

Characteristics of Digital Computer

Classification of Computers

1.7.1  Analog Computers

1.7.2  Digital Computers

1.7.3  Hybrid Computers

1.7.4 Difference Between Analog and Digital Computers
Classification of Digital Computers

1.8.1  Supercomputer

1.8.2 Mainframe Computers

1.8.3  Minicomputers

1.8.4 Microcomputers and its Types

Factors That Influence Personal Computers Performance
PC as a Virtual Office

Human Beings Vs Computer Systems

Difference between Computer and Calculator

1.13 Data communication Media

Summary of the Lesson
Self Assessment Questions and Exercises
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1.1 INTRODUCTION

Let us begin with the word ‘compute’, which means ‘to calculate’. We all are familiar with
calculations in our day to day life. We apply mathematical operations like addition, subtraction,
multiplication, etc. and many other formulae for calculations. Simpler calculations take less time but
complex calculations take much longer time. Another factor is accuracy in calculations. So man
explored the idea to develop a machine which can perform this type of arithmetic calculation faster
and with full accuracy. This gave birth to a device or machine called ‘computer’.

Definition of Computer

The computer we see today is quite different from the one made in the beginning. The number of
applications of a computer has increased, the speed and accuracy of calculation has increased. You
must appreciate the impact of computers in our day to day life. Reservation of tickets in Air Lines and
Railways, payment of telephone and electricity bills, deposits and withdrawals of money from banks,
business data processing, medical diagnosis, weather forecasting, etc. are some of the areas where
computer has become extremely useful.

Definition:

“A computer is an electronic machine that operates under the control of instructions, that accepts the
input data, processes or manipulates the given data according to the predefined instructions and stores
the result for future use”.

HMonitor

Lrizk drive

Floppy disk Mernory

Lazser printer Speaker

CO-ROM drive Eeyboard

Figure 1.1: Components of a Computer

It can also retrieve the stored results as and when required again. Now-a-days, data is processed with
the help of computer. This modern technique to process data is known as Electronic Data Processing
(EDP). Computer is also known as Electronic Data Processing machine.

The term data processing means:

» Arithmetic and logical operations on data to get required results.
» To send and receive information from one location to another.
» Arranging data into a specific order etc.
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1.2 COMPUTER SYSTEM AS INFORMATION PROCESSING SYSTEM

A digital computer can store, process and retrieve data as and when desired. The computer processes
data with very high speed. In addition to being very fast, computer is also very accurate in
calculations. These are the main capabilities of the computer.

Therefore, we may define computer as a device that transforms data. Data can be anything like marks
obtained by you in various subjects. It can also be name, age, sex, weight, height, etc. of all the
students in your class or income, savings, investments, etc., of a country. Computer can be defined in
terms of its functions. It can

accept data

store data

process data as desired, and

retrieve the stored data as and when required and
print the result in desired format.

Data processing is the collection and manipulation of items of data to produce meaningful
information. The term is often used more specifically in the context of a business or other
organization to refer to the class of commercial data processing applications.

Data processing i.e. manipulation of data by a computer. It includes the conversion of raw data to
machine-readable form, flow of data through the CPU and memory to output devices, and formatting
or transformation of output. Any use of computers to perform defined operations on data can be
included under data processing. In the commercial world, data processing refers to the processing of
data required to run organizations and businesses.

Data processing may involve various processes, including:

Validation — Ensuring that supplied data is "clean, correct and useful"

Sorting — "arranging items in some sequence and/or in different sets."

Summarization — reducing detail data to its main points.

Aggregation — combining multiple pieces of data.

Analysis — the "collection, organization, analysis, interpretation and presentation of data."
Reporting — list detail or summary data or computed information.

Classification — separates data into various categories.

1.3 DATA PROCESSING CYCLE AND INFORMATION CYCLE

Data processing is simply the conversion of raw data to meaningful information through a process.
Data is manipulated to produce results that lead to a resolution of a problem or improvement of an
existing situation. Similar to a production process, it follows a cycle where inputs (raw data) are fed
to a process (computer systems, software, etc.) to produce output (information and insights).

The Data Processing Cycle is a series of steps carried out to extract information from raw data.
Although each step must be taken in order, the order is cyclic. The output and storage stage can lead
to the repeat of the data collection stage, resulting in another cycle of data processing. The cycle
provides a view on how the data travels and transforms from collection to interpretation, and
ultimately, used in effective business decisions.

Generally, organizations employ computer systems to carry out a series of operations on the data in
order to present, interpret, or obtain information. The process includes activities like data entry,
summary, calculation, storage, etc. Useful and informative output is presented in various appropriate
forms such as diagrams, repo rts, graphics, etc.

3
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Data Processing Cycle

Fig. 1.2: Data Processing
Stages of the Information Cycle

1) Collection is the first stage of the cycle, and is very crucial, since the quality of data collected will
impact heavily on the output. The collection process needs to ensure that the data gathered are both
defined and accurate, so that subsequent decisions based on the findings are valid. This stage provides
both the baseline from which to measure, and a target on what to improve.

Some types of data collection include census (data collection about everything in a group or statistical
population), sample survey (collection method that includes only part of the total population),
and administrative by-product (data collection is a byproduct of an organization’s day-to-day
operations).

The Information Cycle

+* Essential data set
* Definitions
* Tools

® Information culture :Cluality
* Feedback Collect . F_le porting )
® Actions / \ Target populations
Use Process
. Interpret Analyse
. : -_
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Fig. 1.3: Information Cycle

2) Preparation is the manipulation of data into a form suitable for further analysis and processing.
Raw data cannot be processed and must be checked for accuracy. Preparation is about constructing a
dataset from one or more data sources to be used for further exploration and processing. Analyzing
data that has not been carefully screened for problems can produce highly misleading results that are
heavily dependent on the quality of data prepared.

3) Input is the task where verified data is coded or converted into machine readable form so that it
can be processed through a computer. Data entry is done through the use of a keyboard, digitizer,
scanner, or data entry from an existing source. This time-consuming process requires speed and
accuracy. Most data need to follow a formal and strict syntax since a great deal of processing power is
required to breakdown the complex data at this stage. Due to the costs, many businesses are resorting
to outsource this stage.

4) Processing is when the data is subjected to various means and methods of manipulation, the point
where a computer program is being executed, and it contains the program code and its current
activity. The process may be made up of multiple threads of execution that simultaneously execute
instructions, depending on the operating system. While a computer program is a passive collection of
instructions, a process is the actual execution of those instructions. Many software programs are
available for processing large volumes of data within very short periods.
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5) Output and interpretation is the stage where processed information is now transmitted to the
user. Output is presented to users in various report formats like printed report, audio, video, or on
monitor. Output need to be interpreted so that it can provide meaningful information that will guide
future decisions of the company.

6) Storage is the last stage in the data processing cycle, where data, instruction and information are
held for future use. The importance of this cycle is that it allows quick access and retrieval of the
processed information, allowing it to be passed on to the next stage directly, when needed. Every
computer uses storage to hold system and application software.

1.4 GENERATIONS OF COMPUTERS

The history of computer development is often referred to in reference to the different generations of
computing devices. A generation refers to the state of improvement in the product development
process. This term is also used in the different advancements of new computer technology. With each
new generation, the circuitry has gotten smaller and more advanced than the previous generation
before it. As a result of the miniaturization, speed, power, and computer memory has proportionally
increased. New discoveries are constantly being developed that affect the way we live, work and play.

Each generation of computers is characterized by major technological development that
fundamentally changed the way computers operate, resulting in increasingly smaller, cheaper, and
more powerful and more efficient and reliable devices. Read about each generation and the
developments that led to the current devices that we use today.

The term generation indicates the type of technology used in the computer construction. As new
technology was emerging, it was being used in the making of computer. The new technology
improved the speed, accuracy and storage capacity of the computers. Different technologies have
been used for computers in different times.

Therefore, computers can be divided into five generations depending upon the technologies used.
These are:

1.First Generation (1946 — 1959)
2.Second Generation (1959 — 1965)
3.Third Generation (1965 — 1971)
4.Fourth Generation (1971- 1985)
5.Fifth Generation (1985 onwards)

1.4.1 First Generation (1946-1959)

All subsequent computers after Mark [ were all electronic. The early first-generation computers were
powered by

. Magnetic drums were once use as a primary storage device but have since been implemented as
auxiliary storage devices.

Figure 1.4: Vacuum Tubes
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Remarks | Examples:

1.4.2

1.4.3

Electronic Numerical Integrator and Calculator (ENIAC),
Electronic Discrete Variable Automatic Computer (EDVAC)
Electronic Delay Storage Automatic Computer (EDSAC)
UNIVAC I

Characteristics of First Generation

Vacuum tubes

Magnetic tape and magnetic drum for external storage

Punched cards for input

Punched cards and paper for output

Machine and assembly languages

Human operators to set switches

Examples : UNIVAC I, UNIVAC II, Datamatic 100, EDSAC, Burrough 2202, etc.

Second Generation (1959-1965)

Transistors replaced vacuum tubes and ushered in the second generation computer. Transistor is a
device composed of semiconductor material that amplifies a signal or opens or closes a circuit.
Invented in 1947 at Bell Labs, transistors have become the key ingredient of all digital circuits,
including computers. Today's latest microprocessor contains tens of millions of microscopic
transistors.

Figure 1.5: Transistor

The first computers of this generation were developed for the atomic energy industry.

Characteristics of Second Generation

Transistors

Magnetic-core storage

Magnetic tape and magnetic disk for external storage

Punched cards and magnetic tape for input

Punched cards and paper for output

High-level languages- FORTRAN, COBOL, PL/I, BASIC and others

Human operators to handle cards

Examples : Honeywell 200-, 400-, 800-series, IBM 7070/7080, CDC 1604, Burrough B5000
series, etc.

Third Generation (1965-1971)

During this time integrated circuits with transistors, resistors, and capacitors were etched onto a piece
of silicon. This reduced the price and size of computers, adding to a general trend in the computer
industry of miniaturization. The development of the integrated circuit was the hallmark of the third
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generation of computers. Transistors were miniaturized and placed on silicon chips, called
semiconductors, which drastically increased the speed and efficiency of computers.

Figure 1.6: Integrated Circuits
Characteristics of Third Generation

Integrated circuits

Improved disk storage

Monitors and keyboards for input and output

More high-level languages, including RPG and Pascal

First complete operating system meant less involvement for human operators

Family of computers introduced allowing compatibility

Minicomputers used commercially

Examples: IBM System/360, IBM System/370, Burrough 5700/6700, PDP-8 Series, PDP-11
Series, etc.

1.44 Fourth Generation (1971-1985)

The microprocessor brought the fourth generation of computers, as

inte])

thousands of integrated circuits we rebuilt onto a single silicon chip. A o
"2 Qug
oy

silicon chip contained a CPU. In the world of personal computers, the terms
microprocessor and CPU are used interchangeably. At the heart of all

personal computers and most workstations sits a microprocessor.

Figure 1.7: Microprocessor

Microprocessors also control the logic of almost all digital devices, from clock radios to fuel-injection
systems for automobiles.

Three basic characteristics differentiate microprocessors:

¢ Instruction Set: The set of instructions that the microprocessor can execute.

e Bandwidth: The number of bits processed in a single instruction.

e Clock Speed: Given in megahertz (MHz), the clock speed determines how many instructions
per second the processor can execute.

Characteristics of Fourth Generation

e LSIand VLSI

e Magnetic disk most common external storage

e Introduction of microcomputers

e Fourth-generation languages (4GLs) emerged and application software for microcomputers
became popular

e  Microcomputers used - Compaq Deskpro 386

e Typical examples : Burroughs B7700 and HP 3000 minicomputers
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1.4.5 Fifth Generation (Beyond 1985 and Till-Date)

The changes that have occurred since 1985 are plentiful. Computers have got tinier, more reliable,
and many times faster. Computers are mostly built using components from many different
corporations.

Computers have become more and more online orientated in modern times, especially with the
development of the World Wide Web. Popular companies like Google and Yahoo! were started
because of the internet.

Fifth generation computing devices, based on artificial intelligence, are still in development, though
there are some applications, such as voice recognition, that are being used today. Artificial
Intelligence is the branch of computer science concerned with making computers behave like humans.
The term was coined in 1956 by John McCarthy at the Massachusetts Institute of Technology.

Characteristics of Fifth Generation

Development of true artificial intelligence
Development of Natural Language Processing
Advancement in Parallel Processing
Advancement in Superconductor Technology

Fifth generation computers are supposed to be the ideal computers. The scientists are working to
design such computers that will have the following features.

1. Having their own thinking power
Making decisions themselves

Having capabilities of learning

Having capabilities of reasoning

Having large capacity of internal storage
Having extra high processing speed
Having capabilities of parallel processing

Nowvkwh

1.5 Digital Computer and its Functioning

Modern computer systems are available in numerous physical shapes and sizes, and truly speaking
there is no end to it. In Computer System, different parts of a computer are organized in such a way
that, it helps to perform various operations to complete the given specific task. A computer is a sort of
electric brain, which capable to solve mathematical problems with in movements or produce desired
information or a controlling order.

Personal computer system .0 tor tower
o

maonitor - "\

inkjet printer

external
speaker
\
,

"

lasar printar

computer
internal
layout

Figure 1.8: Basic Components of a Digital Computer

All modern digital computers consist of three main components. These are indicated in the block
diagram (Fig. 1.9).
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Fig. 1.9: Model of a Digital Computer

Let us now study the organisation and function of each unit in detail.
L. Input unit

A unit provided to supply data to the computer is called Input Unit. This unit is also called Input
Devices Unit and uses devices like mouse, lightpen, keyboard etc. to transfer data/information to the
computer directly or may collect data on magnetic disks and tapes and later transfer it to the system.

Peripherals is the term applied to all devices that are connected to the CPU but are not part of the
CPU. These include the Input/Output (I/O) and mass storage devices and other computer devices such
as analog-to-digital converters. The collection of all peripheral equipments is called the computer
configuration.

There are two types of peripherals given as under:
i) Off-line Peripheral and
ii) On-line Peripheral.

Auxiliary devices that are not directly connected to the CPU, such as keypunches, card sorters, and so
on. These are called off-line devices. The term on-line devices refers to equipment that is connected
to the CPU.

I1. Central Processing Unit (CPU)

This unit is called the brain or heart and soul of the computer system. It comes in different shapes viz.
Vertical CPU, Mid-Tower, Horizontal CPU, etc. Few popular CPU types are shown in Fig. 1.10.
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(a) Mid Tower CPU (b) Vertical CPU
Fig. 1.10: Few Popular CPU Shapes
It has the following three sub-units:

i) Primary Storage Unit (or Memory Unit)
i1) Arithmetic & Logic Unit (ALU)
iii) Control Unit

a) Primary Storage Unit

We are already aware that the computer is capable of storing data/instruction/information into it.
Where does the data get stored? The answer to this question is the memory unit. Memory is a part of
the microcomputer that holds data for processing, instructions for processing the data and information
i.e. processed data.

As we have different types of data to be stored, this memory unit has four major logical areas, which
are not shown in the figure to avoid complexity.

i) Input Storage Area

The input data does not straight away go to the processor. It is first stored in this area till the
processor asks for it.

ii) Working Storage Area

‘Working storage area’ is like a sheet of scratch paper. When the data is being processed, there are
some intermediate results that are not required as output but are required to obtain the output. Such
results are stored in working storage area.

iii) Output Storage Area

The final output is not taken by the output devices immediately but is stored in memory till the output
device is ready to receive it. Thus an ‘output storage area’ holds the finished results of the
processing operations until they are released on the output device.

iv) Program Storage Area

In addition to above, the primary storage also contains a ‘program storage area’. The instructions
for data manipulation are stored in this area.

b) Arithmetic & Logic Unit (ALU)

This unit is capable of performing arithmetic operations and logical operations on the data stored in
storage area. The basic arithmetic and logical operations include addition, subtraction, multiplication,
division, ORing, ANDing, NOT (complementing), increment, decrement, shifting, clearing
operations, etc. The data is transferred to ALU for processing and the intermediate results and final
results are transferred to the storage area.
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¢) Control Unit

This unit controls the operation of each unit of computer system by issuing control signals on the
basis of instructions provided to the computer as a program. So this unit can be called the central
nervous system of the computer. This unit generates timing and control signals necessary for
execution of instructions. It provides status, control and timing signals necessary for the operation of
other parts of the CPU, memory, and 1/O devices. It controls the entire operation of the computer. It is
actually the control section of the CPU, which acts as the brain of a computer.

II1. Output Unit

The result generated by CPU is either transferred directly or from the output area of the memory to
the output devices like visual display units (VDU) or printers, etc.

Mass Storage Devices

The primary storage area of the computer is limited in size and is expensive. Only, the frequently
required instructions are stored in it. To supplement this limited memory, we use auxiliary or
secondary storage devices like magnetic tapes and disks. The data can be transferred to/from these
devices by the processor at a very fast speed. But as compared to primary storage, secondary storage
is slow. But the advantage of secondary storage devices is that apart from being cheap, they are
transferable which primary storage is not. There is no limit to secondary storage memory. This can be
compared to human beings who use a note-book or pocket-diary to store the notes to supplement the
brain.

1.6 CHARACTERISTICS OF DIGITAL COMPUTER

Now-a-days computer is playing a main role in everyday life it has become the need of people just
like television, telephone or other electronic devices at home. It solves the human problems very
quickly as well as accurately. The important characteristics of a computer are described below:

1. Speed 8. Versatility
2.Arithmetical & Logical Operations 9. Communications
3. Accuracy 10. Diligence

4. Reliability 11. No Feelings

5. Storage 12. Consistency

6. Retrieving data and programs 13. Precision

7. Automation

1.7 CLASSIFICATION OF COMPUTERS

Though in general we use digital computers, however, present day computers may be classified into
three categories:

e Analog e Digital e Hybrid
1.7.1 Analog Computers

Analog computers are computers which work on the basis of continuous measurement of physical
quantities, e.g. pressure, voltage, current, temperature, current, length, etc. We can quote a number of
instruments that work on the principles of an analog computer.

Limitations of Analog Computers

o These don’t have logical facilities afforded by programming
e Don’t have the ability to store data in large quantities
e Cost of implementation of computation is very high

Examples : Thermometer, Speedometer, Wall-clock, Voltmeter, Ammeter, etc.

11
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Digital Computers

Digital computers are computers which represent data in terms of discrete number and processes data
using the standard arithmetic operations. These computers directly operate on numbers and produce
precise results. These are used in a unlimited number of applications. The basic differences between
analog and digital computers are listed in Table No. 1.1.

We will be concerned with digital computers only because of the following reasons :

1.7.3

Design features of Analog and Digital computers can be combined to create a Hybrid Computer. Such

The tasks that can be done on analog computers can also be done on digital computers while
the reverse is not true.

To understand the calculations made by an analog computer, some mathematical background
is necessary, whereas digital computer can be used and understood without much

mathematical background.
The digital computer is used extensively in many areas of application.
Hybrid Computers

computers are used for special applications only. Examples of such computers include:
Chemical Process Control

e Patient Monitoring System
e Electronic Calculating Scale
e Missile Guidance Computer
e Flight Simulators For Training Air-plane Pilots
e Petroleum Distillation Monitoring Systems
1.7.4 Difference between Analog and Digital Computers
Table 1.1 : Analog Vs. Digital Computer
S.No Analog Computers Digital Computers
1. Represent continuous measurement Represent numbers by discrete coded
of physical quantities e.g. rotation, patterns
voltage, temperature, etc.
2. Accuracy is quite limited Unlimited accuracy
3. Represent physical or mathematical | Represent numbers, letters and other
quantities symbols
4. Data-storage scattered in various Data-storage concentrated in space,
non-interchangeable devices interchangeable and unlimited in duration
5. Distinct elements used for each operation | Identical elements used in sequence
6. Sets up analogy of problem Breaks down problem into arithmetic
operations
7. Best-suited to represent measurable Best suited to handle discrete random
quantities and simulate response of processes, statistical data, and numerical
physical systems by mathematical problems of business and scientific
analogies nature
8. Serves as model and mirrors relations | Digital computer compounds arithmetic
of actual system data, unrelated to system it represents
9. Operations usually carried out in Time of operations usually does not
real-time of physical system correspond to real-time.
10. Relatively few devices used and Many devices needed and difficult
easier programming programming
11. Basic operation performed by Operation performed by relatively many
relatively few ‘single-purpose’ interchangeable arithmetic devices such
devices (integrators, multipliers, as adders, registers, accumulators, etc.
magnitude-comparators, etc.
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1.8 CLASSIFICATION OF DIGITAL COMPUTERS

There is a wide variety of computers in the market today which differ in terms of physical size, price,
capacity, and performance. The variety is so wide that it is sometimes difficult to see those elements
that are shared by many computers and those elements that tend to differ among computers.

Depending upon their speed and memory size, computers are classified into following four main
groups.

1. Supercomputer 3. Mini computer
2. Mainframe computer 4. Microcomputer

This classification implies differences between classes between in one or more characteristics. In the
1960s, before the microcomputer, there was a clear-cut distinction between minicomputers and
mainframes. The most important characteristics that could be used to differentiate the two types of
computers were :

e Speed e Physical size

e Instruction sizes e Cost

e Number of CPU registers e Virtual address space

e  Word Length e Secondary Memory Size

e Main Memory Size e Degree of Multiprogramming
e Complexity of I/O modules

e Operating System Complexity

1.8.1 Supercomputer

Supercomputer is the most powerful and fastest, and also very expensive. It was developed in 1980s.
It is used to process large amount of data and to solve the complicated scientific problems. It can
perform more than one trillions calculations per second. It has large number of processors connected
parallel. So parallel processing is done in this computer. In a single supercomputer thousands of users
can be connected at the same time and the supercomputer handles the work of each user separately.

Supercomputers are mainly used for:
» Weather forecasting.
» Nuclear energy research.
» Aircraft design.
» Automotive design.
» To control industrial units.

A supercomputer is shown in Fig.1.11.
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Fig. 1.11: Super Computer

Examples :

e CRAY X-MP/14, X-MP/24, X-MP/48 e NEC (NEC SX-3)

e CRAY Y-MP, Y-MPC e IBM 3090 (with vector)
e CRAY2 e Fuyjitsu (VP Series)

e CRAY3 e Hitachi (HITAC S-300)
e ETA (EDC-ETA 10, ETA 20) e PARAM,

e C-DAC’s PARAM etc.

1.8.2 Mainframe Computers

The mainframe remains a distinct class of computers and are very powerful large general purpose
computers. Large organisations use mainframe computer. Some of the key differences between the
high end of mainframe class and the high end of the minicomputer class are there. One of the most
dramatic differences is the speed of the two classes.

Fig. 1.12: Mainframe Computer

Examples :

e DEC’s VAX-8350, -8650
e HP 9000 Model 870S/400, Model 870S/300
e IBM 4300 Series (small to medium-size models)



Basics of Computer

IBM 308X Series (large models)

Latest model IBM 3090 Series (IBM 3090/600 installed in 1988)
IBM Enterprise System/9000 Series

ICL Series

MEDHA Series

Sperry Series; etc.

1.8.3 Minicomputers

Minicomputers are faster and more powerful than microcomputers. The word-length of these
computers is usually 32-bits or more. A minicomputer can support up to 64 or even 100 terminals.
Minicomputers can support a greater variety of fast peripheral devices. Minicomputers are
extensively used for multi-user and interactive applications in colleges, universities, research
organisations, government organisations, industries and so on. These are also used for sophisticated
real-time Industrial controls and interactive engineering design work.

Examples :

Wipro S-68030V and S-68033V built around Motorola 68030 CPU

HP 9000 series 800 (a Supermini) built around HP’s VLSI RISC Processor
HCL Magnum built around 68030 and 68040 CPUs

IBM AS/400/B60 (installed in 1988)

DEC’s VAX 8842 (installed in 1988)

e Wipro LandMark 860 (a Supermini) built around Intel’s 64-bit RISC processor 1860 CPU,
and so on.

The capabilities of a minicomputer are between mainframe and personal computer. These computers
are also known as midrange computers.

The minicomputers are used in business, education and many other government departments.
Although some minicomputers are designed for a single user but most are designed to handle multiple
terminals. Minicomputers are commonly used as servers in network environment and hundreds of
personal computers can be connected to the network with a minicomputer acting as server like
mainframes, minicomputers are used as web servers. Single user minicomputers are used for
sophisticated design tasks.

The first minicomputer was introduced in the mid-1960s by Digital Equipment Corporation (DEC).
After this IBM Corporation (AS/400 computers) Data General Corporation and Prime Computer also
designed the mini computers.

1.8.4 Microcomputers and its Types

The microcomputers are also known as personal computers or simply PCs. Microprocessor is used in
this type of computer. These are very small in size and cost. The IBM’s first microcomputer was
designed in 1981 and was named as IBM-PC. After this many computer hardware companies copied
the design of IBM-PC. The term “PC-compatible” refers any personal computer based on the original
IBM personal computer design.

On the basis of cost and performance, personal computers can be classified as :]

Personal Computer (PC)

Personal Computer with Extended Technology (PC/XT)
Personal Computer with Advanced Technology (PC/AT)
Super AT or Super Micro
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Personal Computer (PC)

PC is the simplest and cheapest type of personal computer. It uses Intel 8086/8088 as CPU, 640 KB
RAM, 8KB ROM and normally two floppy disk drives. One of the drives is normally meant for
holding bootable floppy diskette and the second one is used for holding the application package as
well as for secondary storage. This type of computer does not contain any hard-disk. It is a single-user
system. Its ROM can be extended from 8KB to 64 KB. It uses MS-DOS operation system. It may also
employ 8087 math co-processor.

PC/XT

This type of computer contains hard-disk(s) as well as floppy disk drive i.e. 360 KB/1.2 MB. Its cost
is obviously more than the PC due to additional components. It is also a single-user system. [ts ROM
can also be extended up to 64 KB. It also normally uses MS-DOS operation system. It may also
employ 8087 math co-processor.

PC/AT

It contains 80286 as CPU, 640 KB RAM (can be expanded to 4 MB), 64 KB ROM (can be expanded
to 128 KB), hard-disk drive and floppy-disk drive (360 KB/1.2 MB). Microprocessor 80286 is more
powerful than the microprocessors of PC and PC/XTs. Up to 4 terminals can be connected to PC/AT
to make it multi-user system by using XENIX as an operating system. Hard-disk capacity may lie in
the range 20-80 MB. It uses 80287 math co-processor. Processing speed of PC, PC/XT and PC/AT
lies in the range 1-5 MIPS.

Super AT (or Super micros)

These computers use a 32-bit CPU such as Intel 80386 or 80486. The processing speed of 80386 and
80496 may range from 3 to 5 MIPS and 12 MIPS at 25 MHz respectively. RAM size of these lie in
the range 2-8 MB. In case of 80386 microprocessor, it can be extended up to 32 MB and in case of
80486 up to 64 MB. Hard-disk capacity of these lies in the range 200 MB-780 MB. Normally, UNIX
is used as a multi-user operating system on these systems. 80386 CPU offers the connectivity up to 8-
12 terminals whereas 80486 offers the connectivity up to 16-64 terminals.

Personal computers are available in two models. These are:
1.Desktop PCs 2. Tower PCs
A desktop personal computer is most popular model of personal computer. The system unit of the

desktop personal computer can lie flat on the desk or table. In desktop personal computer, the monitor
is usually placed on the system unit.

Another model of the personal computer is known as tower personal computer. The system unit of the
tower PC is vertically placed on the desk of table. Usually the system unit of the tower model is
placed on the floor to make desk space free and user can place other devices such as printer, scanner
etc. on the desktop. Today computer tables are available which are specially designed for this
purpose. The tower models are mostly used at homes and offices.

Microcomputers are further divided into following categories.
1.Laptop computer 2.Workstation 3.Network computer 4.Handheldcomputer
Laptop computer

Laptop computer is also known as notebook computer. It is small size (85-by-11 inch notebook
computer and can fit inside a briefcase. The laptop computer is operated on a special battery and it
does not have to be plugged in like desktop computer. The laptop computer is portable and fully
functional microcomputer. It is mostly used during journey. It can be used on your lap in an airplane.
It is because it is referred to as laptop computer.
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Workstations

Workstations are special single user computers having the same features as personal computer but
have the processing speed equivalent to minicomputer or mainframe computer. A workstation
computer can be fitted on a desktop. Scientists, engineers, architects and graphic designers mostly use
these computers.

Workstations use sophisticated display screens featuring high-resolution color graphics and operating
systems such as UNIX, Windows NT, 95, 98 those permitted multitasking. Workstations also use
powerful networking links to other computers.

Most significant feature of workstations is the powerful processor which churns out results much
faster than the PCs.

Examples : Sun-, Apollo-, Hewlett-Packard-, NeXT- and IBM-workstations.
Network Computers

Network computers are also version of personal computers having less processing power, memory
and storage. These are specially designed as terminals for network environment. Some types of
network computers have no storage. The network computers are designed for network, Internet or
Intranet for data entry or to access data on the network. The network computers depend upon the
network’s server for data storage and to use software. These computers also use the network’s server
to perform some processing tasks.

Handheld Computer

In the mid 1990s, many new types of small personal computing devices have been introduced and
these are referred to as handheld computers. These computers are also referred to as Palmtop
Computers. The handheld computers sometimes called Mini-Notebook Computers. The type of
computer is named as handheld computer because it can fit in one hand while you can operate it with
the other hand. Because of its reduced size, the screen of handheld computer is quite small. Similarly
it also has small keyboard. The handheld computers are preferred by business traveler. Some
handheld computers have a specialized keyboard. These computers are used by mobile employees,
such as meter readers and parcel delivery people, whose jobs require them to move from place to
place.

The examples of handheld computers are:
1.Personal Digital Assistants 2.Cellular telephones 3.H/PC Pro devices
Personal Digital Assistants (PDAs)

The PDA is one of the more popular lightweight mobile devices in use today. A PDA provides
special functions such as taking notes, organizing telephone numbers and addresses. Most PDAs also
offer a variety of other application software such as word processing, spreadsheet and games etc.
Some PDAs include electronic books that enable users to read a book on the PDA’s screen.

Many PDAs are web-based and users can send/receive e-mails and access the Internet. Similarly,
some PDAs also provide telephone capabilities.

Cellular phones

A cellular phone is a web-based telephone having features of analog and digital devices. It is also
referred to as Smart Phone. In addition to basic phone capabilities, a cellular phone also provides the
functions to receive and send e-mails & faxes and to access the Internet.

H/PC Pro Devices

H/PC Pro dive is new development in handheld technology. These systems are larger than PDAs but
they are not quite as large as typical notebook PCs. These devices have features between PDAs and
notebook PCs. The H/PC Pro device includes a full-size keyboard but it does not include disk. These
systems also have RAM with very low storage capacity and slow speed of processor.
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1.9 FACTORS THAT INFLUENCE PERSONAL COMPUTERS PERFORMANCE

There are several factors that influence the performance of computer systems. Few of these factors
are discussed as under:

1. The CPU

High performance, compatibility and upgradability are features that are quite important. The higher
the generation of the processor, the better it is. So processor speed is one of the main factors that
influence the performance.

2. Clock rate

Since any step of processing can happen only on the "tick" of the clock (called clock cycle), the faster
the rate the quicker the CPU works. The Pentium processors have the ability to execute multiple
instructions per clock cycle due to the fact that the Pentium processor's two pipelines can execute two
instructions simultaneously. If other modules of the system require more than one clock pulse, the
CPU has to wait for them to keep up. This is called a wait state.

3. Random Access Memory (RAM)

It does not make much sense to have a fast processor if you don’t have fast RAM. But note that faster
RAM is more expensive.

The amount of RAM is also important. The benefits of adding more RAM include letting you open
more applications at the same time, and working with large files or documents. More memory may
also make your machine run much faster.

4. Computer Internal Cache

Internal cache is a storage area for frequently used data and instructions. The processor contains an
internal cache controller that integrates the cache with the Central Processing Unit (CPU). The
controller stores frequently accessed RAM locations to provide faster execution of data and
instructions and therefore a larger cache leads to the perception of a faster CPU

L1 Cache: The bigger the on-chip cache size, the better since more instructions and data can be
stored on the chip, reducing the number of times the processor has to access slower, off-chip memory
areas to get data. For example, Intel has doubled on-chip cache size to 32K on the Intel Pentium
processor with MMX technology.

L2 Cache: System memories composed of dynamic RAM (DRAM) alone have not been able to keep
up with the dramatic increases in CPU speeds over the years. In order to optimize the memory
performance in these systems, designers are implementing architectures using cache memory,
resulting in speed increases up to 45%.

5. Data bus type and size

The data bus is the highway that carries information between the processor and the memory
subsystem. The wider the data bus, the more information it can transfer. Because of its external 64-bit
data bus, the Pentium processor can transfer data to and from memory at rates up to 528
Mbytes/second.

The PCI local bus greatly improves 1/O performance. It can transfer data between the processor and
the peripherals at up to 132 MB/second, far faster than the ISA bus rate of 5 MB/second.

6. Hard disk capacity and seek time

High-performance hard drives have at least 1.2 G of capacity, provide an average seek time of 12
milliseconds, a 128 to 256 K hard disk buffer cache with both write-caching and read-caching
capabilities, and spin about 4,500 rotations per minute.



Basics of Computer

7. Videocard

A full-featured PCI-compliant VGA card, with at least 1 to 2 MB of video RAM, will further
accelerate graphics performance.

8. CD-ROM drive speed

At the time of writing of these notes the slowest CD-ROM drive available on the market is quad
speed. It may be enough, if you are not running applications from CD-ROM, but only installing them.
Otherwise look at octal or ten-speed technologies.

9. MMX processors

Multimedia extensions processors (MMX) is designed specifically to support media-rich software and
communications applications.. The Pentium processor with MMX technology will give a better,
smoother and more realistic multimedia experience. These processors have got 57 powerful new
instructions specifically designed to manipulate and process video, audio and graphical data
efficiently. However, your system will require software designed for MMX technology (old software
must be recompiled to take advantage of new MMX features).

1.10 PC AS A VIRTUAL OFFICE

Virtual office is a broad term that refers to work environment that is delivered and accessed through
Web-based communication and computing technologies.

A virtual office replaces the workspace with cyberspace. Such an office employs Web-based IT
services that are used for the initiation, execution and operation of typical office processes.

Virtual office is a business location that exists only in cyberspace. A virtual office setup allows
business owners and employees to work from any location by using technology such as laptop
computers, cell phones and internet access. A virtual office can provide significant savings and
flexibility compared to renting a traditional office space. Meetings can be conducted via
teleconferencing and video conferencing, and documents can be transmitted electronically. Some
companies even provide virtual office services to give virtual offices the prestige associated with
physical offices, such as an important-sounding address, a professional phone-answering service and
even occasional rental of office space and conference rooms.

If the business has employees, each employee can work from the location that is most convenient for
him or her, and the business is not restricted to hiring employees that live locally. The virtual office
arrangement thus expands job options for employees and hiring options for businesses.

Virtual Office Desktop is a comprehensive unified communications client application that integrates a
business softphone with visual voicemail, corporate directory, instant messaging, presence, video
calling, fax, call recording, web conferencing, and social media.

1.11 HUMAN BEINGS VS COMPUTER SYSTEMS

We have already gone through the anatomy of a digital computer and functioning of a computer
system using its various components. Besides, we are also well versed and aware with the functioning
of human-beings using its various organs.

Processing of data by hand is satisfactory only when the amount of data to be processed is small and
also the manual data processing is slow, monotonous and often subject to error. Human-beings
utilises past experiences and intuitions for decision making whereas computer follows an algorithmic
procedure. Human-beings as a decision maker utilises heuristic. Society will benefit most if
complementary strengths of human beings and computers are utilised. Definitely, computers today
have more intelligence than in the past and the strides are being made to increase machine
capabilities.
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The Newell-Simon model suggests that there are limitations on the ability of human as information

Pprocessors
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One set of limits concerns the processing of data and is directly related to short-term

memory

Comp uter Applications in Business

Another set of limits is the ability of humans to detect differences

Humans are also limited in their ability to generate, integrate, and interpret probabilistic

data.

Functional similarities of a computer system with human being is in the following Table 1.2.

Table 1.2 :Computer Vs. Human-being (Similarities)

S.NO. Comuter Element Purpose Human-Being

1. Input Used to receive data and | Input to the system is
instructions in computer- | through ears, eyes, mouth
compatible form or nose

2. Main Storage Used to hold input data and | Data and instructions are
instructions  temporarily | stored in brain and can be
before it is processed recalled whenever needed

3. Secondary Storage Used as an extension to | Use pocket-diaries,
main storage and the | notebooks, etc. to store
contents stored in it are | contents for permanent
retained permanently use.

4. ALU Used to carry out| Portion of our brain is
arithmetic  and  logical | used to carry out
computations desired in an | comparisons and
instruction execution calculations for helping

out in logical judgements

5. Control Unit Used to receive stored | Our brain controls our mental
instructions  in  serial | or body actions on the basis
fashion and one at a time. of calculations and
Interpret each instruction comparisons.
and prompt its execution | Before taking any action, the
by one of the units like | old results stored in brain are
input, output, storage or | also referred to and thus brain
ALU. acts as a CPU.

6. Output Used to give out results via | Output is either in the
a suitable device e.g. VDU, | form of a speech using
printer, plotter, etc. mouth or some action e.g.

writing, gesture, body
language, etc.
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1.12 DIFFERENCE BETWEEN COMPUTER AND CALCULATOR

Every electronic calculating device -- from the humble four-function calculator to the most powerful
supercomputer --runs from the same basic computation technique, which are based on Boolean
algebra. At their most basic functions, computers and calculators use binary arithmetic, and do
translation to decimals at their last step before they're displayed. In spite of sharing the same
fundamentals, calculators and computers have a divergent history.

Table 1.3 :Computer Vs. Calculator

S.No. Computer Calculator

1. Calculators  are  single-purpose | Computers are calculators that have vastly
devices that perform mathematical | expanded capabilities, and are often called
operations input by the user. "general purpose computing devices."

2. A computer is an automatic | A Calculator is an electronic device that

electronic machine which performs | calculates accurately and at a very high speed.
operations at a very high speed and
with great accuracy.

3. A computer can work with numbers | A calculator can work only with numbers.
and words both.

4, A computer can store and execute | Calculator usually requires manual input for
aset of instructions for performing | every operation it performs

a series of manipulations on the input
data

5. A computer can store large volume A calculator is not capable of storing data
of data in its memory and reproduce
any part of it, as and when needed.

1.13 Data Communication Media

Data communication simply means to exchange of data between a source and a receiver. It
occursusing some kind of transmission media.

The source is the device that transmits the data whereas the receiver receives the
transmitted data. Main objectives of data communication are the transfer of data and
maintenance of the data during the transmitting process.

Data (singular- Datum) mean the statistical facts and information exist in various forms
such as text, numbers, audio, video, bits, bytes, etc. which are then processed.

The Figure is showing a simple data communication system:

Input Transmithed Rocaived Chatpul
data slgnal signal data
———| Transmitter |————— Tmm":'ﬂ::'}" |  Rochiver |——

Simpie Data Communication Systemn
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Components of data communication system:
A communication system has following components:
Message: The actual information or data that is to be communicated is referred as Message.
1. Sender: It is the device that generates a message and then sends that message.

ii.  Receiver: The device that receives the message is called as the receiver. Generally
the location of receiver is different from that of sender.

iii. Medium: It is the channel or some physical route via which the message is
communicated from sender to the receiver. The medium can be wired or wireless.

iv.  Protocol: It is a particular set of rules and regulations that govern the
communication. A protocol performs the following functions:

1. Data sequencing. It refers to the breaking a long message into smaller packets of a
fixed size.

2. Data routing. It defines the most efficient path of communication.

3. Data formatting. Data formatting rules identify the group of bits/characters within
a fixed packet that constitute data, control or other information.

4. Flow control. It governs the balance and controls the transmission between a
faster sender & slower receiver and vice-versa.

5. Error control. These rulesare intended to detect errors in messages. These also
ensure the transmission of correct messages.

6. Precedence and order of transmission. All the nodes should get a chance to use
the communication lines orderly.

7. Connection establishment and termination.
8. Data security. This prevents access of data by any unauthorized user.

9. Log information. This consists of all works and data communications tasks that
have taken place.

The effectiveness of data communications depends on following:

1. Delivery: The data must be delivered in correct order and to correct target.
2. Accuracy: Accurate data must be delivered.
3. Timeliness: The data must be delivered timely.

Transmission media or Communication Channel is a path that transmits the data
or information from the sender to the receiver. Generally the data is transmitted through
electrical or electromagnetic signals which can be transmitted through copper wires, optical
fibres, atmosphere, water, vacuum, etc.

Types of Transmission Media

Transmission media is broadly classified into two groups.

A). Wired or Guided Media or Bound Transmission Media: Here the tangible cables
having the physical existence are used. E.g. Unshielded Twisted Pair (UTP) cable, shielded
twisted pair (STP) cable, co-axial cable, fibre optical cable. Each cable has its own
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characteristics like transmission speed, appearance, cost, etc. These media are bounded by
physical geography. A two-wired transmission line is considered to be the simplest of all
transmission media.

B). Wireless or Unguided Media or Unbound Transmission Media: Nowadays gaining
popularity, unguided transmission media transmit the data without using any cable. These
media are not bounded by physical geography. E.g. Wireless LANs. The wireless
transmission uses Microwave, Radio wave, Infra-red, Satellite.

Communication Media

* *
Wired/Guided WirelessUngulded l
*‘ b }' + -
Twisted pair | |Coaxial Cable| |Optical fibers Haﬂlnw&msl | Mlcruwml 1 Infrarad 1

The data transmission depends on following factors are:

1. Bandwidth. Communication channels with higher bandwidth maintain higher data
transmission rates.

2. Radiation. Due to some unwanted electrical disturbances of the medium there
may be leakage of signal from the medium.

3. Noise Absorption. The exposure of the media to external electrical noise may
cause false data signal.

4. Attenuation. Radiations and physical characteristics of the media causes the
attenuation i.e. loss of energy which depends on frequency.

SUMMARY OF THE LESSON
You learnt the following in this lesson:

e A computer is an electronic machine that operates under the control of instructions, that
accepts the input data, processes or manipulates the given data according to the predefingd
instructions and stores the result for future use.

e In Dark Age (5000 B.C. - 1890 A.D.), all the computing devices were manual-mechanical in
nature and all the earliest data processing equipment were all manual-mechanical devices.

e In Middle Age (1890-1944), all computing devices were electro-mechanical in nature

e In Modern Age (SINCE 1944), computers changed over time; they improved in speed, pow¢
and efficiency.

-

&=

o The computers can be divided into five generations depending upon the technologies use
These generation are:

First Generation (1946 — 1959) o Fourth Generation (1971- 1985)
Second Generation (1959 — 1965) o Fifth Generation (1985 onwards)
Third Generation (1965 — 1971)

e Modern computer systems are available in numerous physical shapes and sizes, and truly
speaking there is no end to it.
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The important characteristics of a computer are speed, arithmetical and logical operations,
accuracy, reliability, storage, retrieving data and programs, automation, versatility,
communications, diligence, no feelings, consistency and precision

Though in general we use digital computers, however, present day computers may be
classified into three categories — Analog, Digital and Hybrid.

Digital computers are computers which represent data in terms of discrete number and
processes data using the standard arithmetic operations

Design features of Analog and Digital computers can be combined to create a Hybrid
Computer. Such computers are used for special applications only.

Depending upon their speed and memory size, computers are classified into four main groups
— Supercomputer, Mainframe computer, Mini computer and Microcomputer.

The examples of handheld computers are Personal Digital Assistants and Cellular telephones.

Processing of data by hand is satisfactory only when the amount of data to be processed is
small and also the manual data processing is slow, monotonous and often subject to error.

Human-beings utilises past experiences and intuitions for decision making whereas computer
follows an algorithmic procedure. Human-beings as a decision maker utilises heuristic.

There are several factors that influence the performance of computer systems. Few of these
factors include CPU, Clock rate, Random Access Memory (RAM), Data bus type and size,
Hard disk capacity and seek time, Videocard, CD-ROM drive speed, MMX processors, etc.

Virtual office is a broad term that refers to work environment that is delivered and accessed
through Web-based communication and computing technologies.

SELF ASSESSMENT QUESTIONS AND EXERCISES
What is a Computer ? What capabilities does a computer possess ?
How do analog computers differ digital computers ?
State the criteria for classification of digital computers.
Is digital computer more accurate than analog computer ? Justify your answer.
Discuss the important features of micro, mini, mainframes and super-computers.
What are the operations that a computer is able to perform ?
How do you compare human beings and computers?

What are the fundamental components of a computer system ? Which component of a
computer system executes the program ?

Why are microcomputers so popular in comparison to other computers ?

. What is a digital computer ? Provide its anatomy and explain the functioning of such a

computer through its block diagram.

What factors influence the performance of a computer?

What do you mean by ‘PC as Virtual Office’? Justify your answer.

Is a computer more intelligent than human-beings ? Justify your answer.
What are supercomputers and where are they used ?

What are different types of portable computers ?



CHAPTER-2

INPUT/OUTPUT DEVICES AND OTHER HARDWARE
OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the basic concepts of peripheral devices as well as
important hardware components as under:

e Input/Output concepts
Input devices
o Commonly used input devices such as Keyboards, Mouse, Joysticks, Trackballs,
Touch Screens, Light Pens, Touch Pad, Digitizer, Voice Systems and Scanners
e Output devices
o Commonly used output devices such as Monitors, Printers and Plotters
e  Other important hardware such as -
o Motherboard, RAM, Video Card, Digital storage, Power Supply Unit, Expansion
Cards, Sound Card, Network card, etc.
e Communication devices and other hardware
e Configuration of hardware peripherals

STRUCTURE OF THIS LESSON

2.1 Introduction
2.2 Input Devices
2.2.1 Keyboards
2.2.2 Mouse
2.2.3  Joysticks
2.2.4  Trackballs
2.2.5 Touch Screens
2.2.6  Light Pens
2.2.7 Touch Pad
2.2.8 Digitizer
2.2.9 Voice Systems
2.2.10 Scanners
2.3. Output Concepts
2.4 Output Devices
2.4.1 Monitors
2.4.1.1 CRT Monitor
2.4.1.2 Flat Panel Displays
2.4.1.2.1 LCD (Liquid Crystal Display) Monitors
2.4.1.2.2 TFT Monitor
2.4.1.2.3 Plasma Display Panel
2.4.2  Printers
2.4.2.1 Categories of Printers

2422 Character Printers
2.4.2.3 Daisy-Wheel Printer
2424 Dot-Matrix Printer
2.2.4.5 Line Printers

2.4.2.6 Page Printers
24.2.7 Laser Printer

24238 Inkjet Printer
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2.4.3 Plotter

24.3.1 Drum Plotter
2432 Flatbed Plotter
2.43.3 The Inkjet Plotter
2434 Led Plotter

2.4.4  Projector
2.5 Other Computer Peripherals and Hardware
2.6 Communication Devices
2.7 Configuration of Hardware Devices
Summary of the Lesson
Self Assessment Questions and Exercises

2.1 INTRODUCTION

A computer peripheral is any external device that provides input and output for the computer. For
example, a keyboard and mouse are input peripherals, while a monitor and printer are output
peripherals. Computer peripherals, or peripheral devices, are sometimes called "I/O devices" because
they provide input and output for the computer. Some peripherals, such as external hard drives,
provide both input and output for the computer.

2.2 INPUT DEVICES

An input device is any hardware device that sends data to the computer, without any input devices, a
computer would only be a display device and not allow users to interact with it, much like a TV.
Following continuing research in the field of computer hardware, we have a large number of input
devices. Recall that before data can be processed by the computer, they must be translated into
machine-readable form and entered into the computer by an input device.

Many input devices can be classified according to:

Modality of input (e.g. mechanical motion, audio, visual, etc.)

e The input is discrete (e.g. key presses) or continuous (e.g. a mouse's position, though
digitized into a discrete quantity, is fast enough to be considered continuous)

e The number of degrees of freedom involved (e.g. two-dimensional traditional mice, or
three-dimensional navigators designed for CAD applications)

Pointing devices, which are input devices used to specify a position in space, can further be classified
according to:

e  Whether the input is direct or indirect. With direct input, the input space coincides with
the display space, i.e. pointing is done in the space where visual feedback or the cursor
appears. Touch Screens and light pens involve direct input. Examples involving indirect
input include the mouse and trackball.

e Whether the positional information is absolute (e.g. on a touch screen) or relative (e.g.
with a mouse that can be lifted and repositioned)

Note that direct input is almost necessarily absolute, but indirect input may be either absolute or
relative. For example, digitizing Graphics tablets that do not have an embedded screen involve
indirect input and sense absolute positions and are often run in an absolute input mode, but they may
also be setup to simulate a relative input mode where the stylus or puck can be lifted and repositioned.

Here, we list a variety of input devices:

e Punched Cards and Card Readers e Mouse

o Keyboards e Touch Screens
e Joysticks e Light Pens

e Trackballs e Touch Pad
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e Digitizer e Point-of-Sale Terminals
e Voice Systems e Barcode reader
o Key to Magnetic Media e Digital camera
e Financial Transaction Terminals e Microphone
e Machine Vision Systems e MIDI keyboard
e Source Data Input e Mouse (pointing device)
e Magnetic-ink Character e Remote
Recognition (MICR) e Scanner
e Magnetic Strips e Webcam

e Optical Recognition
Few popular and commonly used input devices are briefly described below.

2.2.1 Keyboards

A keyboard is one of the today's most common and familiar input device. A keyboard's primary
function is to act as an input device. The computer keyboard is used to enter text information into
the computer, as when you type the contents of a report.

Figure 2.1: Keyboards

2.2.2 Mouse

Mouse is a pointing device and it has been around us for more than 20 years. The mouse usually
contains one to three buttons; as the user rolls it on a flat surface, the mouse controls cursor
movement on the screen. When the user presses one of the buttons, the mouse either marks a place on
the screen or makes selections from data on the screen.

Different types of mouse are shown in Fig. 2.2.

(a) Simple Mouse (b) Cordless Mouse (c) Ball-point Mouse
Fig. 2.2: Different Types of Mouse
Advantages
e [t is simple device and very easy to use.
e [t is not that very expensive.
e [t moves the cursor faster than the arrow keys of keyboard do.

Disadvantages

e The movement of the cursor is not very sensitive to movement of mouse.
e [fthe contact between wheels and mouse pad is lost, the cursor does not move.
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2.2.3 Joysticks

A joystick is also a pointing device. It is used to move the cursor position on a CRT screen. Its
function is similar to a mouse, except that with a mouse the cursor stops moving as soon as you stop
moving the mouse. A joystick is a stick which has spherical ball at its lower end as well as at its upper
end. A joystick uses a lever to control the position of the cursor. It internally translates the lever
position and speed with which the joystick is moved into digital signals that are sent to the computer
to control the cursor movement. Most joysticks include two buttons called triggers.

Fig. 2.3: Joystick

Joysticks are used for Computer games but they are also used occasionally for CAD/CAM systems
and other applications.

2.2.4 Trackballs

Trackball is another pointing device. A trackball is a mouse lying on its back. A trackball uses a hard
sphere to control cursor movement. The ball can be rotated by hand in any direction. The associated
electronic circuitry detects the direction and speed of spin. The trackball translates the sphere's
direction and speed of rotation into digital signal used to control the cursor. The information is sent to
the CPU for initiating further necessary action.

Different types of Trackball are shown in Fig. 2.4.

(a) (b) (©)

Fig. 2.4: Various Types of Trackballs
2.2.5 Touch Screens

A touch screen is basically a display screen which can identify the occurrence and position of a touch
inside the display region. The word normally refers to a touch or tap to the display of the gadget by a
finger or hand. Touch screens can also identify added inactive objects, such as a stylus. However, if
the object identified is active, as with a light pen, the phrase touch screen is normally irrelevant. The
facility to interact directly with a display normally specifies the existence of a touch screen.
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Figure 2.5: Touch Screen Monitor

Such touch screen displays can be connected to computers, laptops, PDAs, cell phones etc. They also

project an important function in the blueprint of digital.
2.2.6 Light Pens

A light pen is similar to a mouse, except that with a light pen we can move the pointer and select
objects on the display screen by directly pointing to the object with the pen. It is a pen like device

which is connected to the machine by a cable.

Light pens are shown in Fig. 2.6.

Fig. 2.6: Light Pens
2.277 Touch Pad

A small, touch-sensitive pad is used as a pointing device on some portable computers. By moving]

finger or other object along the pad, we can move the pointer on the display screen. The touch pad i

related to the touch screen, but activated by different means. The touch pad uses pressure-sensiti
materials to record data at the point where the pad is touched. Many appliances around the hom
such as microwave ovens, use touch pads for programming time or temperature.

Fig. 2.7: Touch Pad Using a Point-device

2.2.8 Digitizer

A digitizer, or graphics tablet, is similar to a light pen; however, instead of drawing on the screen,|
separate tablet is used on which a special stylus is moved. Input tablets or digitizer tablets
graphical tablets are typically found in CAD terminals or engineering workstations, etc.

Digitizers are also called Digitizing Tablets, Graphics Tablets, Touch Tablets, or simply Tablets. To
view of digitizer along with tablet is shown in Fig. 2.8.

a
pr
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Fig. 2.8: Digitizer With Tablet
2.2.9 Voice Systems

Audio input provides direct and “user friendly” means of inputting data and instructions to the
computer. Recently, a number of Voice Data Entry (VDE) systems have been developed. Voice
recognition is one of the newest, most complex input techniques used to interact with the computer.
The user inputs data by speaking into a microphone.

2.2.10 Scanners

Scanner is a kind of input device that can read text or printed paper and translates the information in a
convenient form to be understood by the computer. All kinds of scanned documents using an optical
scanner gets converted in the form of bit-map and thus it does not distinguish between text or
graphics. In order to edit text read by an optical scanner, we need an OCR system to translate the
image into ASCII format. Almost all optical scanners sold today come along with OCR packages.

There are six distinct types of scanners:

» handheld » photo drum, and
» flatbed » slide
» sheetfed

Each of these styles has its own practical applications and limitations. Theoretically, you could also
include digital cameras as a type of scanner.

Flatbed (or simple) and Hand-held scanners are the most popular scanners in maximum use. These
are shown in Fig. 2.9 (a) and (b) respectively.

(@ (b)
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(©) (d)
(a) to (c) Flatbed Scanners (d) Hand-held Scanner
Fig. 2.9: Types of Scanners
2.3. OUTPUT CONCEPTS

The output device receives results and other information from the computer and provides it to the
users. Output is the process of translating data in machine-readable form into a form understandable
to humans or readable by other machines.

In today's information society, people require clear, legible and output. Output that can be understood
by humans can be categorized as :

e  Hard copy e Soft copy

Hard copy is the output, such as paper, that can be read immediately or stored and read later. It is
relatively stable and permanent form of output. Soft copy is usually a screen-displayed output. It is
transient form of output and is lost when the computer is turned off. But if the data needed to create
the soft copy have been saved on disk or tapes, the soft copy can be reproduced on the screen
anytime.

2.4 OUTPUT DEVICES

Any peripheral that receives or displays output from a computer. An inkjet printer is a good example
of an output device that can make a hard copy of anything on a computer. Below is a listing of all the
different computer output devices found on a computer:

e Flat panel e Sound card
e Monitor e Speakers

e Printer e Video card
e Projector

An output device is any piece of computer hardware equipment used to communicate the results of
data processing carried out by an information processing system (such as a computer) to the outside
world.

Examples of output devices:

» Monitors » Speakers
» Printers » Headphones
» Plotters » Voice Response Systems

Most of the computer output devices are common to home as well as office environments. At the
same time, there are some devices, which are not as commonly available. Having said that, let’s take
a look at computer output devices list.

2.4.1 Monitors

A computer display is also called a display screen or video display terminal (VDT). A monitor is a
screen used to display the output. Images are represented on monitors by individual dots called pixels.
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A pixel is the smallest unit on the screen that can be turned on and off or made different shades. The
density of the dots determines the clarity of the images, the resolution.

Types of Computer Monitors

The computer monitor (also know as a VDU or Visual Display Unit) is the most common computer
output device. For desktop computers, cathode ray monitors (CRT) are gradually being replaced by
flat-screen monitors such as the Liquid Crystal Displays (LCD) and Thin Film Transistor (TFT)
displays used with laptop computers because they use less power and take up less space.

2.4.1.1 Crt Monitor

The traditional output device of a personal computer has been the CRT (Cathode Ray Tube) monitor.
Just like a television set (an older one, anyway) the CRT monitor contains a large cathode ray tube
that uses an electron beam of varying strength to “paint” a picture onto the color phosphorescent dots
on the inside of the screen. CRT monitors are heavy and use more electrical power than flat panel
displays, but they are preferred by some graphic artists for their accurate color rendition, and
preferred by some gamers for faster response to rapidly changing graphics.

Figure 2.10: CRT monitor
2.4.1.2 Flat Panel Displays

Portable computers such as a laptop use flat panel displays, because they are more compact and
consume less power than CRTs. Portable computers use several kinds of flat panel screens:

2.4.1.2.1 LCD (Liquid Crystal Display) Monitors

Liquid crystal display, also known as liquid crystal diode, is one of the most advanced technologies
available at present. Typically, an LCD monitor consists of a layer of color or monochrome pixels
arranged schematically between a couple of transparent electrodes and two polarizing filters.

Figure 2.11: Flat panel display (LCD)

Other types of flat panel technology exist (such as plasma displays) but LCDs are most commonly
used in computers, especially laptops.
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Flat panel displays are much lighter and less bulky than CRT monitors, and they consume much less
power. They have been more expensive than CRTs in the past, but the price gap is narrowing. You
will see many more flat panels in the future.

2.4.1.2.2 TFT Monitor

A TFT monitor is a LCD display that uses thin-film transistor technology. Flat panel displays are
quickly becoming the dominant display of choice and are replacing cathode ray tubes. These days,
nearly all of the LCD monitors that are designed and developed use TFT technology to provide the
picture. They were developed because, in the past, there was a reliance on the passive matrix LCD
display.

Figure 2.12: TFT monitor
2.4.1.2.3 Plasma Display Panel

A plasma display panel (PDP) is a type of flat panel display common to large TV displays
(80 cm/30 in or larger). They are called "plasma" displays because the technology utilizes small cells
containing electrically charged ionized gases, or what are in essence chambers more commonly
known as fluorescent lamps.

Figure 2.13: A typical modern plasma screen television

2.4.2 PrintersA printer is a peripheral which produces a text and/or graphics of documents stored
in electronic form, usually on physical print media such as paper or transparencies. Many printers are
primarily used as local peripherals, and are attached by a printer cable or, in most new printers, a USB
cable to a computer which serves as a document source. Some printers, commonly known as network
printers, have built-in network interfaces, typically wireless and/or Ethernet based, and can serve as a
hard copy device for any user on the network. Individual printers are often designed to support both
local and network connected users at the same time. There are several printer technologies, the most
common of which are:

» the daisy wheel printer
> the dot-matrix printer (also called impact matrix printer)
» the inkjet printer and the bubble jet printer
» the laser printer
Today, daisy wheel printers and matrix printers are hardly ever used.

2.4.2.1 Categories of Printers

A printer is an output device that produces a hard copy of data. The resolution of printer output is
expressed as DPI. Printers can be classified into different types in several ways.
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First, the printers can be divided into three categories by the way they print.

= Serial Printers: Also called a character printer. Print a single character at a time. They are
usually inexpensive and slow.

= Line Printers: Print a line at a time. They are expensive and very fast. Line printers use a
band, a chain, etc.

= Page Printers: Also called a laser printer. Print a page at a time. They usually use a laser to
produce page images. Quality is best. This is a little bit expensive, but the price of the
personal laser printer is decreasing. The price range of the personal laser printer is around
$400, today.

Second, printers can be classified into two forms according to the use of a hammer.

= Impact Printers: Hammer hits ribbons, papers or print head. Dot-matrix and daisy-wheel
printers are the example. Noisy.

= Nonimpact Printers: They do not have the hammer and do not hit. An example is an ink-jet
and laser printer.

So, let's take a closer look at the various types of printers.
2.4.2.2 Character Printers

They are used to print only one character at a time. A typewriter is an example of a character printer.
Some of character printers are described below.

2.4.2.3 Daisy-Wheel Printer

Daisy-Wheel Printer prints typewriter-like very high quality characters. However, they are slower and
less reliable than dot-matrix printers. Microcomputer users seldom use this printer, because the better
dot-matrix printers and inexpensive laser printers are available today. The speeds of daisy-wheel
printers range from 30 to 60 characters per second (cps).

Figure 2.14: A daisy-wheel print wheel
2.4.2.4 Dot-Matrix Printer

The dot-matrix printer allows you to print documents on paper thanks to the "back and forth"
motion of a carriage housing a print head.

Dot-matrix printers are printers that write characters and form graphic images using one or two
columns of tiny dots on a print head. The dot hammer moving serially across the paper strikes an
inked-ribbon and creates images on paper.

» The print head travels from side to side across the paper and is made up of numerous pins
which are pushed out to form the shape of each character.

» The pins hit an ink ribbon against the paper so the characters are printed out.

» The paper is usually continuous with holes down each side and perforations so the pages
can be easily separated by tearing.
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Because the pins make an impact against the paper the characters can be printed through several
layers of self-carbonating paper to produce duplicate copies.

Figure 2.15: Dot Matrix Pins

An animation showing how head of a 21 pin dot-matrix printer moves across the paper, firing the pins
that strike the ink against the paper.

> Character Matrix Printer

Character matrix printers are a category of computer printers (typically impact printers) that place
characters from a fixed character set anywhere onto a fixed grid of possible locations on the page.
Examples of these are daisy wheel printers, golf ball printers, chain printers, and band printers. A
character printer prints one character at a time.

2.2.4.5 Line Printers

Line printers, as the name implies, print an entire line of text at a time. The line printer is a form of
high speed impact printer in which one line of type is printed at a time. They are mostly associated
with the early days of computing, but the technology is still in use. Print speeds of 600 to 1200 lines-
per-minute (approximately 10 to 20 pages per minute) were common.

L Ml“‘l;ul_l-‘}
17 =

Figure 2.16: IBM 1403 line printer
Designs
Four principal designs existed:

» Drum printers » Band Printers
» Chain (train) printers
2.4.2.6 Page Printers

These are the very high speed non impact printers. They can produce documents at speeds of over
20,000 lines per minute. Electronics, xerography, lasers, and other technologies have made these
high-volume systems possible. These techniques called electro-photographic techniques have
developed from the paper copier technology. Page printers can produce pages of output at a rate equal
to a photo copier.

2.4.2.7 Laser Printer

Laser printers are page printers that print one page at a time. It is a non-impact printer. A laser printer
is a printer that uses the electro-photographic method used in a copy machine. A laser printer is a
common type of computer printer that rapidly produces high quality text and graphics on plain paper.
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Basic Laser Printer

Components Toner
Hopper

Laser
Scanning
Corona nit

Discharge ire

Photoreceptor
Fuser Drum Assembly Dcl%’g“ﬂﬂm

Figure 2.17: The basic components of a laser printer

The laser printers produce quality print-outs inexpensively at a high print speed. However, these
printers are mostly used in professional and semi-professional settings because of their high cost.

2.4.2.8 Inkjet Printer

Ink-jet is a printer mechanism that sprays one or more color of ink at high speed onto the paper and
produces high-quality printing. This printer also produces color printing as well as high-quality
image. That is, ink-jet printers can be used for variety of color printing at a relatively low cost. Ink-jet
printing has two methods: Continuous stream method and drop-on- demand method.

Inkjet printing, like laser printing, is a non-impact method.

control circuitry Principle of the inkjet

paper feed

{mo. k
and forth)

paper feed

d

paper advangs rollers

Figure 2.18: Ink Jet Printer
2.4.3 Plotter
Plotters were the first type of printer that could print with color and render graphics and full-size
engineering drawings. As a rule, plotters are much more expensive than printers. They are most
frequently used for CAE (computer-aided engineering) applications, such as CAD (computer-aided

design) and CAM (computer-aided manufacturing). Hewlett-Packard is the leading vendor of plotters
worldwide.

Plotters are divided into four types:

1. Drum plotters 3. Inkjet plotters

2. Flatbed plotters 4. LED plotters

2.4.3.1 Drum Plotter

A drum plotter is pen plotter that wraps the paper around a drum with a pin feed attachment. The
drum then rotates the paper as pens move across it and draw the image. It was the first output device

used to print graphics and large engineering drawings.
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Figure 2.19: A drum plotter
2.4.3.2 Flatbed Plotter

A flat-bed plotter is a mechanical drafting device used with many CAD programs for designers. The

paper remains stationary on a flat surface while a pen moves across it horizontally and vertically. A
flatbed plotter is also known as Table Plotter.

Figure 2.20: Flatbed Plotter
2.4.3.3 The Inkjet Plotter

This is the third kind of Plotter which is called as the Inkjet plotter. The inkjet plotter creates an
image by spraying small droplets of ink onto a piece of paper. A popular choice for advertising

agencies and graphic designers, inkjet plotters are used generally for large outputs, such as banners
and billboards and large signs often seen on roadsides.

Figure 2.21: Inkjet plotter
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In Today's world, virtually all inkjets create color. Low-end inkjets make the most of the three ink
colors (cyan, magenta and yellow), but finally create a complex black that is often mud-spattered.
Four-color inkjets make use of the black ink created for pure black printing alone.

2.4.3.4 LED Plotter

LED plotters are also called as Electrostatic plotters. It works similar to Laser Printers except that it
uses LED as the heat source instead of Laser.

Figure 2.22: LED plotter
2.44 Projector

Projectors are display devices that project a computer created image. The computer sends the image
data to the video card which then sends the video image to the projector. They are typically used for
presentations or for viewing videos.

An output device that can take the display of a computer screen and project a large version of it onto a
flat surface. Projectors are often used in meetings and presentations so that everyone in the room can
view the presentation. In the picture to the right, are a ViewSonic projector and an example of what a
projector may look like. Projectors used with computers are small devices that are rarely much larger
than a toaster and typically weigh a few pounds.
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Figure 2.23: Projector
2.5 OTHER COMPUTER PERIPHERALS AND HARDWARE

Computer hardware is the collection of physical parts of a computer system. Apart from computer
case, monitor, keyboard, mouse, printers, plotters, etc., it also includes all the parts inside the
computer case, such as the hard disk drive, motherboard, video card, and many others. Computer
hardware is what you can physically touch. Few such computer hardware devices and components are
discussed as under.

Motherboard

The motherboard is the main circuit board of a computer. It contains the central processing unit
(CPU), the Basic Input/Output System (BIOS), memory, mass storage interfaces, serial and parallel
ports, expansion slots, and all the controllers for standard peripheral devices like the keyboard, disk
drive and display screen.
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Figure 2.24: Motherboard

The chipset and other motherboard circuitry are the "smarts" of the motherboard. Their job is to
direct traffic and control the flow of information inside the computer.

The chipset is a critical part of any computer, because it plays a big role in determining what sorts of
features the computer can support.

CPU

The central processing unit (CPU), also called a processor, is located inside the computer case on
the motherboard. It is sometimes called the brain of the computer, and its job is to carry out
commands. Whenever you press a key, click the mouse, or start an application, you're sending
instructions to the CPU.

Fig. 2.25: Processor

The CPU is generally a two-inch ceramic square with a silicon chip located inside. The chip is
usually about the size of a thumbnail. The CPU fits into the motherboard's CPU socket, which is
covered by the heat sink, an object that absorbs heat from the CPU.

A processor's speed is measured in megahertz (MHz), or millions of instructions per second;
and gigahertz (GHz), or billions of instructions per second. A faster processor can execute
instructions more quickly. However, the actual speed of the computer depends on the speed of many
different components—not just the processor. There are 2 main chip manufacturers, Intel and AMD.

RAM

Random Access Memory (RAM) is a critical performance component for computers. When a
computer boots up, opens a program, and then opens a file, it loads these elements into RAM to do
the work.
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Figure 2.26: RAM

In general, you want to have as much RAM in your computer as you can afford. If you are running a
32 bit operating system, then each program can make use 2GB to 3 GB of RAM. If you have a 64bit
OS, then each program can use as much RAM as you have available.

Video Card

A video card or Graphics Processing Unit (GPU) is the part of the computer that connects to the
monitor. The GPU takes the video image and puts it in a form that can be displayed on the monitor. In
most laptops, this is built into the system and cannot be replaced. In most desktop computers, the
GPU fits into a slot on the motherboard, and can often be upgraded.

Digital storage

Every computer needs a storage device to store the operating system, programs and files. In the vast
majority of cases, this is provided by one or more hard drives. Most computers have at least one
internal hard drive, and they have the capability to connect to external drives.

Figure 2.27: Hard Disk

Most computers also have the ability to read and write optical disc like CD, DVD or Blu-ray. These
are used for loading data and programs on and off the computer.

Digital storage is a critical part of any computer system, and using storage properly can be the
difference between keeping your photos and losing them. For more information, take the course on
digital storage and backups.

Power Supply Unit

The power supply unit in a computer converts the power from the wall outlet to the type of power
needed by the computer. It sends power through cables to the motherboard and other components.

[

Figure 2.28: Power Supply Unit
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Expansion cards

Most computers have expansion slots on the motherboard that allow you to add various types
of expansion cards. These are sometimes called PCI (peripheral component interconnect) cards.
You may never have to add any PCI cards because most motherboards have built-in video, sound,
network, and other capabilities. However, if you want to boost the performance of your computer or
update the capabilities of an older computer, you can always add one or more cards. Below are some
of the most common types of expansion cards.

Sound Card

The sound card, also called an audio card, is responsible for what you hear in the speakers or
headphones. Most motherboards have integrated sound, but you can upgrade to a dedicated sound
card for higher-quality sound.

Network card

The network card allows your computer to communicate over a network and access the Internet. It
can either connect with an Ethernet cable or through a wireless connection (often called Wi-Fi).
Many motherboards have built-in network connections, and a network card can also be added to an
expansion slot.

Bluetooth card

Bluetooth is a technology for wireless communication over short distances. It's often used in
computers to communicate with wireless keyboards, mice, and printers. It's often built into the
motherboard or included in a wireless network card. For computers that don't have Bluetooth, a
USB adapter, called a dongle, can be purchased.

Figure 2.29: Dongle
2.6 COMMUNICATION DEVICES

Communication devices are the machines that assist in transmission of data. The versatility of a
computer gets enhanced considerably when it can communicate with other devices and computers.
For a two-way communication, a computer must be equipped with a modulator for outgoing data and
a demodulator for the incoming data. This modulating device is referred to as a modem. There are
various kinds of communication devices in the present day market.

There are several types of communication devices. Few of these are discussed below:
Network Interface Card

This is a device which is connected to a users’ computer which allows them to connect their computer
to a device e.g. a switch or a hub, allowing them to communicate using this device.
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Fig. 2.30: Network Interface Card
Servers

A server is used in a network to provide the users of a network with different features, for example a
client server which allows the nodes on a network to connect on any computer system allowing them
to always have the same interface when they log in, another server could be an e-mail server this is
used to hold accounts of the users of the e-mail programmes, when the messages are being sent and
other various features on the e-mail server.

Router

A router is an intelligent device which can route subnets together. Routers are also used across the
internet to transfer the data across the world. A router uses a routing table which is configured with ip
address, so when a user sends data from one network the data on the other network can be received
due to the router. Wireless routers are also the same accept transferring the data wirelessly using a
normal 2.4 ghz frequency.

Fig. 2.31: Modem and Router
Modems
Modem stands for Modulate/demodulate.

A device that transmits and receives data using a modulated carrier wave. Modems are used to establi
sh network and Internetconnections.

Hub

A hub is a non intelligent device, the reason for this is because when a node on port one for example
sends a message to someone on port 4 the message is sent out to all of the ports on the hub, as well as
this making the device slower, it also makes the device insecure because it makes it easy for people to
sniff packets on a network.
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Fig. 2.32: Switch and Router
Switch

A switch is an intelligent device, when data is sent from a node for example on port one sending the
data to port 4 the switch knows exactly which port to send to making it a faster and more secure
device to use.

2.7 CONFIGURATION OF HARDWARE DEVICES

Hardware configuration references the details and system resource settings allotted for a specific
device. Many computer specialists improve hardware performance by adjusting configurations, which
may also include settings for the motherboard and the BIOS, as well as the bus speeds.

With newer technology, most computers have plug-and-play (PnP) allowing the OS to detect and
configure external and internal peripherals, as well as most adaptors. PnP has the ability to locate and
configure hardware components without needing to reset jumpers and dual in-line package (DIP)
switches.

Each device has a hardware configuration setting, which may include the following:

o Interrupt Request (IRQ) Lines: These are hardware interrupt lines, which signal the CPU
when a peripheral event has stopped or started.

e Direct Memory Access (DMA) Channels: This is a method for transferring data from the
main memory to a device without going through the CPU.

e Input/Output Port: This connects the input and output devices to the computer. There is a
memory address for each port.

e Memory Address: There is a unique identifier used for each memory location. The memory
address is typically a binary number, which is numbered sequentially.

All hardware devices have configuration settings that can affect performance and system function.
Hardware configuration information may include:

e Available memory
e Power management features
e Devices that are connected such as modems, disc drives and serial ports

During power-on-self-test (POST), basic input/output system (BIOS) searches system configurations
to determine what devices are present and how they interface with the CPU. After POST, when the
computer and system configurations are found, the CPU uses the information to process instructions
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and data. Configuration information is stored in several ways using DIP switches, jumpers and
complementary metal oxide semiconductors (CMOS).

Today most peripheral devices use PnP, which will auto-configure the DMA, IRQ and I/O address.
Older systems that do not have PnP require a new device to be set by using jumpers or DIP switches.

SUMMARY OF THE LESSON

You learnt the following in this lesson:

An input device is any hardware device that sends data to the computer, without any input
devices, a computer would only be a display device and not allow users to interact with it,
much like a TV.

A keyboard is one of the today's most common and familiar input device. A keyboard's
primary function is to act as an input device.

Mouse is a pointing device and it has been around us for more than 20 years

A joystick is also a pointing device. It is used to move the cursor position on a CRT screen.
Its function is similar to a mouse, except that with a mouse the cursor stops moving as soon
as you stop moving the mouse.

A touch screen is basically a display screen which can identify the occurrence and position of
a touch inside the display region.

Scanner is a kind of input device that can read text or printed paper and translates the
information in a convenient form to be understood by the computer.

Hard copy is the output, such as paper, that can be read immediately or stored and read later.
It is relatively stable and permanent form of output. Soft copy is usually a screen-displayed
output.

Any peripheral that receives or displays output from a computer. An inkjet printer is a good
example of an output device that can make a hard copy of anything on a computer.

The computer monitor (also know as a VDU or Visual Display Unit) is the most common
computer output device

A printer is a peripheral which produces a text and/or graphics of documents stored in
electronic form, usually on physical print media such as paper or transparencies

A printer is an output device that produces a hard copy of data. The resolution of printer
output is expressed as DPI. Printers can be classified into different types in several ways.
Plotters were the first type of printer that could print with color and render graphics and full-
size engineering drawings.

Computer hardware is the collection of physical parts of a computer system. Apart from
computer case, monitor, keyboard, mouse, printers, plotters, etc., it also includes all the parts
inside the computer case, such as the hard disk drive, motherboard, video card, and many
others.

Communication devices are the machines that assist in transmission of data. here are various
kinds of communication devices in the present day market.

Network Interface Card is a device which is connected to a users’ computer which allows
them to connect their computer to a device.

Servers is used in a network to provide the users of a network with different features.

A router is an intelligent device which can route subnets together. Routers are also used
across the internet to transfer the data across the world.

A Hub is a non intelligent device and Switch is an intelligent device.

Hardware configuration references the details and system resource settings allotted for a
specific device.
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With newer technology, most computers have plug-and-play (PnP) allowing the OS to detect
and configure external and internal peripherals, as well as most adaptors. PnP has the ability
to locate and configure hardware components without needing to reset jumpers and dual in-
line package (DIP) switches.

SELF ASSESSMENT QUESTIONS AND EXERCISES
What are input devices?
What do you mean by keyboard?
Explain the concept of mouse?
Explain the speech recognition system in detail?
What do you mean by digital camera?
Explain the working of scanners?
What do you mean by output devices?
What are printers? Explain the various types of printers in detail?

Explain the various types of plotters?

. What do you mean by monitor?

. Explain the various types of monitors?

. What do you mean by projector?

. State the necessities of Input and Output devices.

. What are the reasons for the visual display unit to be more popular than punched card reader

?

What is a Keyboard ? How does a simple keyboard differ from an ergonomically designed
keyboard.

What is meant by configuration of hardware? What are the steps involved in this process?
What is communication hardware?

Differentiate between Hub and Switch?

What is Modem? State its role.

What is Network Interface Card?
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CHAPTER-3

COMPUTER MEMORY AND SECONDARY STORAGE
OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the basic concept of computer memory and storage
devices. Readers will be able to understand the following:

3.1
32
33
34
3.5
3.6
3.7
3.8
3.9

3.10
3.11
3.12
3.13

3.14
3.15
3.16
3.17
3.18
3.19
3.20
3.21
3.22

Characteristics of memory systems and memory hierarchy

Characteristics of memory unit

Types of memory - core memory and  semiconductor memory

Types of semiconductor memories — RAM and ROM

High speed memory and cache memory

Secondary storage devices

Magnetic disks, their characteristics and Classification of magnetic disks

Magnetic drum, Magnetic cards and strips

Optical disks and their types

Zip disk, Jaz disk, Superdisk, Optical disks, Magneto-optical drives

Magnetic tapes and their comparison with Magnetic disk
STRUCTURE OF THIS LESSON

Introduction

Characteristics Of Memory Systems
Memory Hierarchy

Desirable Characteristics Of Memory Unit
Types Of Memory

Core Memory

Semiconductor Memory

Core Memory Vs Semiconductor Memory
Types Of Semiconductor Memories

3.9.1 Random Access Memory (Ram)
3.9.2 Read Only Memory (Rom)

3.9.3 Non-Volatile Flash Memory

High Speed Memory

Cache Memory

Secondary Storage Devices

Magnetic Disks

3.13.1 Characteristics Of Magnetic Disk Systems
3.13.2 Classification Of Magnetic Disks
Magnetic Drum

Magnetic Cards And Strips

Zip Disk

Jaz Disk

SuperDisk

Optical Disks

Magneto-Optical Drives

Magnetic Tapes

Magnetic Tape Vs Magnetic Disk
Summary Of The Lesson

Self Assessment Questions And Exercises
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3.1 INTRODUCTION

Memory is that portion of a computer system that is used for the storage and subsequent retrieval of
data and instructions. Memory is a quite essential component of digital computer. Computer memory
exhibits perhaps the widest range of type, technology, organization, performance, and cost of any
feature of a computer system.

3.2 CHARACTERISTICS OF MEMORY SYSTEMS

The complex subject of computer memory is made more manageable if we classify memory systems
according to their key characteristics. The most important of these are listed in Table 3.1

Table 3.1 : Key Characteristics of Computer Memory Systems

a) Location

-CPU

- Internal (main)

- External (secondary)
b) Capacity

- Word size

- Number of words
¢) Unit of transfer
- Word

- Block

d) Access Method
- Sequential access
- Direct access

- Random access

- Associative access

e) Performance

- Access time

- Cycle time

- Transfer rate

f) Physical type

- Semiconductor

- Magnetic

g) Physical Characteristics
- Volatile/Nonvolatile

- Erasable/Non-erasable
h) Organization

One of the characteristic of memory is its capacity. For internal memory, this is typically expressed in
terms of bytes or words. External memory capacity is typically expressed in terms of bytes or Kbytes
(KB) or Mbytes (MB). The storage capacity can be expressed in terms of Bytes. Few higher storage

units are given below:

1 KB (Kilo Byte)

=1024 Bytes =2'" Bytes

1 MB (Mega Byte) =1024KB  =2" Bytes
1 GB (Giga Byte) =1024MB =2 Bytes
1 TB (Tera Byte) =1024GB =2 Bytes
1 PB (Peta Byte) =1024 TB =2 Bytes
1 EB (Exa Byte) =1024 PB =2% Bytes
1 ZB (Zetta Byte) = 1024 EB =27 Bytes
1 YB (Yetta Byte) =1024 ZB =2% Bytes
33  MEMORY HIERARCHY

A typical memory hierarchy is illustrated in Fig. 3.1.

As one goes down the hierarchy, the following occur:

a) Decreasing cost per bit
b) Increasing capacity

¢) Increasing access time

d) Decreasing frequency of access of the memory by the CPU
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Fig 3.1 : The Memory Hierarchy
34 DESIRABLE CHARACTERISTICS OF MEMORY UNIT

The structure of the memory unit is perhaps the most important characteristic of a computer system.
Some desirable features of the smallest constituent of the memory unit, i.e., binary cell are as:

It must be very fast.

It must be very compact in size.

It must have two stable states.

It must be capable of switching infinite number of times between these stable states.
Cost should be very low.

Time taken for reading and writing onto the binary cell should be very less.

Power consumption must be as small as possible.

3.5 TYPES OF MEMORY

At present the following three kinds of memory are commonly used in modern computers:
a) Primary Memory
e Core Memory e Semiconductor memory
b) Secondary Memory
e Magnetic Memory e Optical Memory
¢) Backup Memory
Primary Memory

All computers except very small systems contain all types of memory, namely, primary, secondary
and backup memories. The core memory or semiconductor memory is employed as the primary
memory (or main memory) of the computer. It stores programs and data which are currently needed
by the CPU.
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Secondary Memory

The magnetic memory is used as secondary (or auxiliary) memory. The information which is not
being currently processed resides in the secondary memory. The information which is needed by the
CPU for current processing is transferred from the secondary to main memory. The size of the main
memory is comparatively much smaller than that of the secondary memory because of its high cost.
The CPU communicates directly with the memory. As the CPU employs semiconductor technology
and has very high speed, its matching memory must be very fast. Only semiconductor devices can
provide the matching speed. Thus the main memory also must employ semiconductor technology.
RAM and ROM ICs are used as the main memory of the computer. RAMs are volatile, i.e., their
contents are erased when power goes off.

Backup Memory

Backup memory is used to store the copy of the important programs such as operating system,
compilers etc. Floppy disks and magnetic tapes can be employed as backup storage. These programs
are generally available in the secondary memory but their copies are also kept in the backup memory
so that they can be reloaded into the secondary memory in case the programs stored in the secondary
memory are lost accidentally or due to any other reason.

3.6 CORE MEMORY

This type of memory was introduced in the year 1955. It consists of tiny cores of doughnut-shaped
objects called cores. The cores are made of ferromagnetic material. The individual cores are strung on
wires to form a core plane. Several core planes are stacked one over the other to form a core stack.

Fig. 3.2: Core Memory (One Core Cell)
3.7 SEMICONDUCTOR MEMORY

The complete memory unit may be constructed from either bipolar or field-effect transistors on a
single silicon chip, which may be referred to as Semi-conductor Memory. These were introduced by
IBM in 1971. The semiconductor storage operates on the principle of a flip-flop in which the switch
is set to a 0 and 1 position by a Write command which sets or restores the flip-flop.

The semiconductor memory is:

e Faster e Lighter

e Compact

e  Consumes less power e  Static device
e Having no rotating part in it

3.8 CORE MEMORY VS SEMICONDUCTOR MEMORY

The main difference between Core memories and Semiconductor Memories are enumerated in Table
3.2:
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Table 3.2 : Difference Between Core and Semiconductor Memories

S.NO | CORE MEMORY SEMICONDUCTOR MEMORY

1. Non-volatile Generally Volatile

2. Destructive readout Non-destructive readout

3. Limited range of read & write cycle times | Wide range of read & write cycle times

4. Moderately priced Low to moderately priced

5. High power consumption Low power consumption

6. Best for large memories Best for small or medium-sized memories
7. Relatively large access time Short access time

8. Available only in large blocks Available in wide variety of sizes

9. Relatively large and heavy Relatively small and light

3.9 TYPES OF SEMICONDUCTOR MEMORIES
Semiconductor memories are of two types :
i) RAM (random access memory) and
ii) ROM (read only memory)
3.9.1 Random Access Memory (Ram)

It is a type of computer memory that can be accessed randomly; that is, any byte of memory can be
accessed without touching the preceding bytes. RAM is the most common type of memory found in
computers and other devices, such as printers.

This type of memory is pronounced as ‘ramm’ and can be used both for reading as well as writing
and that is why RAM is also known as Read/Write memory. It is accessible to users. The user enters
his program and data into RAM. It possesses random access property. The access time is same for
each memory location. RAM is a volatile memory. The information stored into it is retained in it as
long as the power supply is on. As soon as the power supply goes off (or interrupted) its stored
information is lost. The programmer has to load his program and data into the RAM when the power
is resumed.

Figure 3.3: Random-Access Memory

It is the same as the main memory of computer system. RAM is not the correct name of R/W memory
because both RAM and ROM possess random access property. But R/W memory has been called
RAM since long and in practice it has become an established name. Thus R/W memory is commonly
called RAM.

There are two basic types of RAM:
a) Static RAM (SRAM) and
b) Dynamic RAM (DRAM)
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Static RAM (SRAM) Vs Dynamic RAM (DRAM)

Static RAMs retain stored information only as long as the power supply is on whereas a dynamic
RAM loses its stored information in a very short time (in milli seconds) even though the power
supply is on.

In the table below we summarize the main differences between dynamic RAM (DRAM) and static
RAM (SRAM).

Table 3.3: SRAM Vs DRAM

Feature Dynamic RAM (DRAM)| Static RAM (SRAM)
Storage circuit Capacitor Flip-flop

Transfer speed Slower than CPU Same as CPU
Latency High Low

Density High Low

Power ConsumptionLow High

Cost Cheap Expensive

Even though static RAM is faster than dynamic RAM, its disadvantages prevent it from being used as
the main RAM circuit.

Examples of SRAMs are :

Hitachi HM 6116,2 K x 8 *  NEC puPD43256, 32 k x 8; etc.
HM 6264, 8 K x 8
* HM 6287,64 K x 1;

The refreshing and control circuitry for a dynamic RAM may be either on the chip itself or on a
separate IC called dynamic RAM controller. If the DRAM and its refresh and control circuitry are on
the same IC, it is called iRAM (integrated RAM). In other words the iRAM integrates a dynamic
RAM and its control and refreshing circuitry into a single IC. iRAM is also known as quasi-static
RAM or pseudo-static RAM.

Examples of DRAMs are :
*  Toshiba DRAM TC 51100 of 1 M x 1 bits
*  TC 514256 of 256 K x 4 bits, etc.

Intel 21019 1s a 1 MB x 9 bit DRAM. 4 MB x 9 bit DRAMs are also available. The ninth bit is for
parity checking.

Advantages of RAMs
*  These are available in larger sizes than ROMs
* They serve as temporary data storage
*  They can be updated and corrected
*  No special programming mechanism like ROMs are required
%

These do not require lead time like ROM
3.9.2 Read Only Memory (Rom)

Read Only Memory, commonly known as ROM, is a memory which is permanently programmed and
can only be read. It also possesses random access property. RAMs are much cheaper compared to
RAMs when produced in large volumes to defray the cost of making the mask. The stored
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information can only be read from ROMs at the time of operation. Information cannot be written into
a ROM by the users. In other words ROMs are not accessible to users. The contents of ROMs are
decided by the manufacturers. The contents are permanently stored in a ROM at the time of
manufacturer. From programming mode point of view the ROMs are placed in broad categories:

e Masked-programmed ROMs and
e User-programmed ROMs.

ROMs in which contents are written at the time of IC manufacturing are called mask-programmed
RAMs. The following are user-programmable ROMs:

PROM (Programmable ROM)

EPROM (or UVPROM)

E’PROM (Electrically Erasable PROM)
Non-volatile Flash memory

ROMs store information which is not subject to change. They store fixed programs. In
microprocessor-based system which are used for industrial controls, ROMs store monitor, assembler,
debugging package, function tables such as sine, cosine, square root and code-conversion tables, etc.
An example of a ROM is Toshiba Mask ROM, TCS 534000, 512 k x 8 bits.

Advantages of ROMs

They are non-volatile in nature

ROMs are easier to interface than RAMs

ROMs can not be accidentally changed

ROMs are cheaper than ROMs

ROMs are easy to test

These are more reliable than RAMs due to their reduced complexity
These are static and do not require refreshing

e Its contents are always known and can be verified
3.9.3 Non-Volatile Flash Memory

Flash memory is a special type of EEPROM that can be erased and reprogrammed Non-volatile flash
memories are also electrically erasable and re-programmable non-volatile memories. They possess
the feature of quick-pulse programming, a typical time is 100 ps for byte-program and 4 sec for chip-
program.

EEPROM is similar to flash memory i.e. flash EEPROM. The main difference between EEPROM
and flash EEPROM is that the first requires data to be written or erased one byte at a time whereas
flash EEPROM chip allows data to be written or erased in blocks and the same makes it faster. The
chip is flash erasable and programmable. The whole device is erased in one operation. A typical
electrical flash erase time for the chip is 1 second. The access time for read-operation is 150-170 ns. It
can be used in place of EPROM.

These are suitable for firmware storage whereas conventional E’PROMs are suitable for parameter
storage. When codes are to be updated the entire codes are written to avoid errors. For updation of
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firmware codes, flash memories are very fast and economical as compared to EPROMs. In case of
parameter updation, they need to be rewritten individually byte by byte while system is on-line, in
normal operation. Hence, EEPROM are best suited for such applications.

This type of memory is very costly and also they have the limit on the number of times they can be
reprogrammed usually 10,000 erase/write operations. But the failure rate is less compared to
EEPROMs.

Examples of flash-memories are :
1) Intel 28F512, 512K (64K x 8) bit CMOS Flash Memory
ii) Intel 28F020, 2048K (256 x 8) bit CMOS Flash Memory
3.10 HIGH SPEED MEMORY

We are aware that the access time of main memories is slower than the speed of the processor. Since
each instruction require several memory accesses, therefore, faster memories will be of great help in
increasing the overall performance of a computer system. The following may be the four serious
possibilities to enhance the speed of memory:

o Inserting Cache memory, known as a high speed memory, between the main memory and
processor.

o Employing associative addressing in place of random access using which information can
be retrieved at a very high speed on the basis of the portion of its contents as an address.

o Employing a faster but expensive technology for main memory having a very smaller
access time and the same become available in the time to come due to technological
advancement in memories.

o By employing Memory Interleaving using which more words are accessed in a single
memory access cycle rather than accessing one word. This is termed as memory
interleaving.

3.11 CACHE MEMORY

A very high speed small capacity memory introduced as a buffer between the CPU and the main
memory is called a Cache Memory. Due to very high cost, small cache memories are intended to
provide fast speed of memory retrieval. Only small sizes such as 8KB, 64 K, 128K, 256 KB, 512 KB
etc. are normally provided in microcomputers whereas they can have 640 KB to 64 MB RAMs or
even more Parts of the current program are copied from the main memory into the high speed cache.

The design of cache memory is such that it is not “visible” to a programmer. The CPU cycle time in a
computer is normally much faster than the memory cycle time. Thus every time information is to be
read from the memory to be used by CPU, this speed mismatch would make the CPU wait.
Employing cache is an attempt to minimize this mismatch.

When the CPU refers to an instruction (or data), it is fetched from the cache if it is already there. This
is called a hit. If it is not available, then it is called a miss and in this case the same is read from the
main memory.

3.12 SECONDARY STORAGE DEVICES

A secondary storage device refers to any volatile storage device that is internal or external to the
computer. It can be any storage device beyond the primary storage that enables permanent data
storage.

A secondary storage device is also known as an auxiliary storage device or external storage.
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Fig. 3.5: Few Secondary Storage Devices

Secondary storage devices are primarily referred to as storage devices that serve as an addition to the
computer's primary storage, RAM and cache memory. Typically, secondary storage allows for the
storage of data ranging from a few Mega Bytes to Peta Bytes. These devices store virtually all
programs and applications stored on a computer, including the operating system, device drivers,
applications and general user data. Most of the secondary storage devices are internal to the computer
such as the hard disk drive, the tape disk drive and even the compact disk drive and floppy disk drive.

3.13 MAGNETIC DISKS

A disk is a circular platter constructed of metal or of plastic coated with a magnetizable material. Data
are recorded on and later retrieved from the disk via a conducting coil named the head. During a read
or write operation, the head is stationary while the platter rotates beneath it.

The write mechanism is based on the fact that electricity flowing through a coil produces a magnetic
field. Pulses are sent to the head, and magnetic patterns are recorded on the surface below, with
different patterns for positive and negative currents. The read mechanism is based on the fact that a
magnetic field moving relative to a coil produces an electrical current in the coil. When the surface of

the disk passes under the head, it generates a current of the same polarity as the one recorded.
3.13.1 Characteristics of Magnetic Disk Systems

A magnetic disk system is a mylar or metallic platter on which electronic data can be stored.
Although disk resemble phonograph records, they do not have the characteristic spiraling groove,
however, data is accessed in much the same was as an individual song is selected on a record. Data
files on the disk can be read sequentially or directly.
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Table 3.4 lists the major characteristics that differentiate among the various types of disk systems.

Table 3.4: Characteristics of Disk Systems

1. Head Motion 4. Platters
- Fixed-Head - Single-platter
- Movable-Head - Multiple-platter
2. Disk Portability 5. Head Mechanism
- Non-removable Disk - Contact (floppy)
- Removable Disk - Fixed gap
3. Sides - Aerodynamic gap (Winchester)
- Single-sided 6. Disk Access Time

- Double-sided
3.13.2 Classification of Magnetic Disks

Depending upon the aforesaid characteristics, magnetic disks can be classified in the following
manner :

*  Floppy Disk *  Magnetic Cards and Strips
* 8inch *  Zip Disk
* 5.25inch *  Jaz Disk
* 3.5inch *  SuperDisk

*  Hard Disk

*  Fixed Disk
*  Removable Cartridge
*  Disk Pack

*  Magnetic Drum

Floppy Disks

A floppy diskette, also called simply a diskette or disk, is a small flexible disk. Floppy disks are
commonly used as secondary and backup memory in personal computers. These disks are very thin
and flexible and hence, they are called floppy. It has been around since the early 1970s.

The different sizes of floppy disk are:

* .
8 inch * 5S4 inch * 3 Yinch

Hard Disk

A hard disk is just that - hard and inflexible. The hard disk is made from materials such as aluminium
instead of mylar. The I/O device used to transfer data to and from a hard disk is called a hard-disk
drive. The read/write head of a hard-disk drive floats above the surface of the disk at a height of about
50 millionth of an inch (0.00005 inches). In comparison, a human hair is a hundred times larger in
diameter.

Fixed Disk

A fixed disk is enclosed permanently inside a sealed case for protection from environmental factors.
Fixed-disk systems contain one or more hard disks and can be used in all types of computers. Home
computer users may be familiar with the 5.25 * fixed-disk systems used with desktops, having typical
storage capacities between 10 MB and 2.1 GB. In large computers, the fixed-disk system provides
storage capacities in Giga-bytes (GB) or Tera-bytes (TB).
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Fig. 3.6: Fixed Hard-disk(s) With Removed Outer Jacket
Removable Cartridge

A storage system using Removable Cartridges has the same speed and capacity as a hard disk. These
cartridges usually contain only one or two disks. Many hard-disk drives used with small computers
are designed to use removable cartridges.

The advantage of this type of disk is that it may be removed at any time and a new or different
cartridge may be inserted. For example, a user can have a separate cartridge for each application.

Disk Pack

A disk pack is another removable storage media in which several hard-disks are packed into a single
plastic case. The disk-pack drives are designed for large systems that require larger storage capacities.
Because a disk pack is susceptible to damage by scratching, the top of the first disk and the bottom of
the last disk are generally not used.

Fig. 3.7: Disk Pack Arranged on a Spindle
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Disk packs can be interchanged, giving the computer a virtually unlimited amount of secondary

storage.

Fig. 3.8: Disk Pack

Advantages of Magnetic Disks

i)

i)
iii)
iv)

v)

Vi)

The data can be accessed sequentially as well as directly.

The access time is smaller, which results in efficient storage.

When a transaction is made, data can be updated immediately. There is no need to
maintain a transaction file.

Software allows files to be altered simultaneously.

Disk storage is much more durable and is less likely to be lost because of mishandling or
a poor storage environment.

Inquiries can be answered quickly on the spot.

Disadvantages of Magnetic Disks

)
ii)

iii)
iv)

v)

vi)

They are more expensive than magnetic tapes.

Requires complex programming to gain access to files.

These are heavier (particularly disk packs) and more difficult to replace than a magnetic
tape.

Easily transported disks may pose security problems.

Requires backup files to be prevent data from being lost during alterations.

When the data in master file is updated in case of a transaction, the old data is lost.
Whereas in tapes, a new master-file is formed which has the updated data. The old master
file is also retained for the desired time.

3.14 MAGNETIC DRUM

A magnetic drum is similar in a concept to a fixed stack magnetic disk, except that the information is
stored on the outer surface of a drum, rotating at a high speed as opposed to the surface of a disk. a
drum, as the name suggests, is cylindrical in shape, typically about 3 feet in length. The outer surface
of the drum is coated in ferro-oxide, enabling the storage of information in coded form as magnetized
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or non-magnetized spots. The surface is divided into a number of tracks, each having one or more
fixed read and record heads.

As in the case of magnetic disk, data are recorded serially along the tracks, from where any particular
item can be directly accesses. Magnetic drums are used in places where very fast access and fast
transfer speed are required.

A typical drum can store between 100,000 and 10,000,000 characters of information, transfer more
than 1.5 million characters per second (CPS) with an appropriate access time of 6 to 29 ms (million
seconds). Unlike a disk pack it cannot be removed from a unit and replaced and is more expensive
than disk. Magnetic drums are not used in our present day computers.

3.15 MAGNETIC CARDS AND STRIPS

A magnetic strip is a flexible plastic material of size 2 x 12 inches, on which data are magnetically
recorded. Ten such strips put together is called as a sub-cell and twenty sub-cells are placed in a data
cell drive. Like disk packs they can be removed. Cards and strips have high storage facility and slow
access speed. They are much cheaper than disk packs, can accommodate reasonably large amount of
data and the data stored are erasable.

3.16 ZIP DISK

These are high-capacity floppy disk drives developed by the Iomega Corporation. Zip disks are
slightly larger than the conventional floppy disks, and are about twice as thick. These can store 100
MB of data. As they are relatively inexpensive and durable, so they have become a popular media for
backing up hard disks and for transporting large files.

3.17 JAZDISK

These are removable disk drives developed by the lomega Corporation. The Jaz drive has a 12 ms
average seek-time and a transfer rate of 5.5 MB per second. The removable cartridges hold 1 GB of
data. The fast data rates and large storage capacity make it a viable alternative for backup storage as
well as everyday use.

3.18 SUPERDISK

This is a new disk storage technology developed by the Imation Corporation that supports very high-
density diskettes. SuperDisk diskettes are etched with a servo pattern at the factory. This pattern then
read by the SuperDisk drive to precisely align the read/write head. The result is that a SuperDisk
diskette can have 2490 tracks, as opposed to the 135 tracks that conventional 3 % inch 1.44 MB
diskettes use. This higher density translates into 120 MB capacity per diskette.

Unlike the other removable disk storage solutions, such as the Zip Drive, SuperDisk is backward
compatible with older diskettes. This means that you can use the SuperDisk drive to read and write to
older 1.44 MB diskettes as well as the new 120 MB SuperDisk diskettes. Imation’s current SuperDisk
drive is called the LS-120.

3.19 OPTICAL DISKS

In 1983, one of the most successful consumer products of all time was introduced : the Compact Disk
(CD) digital audio system. The CD is a non-erasable disk that can store more than 60 minutes audio
information on one side. The huge commercial success of the CD enabled the development of low-
cost Optical Storage Technology that now promise to revolutionize data storage.

The greatest drawback of the optical disk system is its slow average seek time of the drive. In case of
a hard disk the read/write head is a tiny magnet whereas in optical system the drive has to move on
sizable optical assembly across the disk surface. This increases the seek time. In future it is expected
that the access time will be reduced using fibre-optic system.



Computer Memory and Secondary Storage
CD-ROM Dirive with Optical Disk is shown in Fig. 3.9.

Fig. 3.9: CD-ROM Drive With Optical Disk
Portable CD-ROM Dirive is shown in Fig. 3.10.

.

Fig. 3.10: Portable CD-ROM Drive
There are mainly following types of optical disk products :

I.  Compact Disk (CD)

II. CD-ROM (Compact Disk Read-Only-Memory)

III. Compact Disk Interactive (CD-I)

IV. Digital Video Interface (DVI)

V. WORM (Write-Once-Read-Many)

VI. CD-R (Compact Disk-Recordable) Drive
VII.Erasable Optical Disk or CD-RW (ReWritable) Disk
VIII.Optical Card

IX. Optical Tape

Optical disk(s) are shown in Fig. 3.11 (a),Fig. 3.11 (b) and Fig. 3.11(c).
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(a) A CD-ROM Drive (b) A CD-ROM Drive (without case)

(c)The optical lens of a CD Drive
Figure 3.11
Compact Disk (CD)

Compact Disk (CD) is a non-erasable disk that stores digitized audio information. The standard
system uses 12 cm disks and can record more than 60 minutes of uninterrupted playing time.

CD-ROM

CD-ROM is an optical Compact Disk ROM. Pre-recorded data can be read out. The manufacturer
writes data on CD-ROMs. The disk is made up of resin, such as poly-carbonate. It is coated with a
material which will change when a high intensity laser beam is focused on it. The coating material is
highly reflective, usually aluminium. The high intensity laser beam forms a tiny pit along a trace to
represent 1. For reading the data laser beam of less intensity is employed.

CD-ROM is appropriate for the distribution of large amounts of data to a large number of users.
Because of the expense of the initial writing process, it is not appropriate for individualized
applications.

Advantages of CD-ROM

e The information-storage capacity is much greater on the optical disk.
e Mass replication of CD-ROMs is inexpensive and very fast.
e These are removable and thus may be used suitably for archival storage.

Disadvantages of CD-ROM

e Itisread-only and can not be updated.
e [t has an access time much longer than that of a magnetic disk drive.

Compact Disk Interactive (CD-I)

Compact Disk Interactive (CDI) optical disk is a specification based on the use of CD-ROM. It
describes methods for providing audio, video, graphics, text, and machine-executable code on CD-
ROM.

Digital Video Interface (DVI)

Digital Video Interface (DVI) optical disk is a technology for producing digitized, compressed,
representation of video information. The representation can be stored on CD or disk media. Current
systems use CDs and can store about 20 minutes of video on one disk.

WORM (Write Once Read Many)

To accommodate applications in which only one or small number of copies of a set of data is needed,
the write-once read many (WORM) type optical disk has been developed.

The WORM optical disk is attractive for archival storage of documents and files. It provides a
permanent record of large volumes of user data.
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Advantages
1) High capacity
ii) Better reliability
iii) Longer life
Disadvantages
1) Greater access time as compared to that of hard disk.
CD-R Drive

It is a special type of disk-drive that can create CD-ROMs and audio CDs. This allows the users to
master a CD-ROM or audio CD for publishing. Until recently, CD-R drives were quite expensive, but
prices have tremendously come down.

Fig. 3.12: CD-R Drive
Erasable Optical Disk or CD-RW Disk

The most recent development in computer optical disks is the erasable optical disk. This disk can be
repeatedly written and overwritten, as with any magnetic disk. Although a number of approaches
have been tried, the only technology that has proved commercially feasible is the magneto-optical
system.

The erasable optical disk has the obvious advantages over CD-ROM and WORM that it can rewritten
and thus used as true secondary storage. As such, it competes with magnetic disks.

Optical Card

The optical or laser card is the of the size as a credit card and has an optical laser-encoded strip that
can store approximately 2 MB of data. These cards have many potential uses, most notably for storing
credit records or medical histories. Some people predict that these cards may one day lead to a cash-
less and cheque-less.

Optical cards have the potential to store an individual’s entire financial history, adding to or
subtracting from appropriate accounts as a person makes, saves, or spends money. These cards may
also supply a hospital with the holder’s complete medical history. If emergency treatment is required,
this information could expedite care.

Optical Tape

Continuing developments and refinements in optical technology include Optical Tape. Optical Tape is
similar in appearance to magnetic tape, but data are stored by optical-laser techniques. Optical tapes
which are in cassette form can store over 8 GB each, and the tape drives can hold 128 cassettes,
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providing a total storage of about 1 TB (1024 GB). Like other optical methods of data storage, optical
is read-only. As optical technology develops, higher densities and expanded uses will result.

320 MAGNETO-OPTICAL DRIVES

This is a type of disk drive that combines magnetic disk technologies with CD-ROM technologies.
Like magnetic disks, these can be read as well written to and like floppy disks, they are also
removable. These are faster than floppy and CD-ROM drives but not comparable to hard-disk drives.
However, their storage capacity can be more than 200 MBs which is an enormous storage capacity in
comparison to floppy disks.

3.21 MAGNETIC TAPES

A magnetic tape is usually a 0.5 inch wide plastic tape with a coating of magnetic material on one
side. The length is generally 2400 feet. Records are stored on the tape one after the other in the order
of the key field.

Every tape has a header and trailer label. The header label is at the beginning of the tape and stores
the name of file, date of last updation and any other relevant information. The trailer label has the
same information as header label. It may be possible that a number of files are stored in a tape.

CASSETTE

Fig. 3.13: Various Types of Magnetic Tapes
Main Characteristics of Magnetic Tapes
Some major characteristics of magnetic tapes are given as under

Tape Density

Character Set Used

Parity Check

Blocks : Fixed Length or Variable Length

EE 3
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Block Size

Labels

Mechanical Interlock
Headers and trailers

Length of tape

Drive mechanism

IRG and IBG
Blocking/Unblocking Storage

% % % X % k%

Magnetic Tape Drive And Its Types

A tape drive performs the operation of writing onto the tape and also reading information from the
tape. The tape is loaded onto the tape drive in the same way that a movie projector is threaded.

Fig. 3.14: Mounting of Magnetic Tape on Drive
There are two types of magnetic tape drive mechanisms. These are:
*  ArmsUsing Vacuum Columns
*  Using Tension
Types of Magnetic Tapes
There are three forms of magnetic tape :
a) Reel-to-reel Tape
b) Cassette Tape
¢) Cartridge Tape
Advantages of Magnetic Tapes
1. It is the cheapest storage medium for sequential access.
The storage capacity is very high.

2
3. A tape is erasable and reusable.
4. Itis alow-cost backup

5

They require less space to be stored as compared to other storage devices.
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Magnetic tapes are less prone to errors
Stores large amounts of data in a small space in comparison to punched cards.

It is the most suitable backup media for voluminous storage.

o x® =N

Transfers data between tape and the CPU rapidly.
Disadvantages of Magnetic Tapes

1. It is not a very reliable and durable media for storage as when a tape tears, some data is
certainly lost.

2. Magnetic tapes require proper labels for content verification.

3. Only sequential access is possible and time required to access depends upon the location
of the record on the tape.

4. Tapes are not easily distinguishable superficially.

5. Data can not be inserted in a tape. Each time an updation is to be made, a new copy of
tape is made.

6. Environmental factors can distort data stored on magnetic tapes.

7. A tape can be read only by a machine, whereas punched cards can be read visually by an
operator.

3.22 MAGNETIC TAPE VS MAGNETIC DISK

Magnetic tape and disk have evolved together since the 1950s, filling different data storage needs for
computer users. Tape drives store and archive large amounts of data economically. Disk drives access
the data with great speed.

1. Random Access

Any data on a disk can be accessed in a few thousandths of a second. This is called random access---
you don't need to search every file to find something.

2. Serial Access

A magnetic tape drive must search through all the files leading up to the one you want. This is serial
access, reading one file after another.

3. Speed

For everyday file access, magnetic disk is faster because of its random access feature. For archiving
files, tape and disk are about the same speed.

4. Archiving

Magnetic tape is less expensive to store large amounts of data for archiving. Data centers also use
disks for archiving, though to a lesser extent.

5. Size

The smallest magnetic disks are the size of a matchbox. The smallest tape drives are about the size of
a small book.

SUMMARY OF THE LESSON

You learnt the following in this lesson:

e Memory is that portion of a computer system that is used for the storage and subsequent
retrieval of data and instructions. Memory is a quite essential component of digital computer.

e Memory systems may be classified according to their key characteristics.

o The structure of the memory unit is one of the most important characteristic of a computer
system.
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At present three kinds of memory are commonly used in modern computers - Primary
Memory, Secondary and Backup.

There are several types of primary memories - Core Memory, Semiconductor memory, etc.

The semiconductor memory is faster, compact, lighter, consumes less power, static device
and having no rotating part in it

ROMs in which contents are written at the time of IC manufacturing are called mask-
programmed RAMs.

There are user-programmable ROMs such as PROM (Programmable ROM), EPROM (or
UVPROM), E’PROM (Electrically Erasable PROM) and Non-volatile Flash memory

A very high speed small capacity memory introduced as a buffer between the CPU and the
main memory is called a Cache Memory. Due to very high cost, small cache memories are
intended to provide fast speed of memory retrieval.

There are several types of secondary storages also such as Magnetic Disks, Magnetic Tapes,
Magnetic Drums, etc.

All computers except very small systems contain all types of memory, namely, primary,
secondary and backup memories.

The magnetic memory is used as secondary (or auxiliary) memory

Backup memory is used to store the copy of the important programs such as operating
system, compilers etc.

There are several types of optical disk such as Compact Disk (CD), CD-ROM (Compact Disk
Read-Only-Memory), Compact Disk Interactive (CD-I), Digital Video Interface (DVI),
WORM (Write-Once-Read-Many), CD-R (Compact Disk-Recordable) Drive, Erasable
Optical Disk or CD-RW (ReWritable) Disk, Optical Card and Optical Tape.

SELF ASSESSMENT QUESTIONS AND EXERCISES

What are disk systems ? Outline their typical characteristics.

What is meant by Memory Hierarchy ? State its importance.

State the function of memory in a computer ?

What is a hard-disk and how does it work ?

Differentiate between Core and Semi-conductor memory.

What are high speed memories ? Explain their usage.

What are the advantages and disadvantages of magnetic tapes ?

What are the different types of memory ? Explain their merits and demerits.
Describe the physical characteristics of magnetic tape.

. What is magnetic strip ? Explain its working.

. How does a random access device differ from a sequential access device ?
. What are the major secondary storage devices ?

. When is magnetic tape storage used ?

. What is a magnetic drum ? State its applications.

. Why do we need secondary storage devices ? What are the characteristics of secondary storage ?
. What is a magnetic tape ? State its major characteristics.

. What are optical disks and how do they work ?

. Why a floppy diskette is named so ? How is it different from a hard-disk ?
. Explain the difference between Zip-Disk, Jaz-Disk and SuperDisk.

. State the applications of ROM and RAM.
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CHAPTER-4

COMPUTER NETWORKS AND INTERNET
OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the basic concepts of software and operating systems.
Readers will be able to understand the following:

4.1
42
43
4.4

4.3

4.5
4.6
4.7
4.8

4.9

4.10
4.11
4.12
4.13
4.14
4.15

Basics of Information Technology (IT) and its role in society

Essence of computer network and types of computer network

About Local Area Network (LAN), Wide Area Network (WAN) and types of WAN

Concept of Internet and its importance

About World Wide Web and Web Browser

Applications of the Internet such as information retrieval services, communication services
and data transfer services

Overview of E-mail, internet browsing and search engines

Internet access devices, domain name system (DNS) and types of internet connections

About multimedia applications of multimedia

STRUCTURE OF THIS LESSON
Introduction to Information Technology
Modern Information Technology
Computer Network
Types of Computer Network
4.4.1 Local Area Network (Lan)
4.4.2 Wide Area Networks (Wan)
Types of Wide Area Networks
4.3.1 Public Networks
4.3.2  Private Networks
Internet
World Wide Web
Web Browser
Applications of the Internet
4.8.1 Information Retrieval Services
4.8.2 Communication Services
4.8.3 Data Transfer Services
E-Mail
Internet Browsing and Search Engines
Internet Access Devices
Domain Name System
Types of Internet Connections
Multimedia
Applications of Multimedia
Summary of the Lesson
Self Assessment Questions And Exercises

4.1 INTRODUCTION TO INFORMATION TECHNOLOGY

Information technology (IT) in simple words can be defined as a marriage of two technologies i.e.
Computer Technology and Communication Technology that helps in all walks of life.
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IT (information technology) is a term that encompasses all forms of technology used to create, store,
exchange, and use information in its various forms (business data, voice conversations, still images,
motion pictures, multimedia presentations, and other forms, including those not yet conceived). It's a
convenient term for including both telephony and computer technology in the same word. It is the
technology that is driving what has often been called "the information revolution."

4.2 MODERN INFORMATION TECHNOLOGY

IT has become a vital and integral part of every business plan. From multi-national corporations who
maintain mainframe systems and databases to small businesses that own a single computer, IT plays a
role. The reasons for the omnipresent use of computer technology in business can best be determined
by looking at how it is being used across the business world.

Following are certain areas where IT plays a very important role:
1. Communication

For several organisations, email is the principal means of communication between employees,
suppliers and customers. Email was one of the early drivers of the Internet, providing a simple and
inexpensive means to communicate.

Over the years, a number of other communications tools have also evolved, allowing staff to
communicate using live chat systems, online meeting tools and video-conferencing systems. Voice
over internet protocol (VOIP) telephones and smart-phones offer even more high-tech ways for
employees to communicate.

2. Inventory Management

When it comes to managing inventory, organizations need to maintain enough stock to meet demand
without investing in more than they require. Inventory management systems track the quantity of each
item a company maintains, triggering an order of additional stock when the quantities fall below a
pre-determined amount. These systems are best used when the inventory management system is
connected to the point-of-sale (POS) system. The POS system ensures that each time an item is sold,
one of those items is removed from the inventory count, creating a closed information loop between
all departments.

3. Customer Relationship Management

Companies are using IT to improve the way they design and manage customer relationships.
Customer Relationship Management (CRM) systems capture every interaction a company has with a
customer, so that a more enriching experience is possible. If a customer calls a call center with an
issue, the customer support representative will be able to see what the customer has purchased, view
shipping information, call up the training manual for that item and effectively respond to the issue.
The entire interaction is stored in the CRM system, ready to be recalled if the customer calls again.
The customer has a better, more focused experience and the company benefits from improved
productivity.

4. Data Management

Today, most companies store digital versions of documents on servers and storage devices. These
documents become instantly available to everyone in the company, regardless of their geographical
location. Companies are able to store and maintain a tremendous amount of historical data
economically, and employees benefit from immediate access to the documents they need.

5. Management Information Systems

Storing data is only a benefit if that data can be used effectively. Progressive companies use that data
as part of their strategic planning process as well as the tactical execution of that strategy.
Management Information Systems (MIS) enable companies to track sales data, expenses and
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productivity levels. The information can be used to track profitability over time, maximize return on
investment and identify areas of improvement. Managers can track sales on a daily basis, allowing
them to immediately react to lower-than-expected numbers by boosting employee productivity or
reducing the cost of an item.

4.3 COMPUTER NETWORK

A computer network is an interconnection of various computer systems located at different places. In
computer network two or more computers are linked together with a medium and data
communication devices for the purpose of communicating data and sharing resources. The computer

that provides resources to other computers on a network is known as server. In the network the
individual computers, which access shared network resources, are known as workstations or nodes.
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Fig. 4.1: Computer Network

Need of Computer Network

The need of a computer network arose due to:

*  Limited resources * * Desire to share the resources * Cost Reduction

Today, that’s a limiting view, because the most important resource is information. Network lets us
share information and the same is achieved by Resource Sharing.

The purpose of many computer networks is to permit a far-flung community of users to share
computer resources. The resource sharing will automatically result in Cost Reduction.

4.4 TYPES OF COMPUTER NETWORK
The following are different types of networks:

Local Area Network (LAN)

Wireless Local Area Network (WLAN)
Wide Area Network (WAN)
Metropolitan Area Network (MAN)
Storage Area Network (SAN)

Campus Area Network (CAN)
Personal Area Network (PAN)

Desk Area Network (DAN)

PN R L=

Local Area Network and Wide Area Network are the popular computer networks, and the same are
being discussed here.
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4.4.1 Local Area Network(LLAN)

A local area network (LAN) is two or more computers directly linked within a small well-defined
area such as a room, building, or group of closely placed buildings. A LAN may be made up of only
microcomputers or any combination of microcomputers and large systems.

LANSs is shown in Fig. 4.2.
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Fig. 4.2: Local Area Network(s)

The computer network which connects the computers in the different parts of the same big city like
metropolitan city may be referred to as Metropolitan Area Network (MAN).

Interest in local area networks is constantly growing due to following two developments:

*  Development of powerful and user-friendly micro-computers
*  Developments in communication technology

4.4.2 Wide Area Networks (WAN)

A wide area network (WAN) is two or more computers that are geographically dispersed, linked by
communication means such as telephone system, microwave, satellites, etc. This type of network is
usually limited to use by large corporations and government agencies because of the high costs
involved in building and maintaining them.

A WAN is a network that links separate geographical locations and this network can be a public
system or any of the various packet switched services provided by the public telecommunication
agencies.

The main difference between a WAN and LAN is that, the LAN is under the complete control of the
owner, whereas the WAN needs the involvement of another authority like telecom department. LANs
are successful and capable of handling very high data transfer rates at low cost because of the small
area covered. Besides LANs have a lower error rate than WANS.
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[ Wide Area Network (WAN) L ek
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Fig. 4.3: Wide Area Network (WAN)
4.4.3 Types Of Wide Area Networks

There are mainly two types of WAN:
* Public Networks * Private Networks
4.3.1 Public Networks

Public networks are those networks which are installed and run by the telecommunication authorities
and are made available to any organisation or individual who go for their subscription.

4.3.2 Private Networks

The basic technique used in all forms of private WAN is to use private circuits to link the locations to
be served by the network. Between these fixed points the owner of the network has complete freedom
to use the circuits in any way they want. They can use the circuits to carry large quantities of data or
for high speed transmissions. Private wide area networks can be built using whatever standard
technology is available.

4.5 INTERNET

The word Internet is derived from two words ‘Interconnection’ and ‘Network’. ‘Network’ is a
set of two or more computers that are connected through a set of hardware devices to share
data/information. When a large number of such ‘Networks’ are ‘Interconnected’ together to exchange
information, using same set of rules and regulations, they constitute the Internet. Internet is also
known as mother of computer networks i.e. network of networks.

There are several ways to describe the Internet:

» From a social point of view.
The Internet is a platform where people can communicate with others no matter where they
are, their status, or their expertise. People communicate on the internet in a variety of ways:
E-mail, Usenet, etc.

» From commercial point of view.
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The Internet is a vast collection of information that can be searched and retrieved
electronically. One can access the information or communicate with others on the Internet by
using a collection of tools and services that give access to people, information, and resources.
There are three basic services: Telnet, FTP, WWW, etc.

» From technical point of view.

As discussed earlier, the Internet is a Network of Networks. Every network and every
computer on these networks exchange information according to some set rules and
regulations which are called protocols. Two most commonly used protocols for working with
the Internet are Internet Protocol (IP) or Transmission Control Protocol (TCP).

4.6 WORLD WIDE WEB

The term WWW refers to the World Wide Webor simply the Web. The World Wide Web consists of
all the public web-sites connected to the Internet worldwide, including the client devices (such as
computers and cell phones) that access Web content. The WWW is just one of many applications of
the Internet and computer networks. The World Web is based on these technologies:

e HTML - Hypertext Markup Language
e HTTP - Hypertext Transfer Protocol
e  Web servers and Web browsers

Researcher Tim Berners-Lee led the development of the original World Wide Web in the late 1980s
and early 1990s. He helped build prototypes of the above Web technologies and coined the term
"WWW." Web sites and Web browsing exploded in popularity during the mid-1990s.

HTML

HTML stands for Hyper Text Markup Language. HTML is a markup language for describing web
documents (web pages).A markup language is a set of markup tags and HTML documents are
described by HTML tags. Each HTML tag describes different document content

HTTP

The Hypertext Transfer Protocol (HTTP) is an application protocol for distributed, collaborative,
hypermedia information systems. HTTP is the foundation of data communication for the World Wide
Web. Hypertext is structured text that uses logical links (hyperlinks) between nodes containing text.

In order to fetch a web page for you, your web browser must "talk" to a web server somewhere else.
When web browsers talk to web servers, they speak a language known as HTTP, which stands for
HyperText Transfer Protocol. This language is actually very simple and understandable and is not
difficult for the human eye to follow.

4.7 WEB BROWSER

A web browser (commonly referred to as a browser) is a software application for retrieving,
presenting and traversing information resources on the World Wide Web. An information resource is
identified by a Uniform Resource Identifier/Locator (URI/URL) and may be a web page, image,
video or other piece of content.

The two most popular browsers are Microsoft Internet Explorer and Mozila Firefox. Other major
browsers include Netscape Navigator,Google Chrome, Apple Safari and Opera. While most
commonly use to access information on the web, a browser can also be used to access information
hosted on Web servers in private networks.

4.8 APPLICATIONS OF THE INTERNET

The wide variety of applications provided by Internet can be categorized into following
categories according to their behavior:
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4.8.1 Information Retrieval Services

The Internet has enabled individuals and organizations to publish ideas and information to a
large audience online at minimal charges and no time delay. Those ideas can be published in one of
the following forms:

a) Web pages

Internet provides a pool of information through the web pages available on almost
every topic. These websites can be referenced with Uniform Resource Locators
(URL’s) which allow providers to symbolically identify services and clients to locate
websites and access them using Hypertext Transfer Protocol (HTTP).

Web pages are designed using Hypertext Markup Language (HTML) which is a
special formatting language that defines the placement and format of text and other
objects on the webpage.

b) Blogs

Web logs or blogs are used as updateable online diaries as journals. Readers can post
comments on each journal entry. The blogs are usually arranged in chronological
order from the most recent post or entry at the top of main page to the older entries
towards the bottom of the page.

¢) Advertisements

The companies and organizations advertise their products via banners on popular
websites. Banners are advertisements in the form of graphical images that runs across
a webpage.

4.8.2 Communication Services

Internet provides its users one of the most attractive services to communicate over long
distances. This communication can be carried out in one of the many forms mentioned here:

a) Email

Email is a basic communication service provided by the Internet. This is a way of
sending electronic text messages between sender and receiver. Images, documents
and other files can also be sent as mail attachments.

b) Voice-over-Internet Protocol(VolP)

VolIP is a method of transmitting audio over the Internet by encoding analog audio in
a digital form, transmitting it over the Internet, and decoding it back to analog form
for listening. It carries the voice traffic over the Internet. VoIP can be free of cost or
much less cost than a telephone, especially over long distances.

¢) Internet Relay Chat (IRC)

IRC enables people all over the world to talk over the Internet in real-time sessions.
One can connect to an IRC Server across the Internet through an IRC client
application and join a network to participate in world-wide conversations.

4.8.3 Data Transfer Services

Retrieving the information is only a first step in the overall transfer of information. Actual
data is transferred using specific protocols used in transferring files over Internet. Various
protocols used in data transfer are listed below:
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a) File Transfer

File Transfer Protocol (FTP) is the protocol used for exchanging files over the
Internet. It is commonly used to download a file from a FTP server using the Internet
or to upload a file to a FTP server.

b) Gopher

Gopher is a menu based document delivery system. An individual uses Gopher to
access various types of information such as files, documents, and images. Gopher
also allows access to fip, telnet, and searchable databases. All of this is done by
selecting items from menus.

4.9 E-MAIL

E-mail stands for electronic mail. It is the most popular service or facility provided by the Internet
through which we can electronically send and receive messages anywhere in the world. E-mail is a
fast and efficient method of communication. It is almost free of cost. The e-mail reaches to the
destination in a few seconds. You can also send documents, pictures, audio and video files via e-mail
by attaching the file with e-mail. It is also possible to send or receive e-mail messages through a
mobile phone.

E-mail is a fast and efficient method of communication. You can also send your important data files
or information to your own mail account and download these when required.

E-mail Address
The general format of an e-mail address is: username@domain_name

where username specifies the name of user or organization and domain_name specifies the name of
server or ISP (internet Service Provider) of which the user is member.

For example, “nasib.gill@mdurohtak.ac.in” is e-mail address in which, “nasib.gill” is the name of
user and “mdurohtak.ac.in” is the name of server.

E-Mail Attachment

Attachment is a powerful feature of e-mail, which enables you to send additional files with your e-
mail message. In this way, you can send and receive messages as well as document or program files.
You can send documents, pictures or images, and audio & video files via e-mail, anywhere over the
network. Attachment size varies from one e-mail service provider to the other.

Advantages of E-Mail

There are several advantages of the e-mail facility available on the Internet. The main advantages of
e-mail are:

1. It is extremely fast and reaches to the destination in a few minutes or even in few seconds.
Typically, it takes 1 to 5 minutes to reach a destination in Europe (USA, England etc.) from
Pakistan.

Its cost is either very low or almost free.

One message can be sent to many persons with a single e-mail.

It is available round the clock and round the globe.

You can send and receive e-mail from anywhere in the world.

You can attach and send any type of files.

It is also possible to send or receive e-mail messages through a mobile phone.

Nowunbkwn
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Limitations of E-Mail

Although e-mail, provides the fast and efficient way to send and messages. It also has some
limitations. These are described below.

1. Email is not necessarily private. Your confidential message read by someone such as network
administrator.

Some email systems can send or receive text files only.

It is difficult to express emotions using email.

You can receive too much or unwanted emails.

5. You may not know about the person with whom you are communicating.

Free E-Mail Account

Rl

Although you are provided with the e-mail account when you join any local ISP company there are
also some websites that provide facility to Internet users to create their own e-mail account, free of
cost. The most popular websites are:

e http://www.gmail.com

e http://www.yahoo.com

e http: //www.hotmail.com

e http: //www.rediffmail.com

After creation of your e-mail account, you are allotted username and password. You can check ‘your
e-mail account by entering the correct username and password. You can also compose and send the e-
mail from your free e-mail account as well as you can manage your mails.

4.10 INTERNET BROWSING AND SEARCH ENGINES

Internet is a large source of information and contains almost millions of Web Pages related to almost
every topic that can be thought of. Initially to search for any relevant item of information, user needs
to browse from an initial starting address of a known website, and then begin searching for links from
one webpage to another, hoping to reach to the required information. This technique is called
browsing. Many searching tools are developed for the searchers to get the relevant information in
minimum time possible with accurate results.

Search Engines are programs that search documents for specified keywords and return a list of the
documents where the keywords were found. A search engine is really a general class of programs,
however, the term is often used to specifically describe systems like Google, Bing and Yahoo! that
enable users to search for documents on the World Wide Web.

4.11 INTERNET ACCESS DEVICES

Internet access connects individual computer terminals, computers, mobile devices, and computer
networks to the Internet, enabling users to access Internet services, such as email and the World Wide
Web.

Internet service providers (ISPs) offer Internet access through various technologies that offer a wide
range of data signaling rates (speeds).

412 DOMAIN NAME SYSTEM

The Domain Name System (DNS) is a global database that translates domain names (such
as www.mdurohtak.ac.in) to Internet addresses that are used by computers to talk to each other.

DNS also provides other information about domain names, such as mail services.
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Domain names are fundamental to the Internet. Every Internet-connected device, whether a personal
computer, smart phone, or gaming console, looks up each name in the global DNS, and uses the
resulting Internet address to connect to the web server, send the e-mail or use the World Wide Web.

The Domain name system comprises of Domain Names, Domain Name Space, Name Server that
have been described below:

Domain Names

Domain Name is a symbolic string associated with an IP address. There are several domain names
available; some of them are generic such as com, edu, gov, net etc, while some country level domain
names such as in, au, uk, us etc.

Domain Name Space

The domain name space refers a hierarchy in the internet naming structure. This hierarchy has
multiple levels (from 0 to 127), with a root at the top. The following diagram shows the domain
name space hierarchy.

4.13 TYPES OF INTERNET CONNECTIONS

In today’s age, there are numerous ways to connect laptops, desktops, mobile phones, gaming
consoles, e-readers and tablets to the Internet. Some of the most widely used Internet connections are
described below.

Wireless

Radio frequency bands are used in place of telephone or cable networks. One of the greatest
advantages of wireless Internet connections is the “always-on” connection that can be accessed from
any location that falls within network coverage. Wireless connections are made possible through the
use of a modem, which picks up Internet signals and sends them to other devices.

Mobile

Many cell phone and smartphone providers offer voice plans with Internet access. Mobile Internet
connections provide good speeds and allow you to access the Internet on the go.

Hotspots

Hotspots are sites that offer Internet access over a wireless local area network (WLAN) by way of a
router that then connects to an Internet service provider. Hotspots utilize Wi-Fi technology, which
allows electronic devices to connect to the Internet or exchange data wirelessly through radio waves.
Hotspots can be phone-based or free-standing, commercial or free to the public.

Dial-Up

Dial-up connections require users to link their phone line to a computer in order to access the Internet.
This particular type of connection—also referred to as analog—does not permit users to make or
receive phone calls through their home phone service while using the Internet.

Broadband

This high-speed Internet connection is provided through either cable or telephone companies. One of
the fastest options available, broadband Internet uses multiple data channels to send large quantities
of information. The term broadband is shorthand for broad bandwidth. Broadband Internet
connections such as DSL and cable are considered high-bandwidth connections. Although many DSL
connections can be considered broadband, not all broadband connections are DSL.
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DSL

DSL, which stands for Digital Subscriber Line, uses existing 2-wire copper telephone line connected
to one’s home so service is delivered at the same time as landline telephone service. Customers can
still place calls while surfing the Internet.

Cable

Cable Internet connection is a form of broadband access. Through use of a cable modem, users can
access the Internet over cable TV lines. Cable modems can provide extremely fast access to the
Internet.

Satellite

In certain areas where broadband connection is not yet offered, a satellite Internet option may be
available. Similar to wireless access, satellite connection utilizes a modem.

ISDN

ISDN (Integrated Services Digital Network) allows users to send data, voice and video content over
digital telephone lines or standard telephone wires. The installation of an ISDN adapter is required at
both ends of the transmission—on the part of the user as well as the Internet access provider.

There are quite a few other Internet connection options available, including T-1 lines, T-3 lines, OC
(Optical Carrier) and other DSL technologies.

4.14 MULTIMEDIA
A good general definition of multimedia is:

Multimedia is the field concerned with the computer-controlled integration of text, graphics,
drawings, still and moving images (Video), animation, audio, and any other media where every type
of information can be represented, stored, transmitted and processed digitally.

Multimedia means integration of multiple mediums such as audio, video, and animation in addition to
traditional media (i.e., text, graphics drawings, images, etc).

Multimedia uses computers to present text, audio, video, animation, interactive features, and still
images in various ways and combinations made possible through the advancement of technology.
This is an exciting new field for those interested in computers, technology, and creative career
options. Multimedia can be accessed through computers or electronic devices and integrates the
various forms together. One example of multimedia would be combining a website with video, audio,
or text images.

4.15 APPLICATIONS OF MULTIMEDIA

Applications of multimedia are limitless. However, following are main Application Areas
of Multimedia:
e Education & Training
o In Education, multimedia applications are used in educational games as well as for
training purposes in various fields.
¢ Entertainment

o Multimedia power is to use computers as a medium for entertainment. With the
addition of computer games to the multimedia revolution, entertainment has reached
new heights. Multimedia is also great for artistic expression.

e Presentations

o PowerPoint can be very effective means of presentation in increasing viewers'
enthusiasm and interest in the delivered contents. Most often, you will use only
graphics, sound, video and hyperlinks.
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Virtual Reality

o The goal of virtual reality is to create a three-dimentional world which feels real. the
high level of interactivity is desired and is achieved by simulating world. virtual
reality uses headsets and data gloves. the headset covers the eyes and ears and
projects sights and sounds generated by the computer. the glove transmits orientation
of hand, enabling the computer to tell where you are looking, reaching or pointing.
this technology will enhance multimedia by supporting real time, interactive, three
dimensional graphics.

Kiosk Displays

o Kiosk Displays are usually stand alone applications, frequently used in Museum
displays, trade show exhibits, automated information centers in company lobbies and
store promotional devices.

SUMMARY OF THE LESSON

You learnt the following in this lesson:

Information technology (IT) in simple words can be defined as a marriage of two
technologies i.e. Computer Technology and Communication Technology that helps in all
walks of life.

IT is a term that encompasses all forms of technology used to create, store, exchange, and
use information in its various forms (business data, voice conversations, still images, motion
pictures, multimedia presentations, and other forms).

A computer network is an interconnection of various computer systems located at different
places. In computer network two or more computers are linked together with a medium and
data communication devices for the purpose of communicating data and sharing resources.
The need of a computer network arose due to limited resources, desire to share the resources
and cost reduction.

There are several types of networks but Local Area Network (LAN) and Wide Area Network
(WAN) are the main ones.

A local area network (LAN) is two or more computers directly linked within a small well-
defined area such as a room, building, or group of closely placed buildings. A LAN may be
made up of only microcomputers or any combination of microcomputers and large systems.

A wide area network (WAN) is two or more computers that are geographically dispersed,
linked by communication means such as telephone system, microwave, satellites, etc.

The word Internet is derived from two words ‘Interconnection’ and ‘Network’. ‘Network’ is a
set of two or more computers that are connected through a set of hardware devices to share
data/information. When a large number of such ‘Networks’ are ‘Interconnected’ together to
exchange information, using same set of rules and regulations, they constitute the Internet.
The World Wide Web consists of all the public web-sites connected to the Internet
worldwide, including the client devices (such as computers and cell phones) that access Web
content.

A web browser (commonly referred to as a browser) is a software application for retrieving,
presenting and traversing information resources on the World Wide Web.

The wide variety of applications provided by Internet can be categorized into three main
categories according to their behavior: Information Retrieval Services, Communication
Services and Data Transfer Services.
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E-mail stands for electronic mail. It is the most popular service or facility provided by the
Internet through which we can electronically send and receive messages anywhere in the
world.

Search Engines are programs that search documents for specified keywords and return a list
of the documents where the keywords were found.

Internet service providers (ISPs) offer Internet access through various technologies that offer
a wide range of data signaling rates (speeds).

The Domain Name System (DNS) is a global database that translates domain names (such
as www.mdurohtak.ac.in) to Internet addresses that are used by computers to talk to each
other.

DNS also provides other information about domain names, such as mail services.

In today’s age, there are numerous ways to connect laptops, desktops, mobile phones, gaming
consoles, e-readers and tablets to the Internet.

ISDN (Integrated Services Digital Network) allows users to send data, voice and video
content over digital telephone lines or standard telephone wires

Multimedia means integration of multiple mediums such as audio, video, and animation in
addition to traditional media (i.e., text, graphics drawings, images, etc).

Applications of multimedia are limitless. However, main application areas of multimedia
include Education & Training, Entertainment, Presentations, Virtual Reality and Kiosk
Displays.

SELF ASSESSMENT QUESTIONS AND EXERCISES

What is Information Technology (IT)?

How IT is important in the present scenario?

What are IT tools?

In which areas IT may play an important role?
What is a computer network? What are its benefits?
Differentiate between LAN and WAN.

What are different types of WAN?

What is ISDN? Discuss its importance.

What are different types of services of Internet?

. What are the benefits and limitations of E-Mail ?

. What is computer conferencing ? What are its benefits ?

. What do you mean by internet?

. Explain the evolution of internet?

. Explain the various application of internet?

. Explain the various ways to connect the internet?

. What do you mean by e-mail?

. What are the advantages and disadvantages of email?

. What do you mean by search engine?

. What do you means by Information Retrieval Systems ? State their importance.
. What are the advantages and disadvantages of email?

. What do you mean by search engine?

. Explain the components of Search engine?

. What is an Internet Service Providers? Give few examples.
. What is DNS? Outline its significance.

. What are different elements of multimedia technology?

. What are applications of multimedia?
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OPERATING SYSTEMS
OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the basic concepts of software and operating systems.
Readers will be able to understand the following:

5.1
5.2

54

5.5

5.6
5.7
5.8
59

5.10

5.11

5.12

Software and its different types such as programming software, system software, application
software and other software types

Application software and its various types such as general-purpose application packages,
application-specific packages and customised application packages

Operating system and its characteristics, desirable features of operating system

Classification of operating systems and their families

Functions of operating system, main functions, basic roles of operating system, OS as an
extended machine and as a Resource Manager

Programming languages and its different types

Generation of programming languages

Operating system choices — DOS, UNIX and LINUX.

Windows operating system, its common features, Windows Explorer, Control Panel, Print
Manager and other elements of Windows

UNIX operating system, its overview and few important commands.

Outline of LINUX operating system

User interface and its types. GUI, its features and important elements.

STRUCTURE OF THIS LESSON

Introduction

Software Types

5.2.1 Programming Software

5.2.2  System Software

5.2.3  Application Software

5.2.4  Other Software Types

APPLICATION SOFTWARE

5.4.1 General-purpose Application Packages
5.4.2 Application-specific Packages

5.4.3 Customised Application Packages
OPERATING SYSTEM

5.5.1 Control Programs

5.5.2  Processing Programs
CHARACTERISTICS OF OPERATING SYSTEM
DESIRABLE FEATURES OF OPERATING SYSTEM
Booting (or Bootstrapping)

Family of operating systems

FUNCTIONS OF OPERATING SYSTEM

5.10.1 Main Functions

5.10.2 Basic Roles of Operating System

5.10.3 OS as an Extended Machine

5.10.4 OS a Resource Manager
CLASSIFICATION OF OPERATING SYSTEMS
PROGRAMMING LANGUAGES
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5.13  GENERATION OF PROGRAMMING LANGUAGES
5.13.1 MACHINE LANGUAGE
5.13.2 ASSEMBLY LANGUAGE
5.13.3 HIGH LEVEL LANGUAGE (HLL)
5.13.4 Fourth Generation Languages (4GLs): Very High Level Languages (VHLLs)
5.13.5 Fifth Generation Languages (5GLs): Natural Languages
5.14  OPERATING SYSTEM CHOICES

5.14.1 DOS
5.14.2 Windows Operating System
5.14.2.1 Windows Explorer
5.14.2.2 Print Manager
5.14.2.3 Control Panel
5.14.2.4 Paint Brush
5.14.2.5 Calculator
5.14.2.6 Desktop
5.14.2.7 My Computer
5.14.2.8 Find and Run
5.143 UNIX
5.14.3.1Few Common Unix Commands
5.144 LINUX

5.15 USER INTERFACE
5.15.1 CUI (Command User Interface)
5.15.2 GUI (Graphical User Interface)

5.15.2.1 Common Features of GUI

5.152.2 Components of GUI

5.15.2.3 CUI Vs GUI Operating Systems
SUMMARY OF THE LESSON

SELF ASSESSMENT QUESTIONS AND EXERCISES
5.1 INTRODUCTION

The hardware alone can not perform any particular calculation, computation or manipulation without
being instructed exactly what to do, when to do and how to do it. These instructions are very
important and are called software.

The software acts as an interface between the user and the computer or a software can be defined as a
complete set of instructions written by the programmer which enables the computer to obtain the
solution to a problem.

Software may be viewed as a general term that is used to describe any single program or a group of
programs.

In its most general form, software is a term used in contrast to hardware to refer to all programs
which can be used on a particular computer system i.e. the term software is used to describe program
sets needed to operate an information processing system.

5.2 SOFTWARE TYPES

Software is the means by which computer systems speak with computer users. Software forms the
heart of computer systems.
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Figure 5.1

Software, by definition, is the collection of computer programs, procedures and documentation th
performs different tasks on a computer system. The term 'software' was first used by John Tukey
1958. Briefly, computer software is the language in which a computer speaks. There are differe
types of computer software.

5.2.1 Programming Software

This is one of the most commonly known and popularly used forms of computer software. The
software come in forms of tools that assist a programmer in writing computer programs. Comput
programs are sets of logical instructions that make a computer system perform certain tasks. The tog

that help the programmers in instructing a computer system include text editors, compilers and

interpreters.
5.2.2 System Software

It helps in running the computer hardware and the computer system. System software is a collecti
of system programs; device drivers, servers, windowing systems and utilities. System software hel
an application programmer in abstracting away from hardware, memory and other intern
complexities of a computer.

5.2.3 Application Software

It enables the end users to accomplish certain specific tasks. Business software, databases a
educational software are some forms of application software. Different word processors, which
dedicated for specialized tasks to be performed by the user, are other examples of applicati
software.

5.2.4 Other Software Types

Apart from these three basic types of software, there are some other well-known forms of computj

software like inventory management software, ERP, utility software, accounting software and others.

5.4 APPLICATION SOFTWARE

An application package or application program is the software that has been written to process
perform specific job. The term application indicates that the software is applied to the job at han|
application packages are available for all types of tasks. These programs are called Applicati
Packages because they accomplish the processing required for a particular application. They may |
for business applications, engineering designs, home applications, teaching aids etc.

An end-user wishing to use an application package has to define his own requirements by means
parameters, which are employed by the programs in the system to produce the specific resu

required. These are usually written in high-level languages. Of course, the application packages riin

under the control of the operating system.

Application software is developed to aid in any task that benefits from computation. It is a bro
category, and encompasses software of many kinds, including the internet browser being used
display this page. This category includes:

5e
er
Is

n

DS
al

d
e
n

ad
to

81

Remarks



82

Remarks

Computer Applications in Business

¢ Business software e Image editing

e Computer-aided design e Industrial automation

e Databases e Mathematical software

e Decision making software e Medical software

e Educational software e Molecular modeling software
¢ Quantum chemistry & solid state physics software

e Simulation software e Spreadsheets

e Telecommunications (i.e., the Internet and everything that flows on it)

e Video editing software e Word processing

e Video games and so on.

Application packages can be classified as:
e General-purpose Application Packages
e Application-specific Packages
e Customised Application Packages

5.4.1 General-purpose Application Packages

It is that class of application packages that perform quite commonly used day-to-day tasks and also
increase the productivity very significantly and that’s why these are also known as productivity
packages.

Some important examples of this category include:

Word processing packages for processing and manipulating text

Spreadsheet packages for calculating finances and data analysis

CAD for designing or drafting

Database packages for management of files, database, storage and retrieval of information
Engineering design packages

Communication packages

Integrated packages, etc.

Some integrated packages have been developed which combine the functions of word processing,
spreadsheets, graphics, database management and communication into a single software. MS-Office,
Framework and Symphony are good examples of Integrated Packages.

5.4.2 Application-specific Packages

It is the type of application packages specifically meant for accomplishing a uncommon application.
Few important examples include :

*  General Application Packages

*  Payroll *  Attendance Management
*  Personnel Management and so on.
*  Business Application Packages
Inventory Control *  Finance and Accounting

*  Marketing Analysis
*  MRP (Material Requirements Planning)
*  Human-resource Managementand so on
*  Scientific Application Packages
Computer-Aided Designing and Drafting (CADD)
*  SPSS (Statistical Package For Social Sciences)
*  Computer-Aided Manufacturing (CAM)
*  Statistical Analysis Software (SAS)and so on.
*  Miscellaneous Application Packages
*  Computer-Based Learning (CBL)
*  MIDI (Musical Instrument Digital Interface) Package
*  Computer-Based Training (CBT)and so on



Operating System

5.4.3 Customised Application Packages

It is a kind of application packages developed by the professional programmers. It has become the
trend of the present day Software Industry to develop such kind of packages. Natural Language
Processing (NLP) is getting world-wide attention because these are non-procedural and are more
closer to human conversation. This is trend has been geared up probably due to the development of
the non-procedural 4GLs (4™ Generation Languages). This trend will continue to grow as the

development in multimedia, graphics, artificial intelligence, networking solutions enhance.
5.5 OPERATING SYSTEM

“Operating System (OS) is a collection of software written to provide the fundamental instructions

that a computer needs to manage resources, such as memory, the file system, and processes”.

In other words, OS is a master program that controls a computer's basic functions and allows other

programs to access the computer's resources such as disk drive, printer, keyboard, and screen.
There are several definitions of operating system. Few of these are:

“Operating system is a set of system programs which controls all the computer’s resources and

provides the base upon which application programs can be written”.
OR

“An operating system may be viewed as an organised collection of software extensions of hardware,
consisting of control routines for operating a computer and for providing an environment for

execution of programs”.
OR

“An operating system is a set of procedures (manual and/or automatic) that enables people or group

of people to share a computer installation efficiently”.
OR

“An operating system is a program that act as an intermediary between a user of a computer and the

computer hardware. The primary goals of an operating system are:
e To make the computer system convenient to use and
e To use the computer hardware in an efficient manner” OR

“An operating system is an integrated collection of subsystems and further each subsystem consists of
programs that perform specific duties. Just as the processor is the nucleus of the computer system, the

operating system is the nucleus of all types software activities”.

Examples of operating systems: Linux, MS Windows 95, MS Windows NT, Windows XP, UNIX,
DOS and OS/2.
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It co-ordinates all the hardware and software components of a computer
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Fig. 5.3: OS as Co-ordinator

The following two types of programs make up the operating system:

i) Control programs and

ii) Processing programs

Computer Applications in Business
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5.5.1 Control Programs

These programs oversee system operations and performs tasks such as input/output, scheduling,
handling interrupts, and communication with computer operator or programmer. The control
programs consist of the following :

a) Supervisor Programs
b) Job Control Programs
c) Input/Output Management Program

5.5.2 Processing Programs

These are executed under the supervision of control programs and are used by the programmer to
simplify program operation for the computer system. They include language translator programs, link
editors, library programs and a set of utility programs. These programs collectively automate the
management of all the computing resources available in a computer system including CPU, all
peripherals, and software. This integrated collection of programs provides more efficient computer
operation. Improved operating convenience is another benefit of an operating system.

Typically, operating systems (OSs) are used in microcomputer systems. They require mass storage
media such as magnetic tape or floppy disk. most microcomputers systems use operating systems
only with floppy disk mass storage. For this reason, these operating systems are referred to as disk
operating systems (DOS). The most commonly used operating systems on personal computers are
MS-DOS and PC-DOS.

5.6 CHARACTERISTICS OF OPERATING SYSTEM

Sharing e Long-term Storage
Concurrency e Non-determinacy

5.7 DESIRABLE FEATURES OF OPERATING SYSTEM

e Efficiency e Small-Size
Reliability e Maintainability

Thus the operating system is responsible for directing a given computer into a batch mono-
programming system, a multi-programmed system, a time-sharing system or a real-time system.
Many operating systems can handle both batch and real-time applications simultaneously.

5.8 BOOTING (OR BOOTSTRAPPING)

The process of loading the operating system into memory is known as booting. When a computer is
turned on the operating system must be brought into the memory of computer from the hard-disk
storage. The process is normally started by a small program called bootstrap loader. This program
resides in a ROM as a firmware. A computer is designed to fetch its very first instruction from the
ROM when power is turned on. The first instruction is bootstrap loader. It is very simple program
sufficient only to direct the CPU to look for specific file on the disk memory, and executes the
instructions stored in the file. The file contains machine codes to direct the CPU to continue loading
the rest of the operating system into the memory. When the operating system is fully loaded into the
memory, the computer is ready to accept user’s commands.

5.9 FAMILY OF OPERATING SYSTEMS
The family of operating systems have evolved over the years:

a) Windows family of OS:
Windows 1.0 Windows 2.0
Windows 3.0 (the first version to make substantial commercial impact)
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b)

c)
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Windows 3.1x

Windows 95 (aka Windows 4.0)

Windows 98 (aka Windows 4.1)

Windows Me (aka Windows 4.2)

0S/2 (developed jointly with IBM)

Windows NT

Windows 2000 (aka Windows NT 5.0)

Windows XP (aka Windows NT 5.1)

Windows Server 2003 (aka Windows NT 5.2)
Windows Vista (to be released August 2006)
Windows Longhorn Server (to be released shortly after Windows Vista)
Microsoft Codename Blackcomb (to follow Vista)

Apple/Macintosh Lisa OS
Apple DOS A/UX
ProDOS Mac OS
GS/OS System 6
System 7 (code-named "Big Bang")

Mac OS 8 Mac OS 9
Mac OS X

Mac OS X v10.0 (aka Mac OS X 10.0 "Cheetah")

Mac OS X v10.1 (aka Mac OS X 10.1 "Puma")

Mac OS X v10.2 (aka Mac OS X 10.2 "Jaguar")

Mac OS X v10.3 (aka Mac OS X 10.3 "Panther")

Mac OS X v10.4 (aka Mac OS X 10.4 "Tiger")

Mac OS X v10.5 (aka Mac OS X 10.5 "Leopard")

Mac OS X Server Darwin

Unix d) Linux e) Solaris.
5.10 FUNCTIONS OF OPERATING SYSTEM

The main functions of OS are:

1.

5.10.1

It manages the hardware and software resources of the system. In a desktop computer, these
resources include such things as the processor, memory, disk, etc.

It provides a stable, consistent way for applications to deal with the hardware without having
to know all the details of the hardware.

Main Functions

OS acts as an interface between hardware and users. It controls overall operations of computers. It is
mainly used for job management, data management, virtual memory management, input/output
management, process management, security etc.

a)

b)

c)

d)

Job Management: OS manages the job waiting to be processed. It recognizes the jobs,
identifies their priorities, allocates the memory for the job, schedules and finally runs each
job at the appropriate moment.

Data Management: Data management keeps track of the data on disk, tape and optical storage
devices. The operating system's file system knows where that data are physically stored.

Virtual Storage Management: OS is used for virtual memory management. OS makes
possible to increase the capacity of main memory with out actually increasing its size.

Input/output Management: OS manages the input and output operation of computer. This
applies to the flow of data among the different devices of computer and application programs.
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e) Process Management: The main activities of process management are job queuing, job
scheduling, keeping track of the status of each process etc.

f) Protection and Security: OS job is to secure data inside the memory of computer. Operating
systems provide password protection to keep unauthorized users out of the system.

g) User Interface: OS acts as an interface between a user of a computer and the computer
hardware.

5.10.2 Basic Roles of Operating System

a) Easy interaction between human and computer.

b) Starting computer operation automatically.

c) Loading and scheduling users’ programs/processes.

d) Controlling I/O devices

e) Managing various types of memories such as primary, secondary, cache etc.
1) Providing security to users’ jobs and files.

g) Accounting hardware resources and handling network communication.

h) Allowing users to share data and software among themselves.

1) Preventing the system from unauthorized user, programs etc.

5.10.3 OS as an Extended Machine

The OS effectively isolates the hardware from the user. The user communicates only with the OS and
it links the various languages and the systems and applications programs available. The OS fields all
requests for services and totally eliminates the need for the user to deal with the hardware or related
problems. Thus the operating system allows the user to concentrate on his application and prevents
him for having to spend a lot of time determining how things are to be specifically accomplished by
the hardware.

In this view, the function of an operating system is to prevent the user with the equivalent of an
Extended Machine or Virtual Machine that is easier to program than the underlying hardware.

5.10.4 OS a Resource Manager

An operating system’s major function is to manage the resources of the computer system. It allocates
the resources on the basis of the user need and system capability. The four major functions of an
operating system are:

i) File and Software Management

ii) Input/Output and Peripheral Management
iii) Memory Management

iv) Processor (or CPU) Management

As a Resource Manager, the operating system must perform the following functions for each resource
viz. processor, memory, /O, files :

a) Keep track of status of each resource

b) Decide which job should get the resource and for how much time, according to some
policy

¢) Allocate the resource to the job decided

d) After the resource is used by the job for the allocated time, make the resource free
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5.11 CLASSIFICATION OF OPERATING SYSTEMS

Within the broad family of operating systems, these may be categorized based on the types of
computers they control and the sort of applications they support. These may be classified in the
following categories:

Single-user, Single-task Operating System
Single-user, Multi-task Operating System
Multi-user Operating System

Multi-access Operating System

Multi-processing Operating System

Multi-tasking and Multi-threading Operating System
Real-time Operating System

Distributed Operating System

e Embedded Operating System
Single-user, single task Operating System

As the name implies, this operating system is designed to manage the computer so that one user can
effectively do one thing at a time. The Palm OS for Palm handheld computers is a good example of a
modern single-user, single-task operating system. Other examples of such operating systems include
MS-DOS, PC-DOS, etc.

Single-user, multi tasking Operating System

This operating system allows a computer to perform more than one task at a time. Microsoft's
Windows and Apple's Mac OS (Leopard) platforms are both examples of operating systems that will
let a single user have several programs in operation at the same time.

Multi-user Operating System

A multi-user operating system allows many different users to take advantage of the computer's
resources simultaneously. UNIX, VMS and mainframe operating systems, such as MVS, are
examples of multi-user operating systems.

These operating systems allow two or more users to run their respective programs at the same time by
making all these programs resident in the memory of computer. Such operating systems are normally
made to work on minicomputers and mainframe computers.

Examples : VMS (on DEC Mainframes), UNIX, XENIX, MVS, etc.
Multi-access Operating System

In a multi-access operating system, a user may submit a job by typing on a terminal and may use the
terminal to monitor and control the job as it runs. These operating systems allow simultaneous access
of a single application onto a computer system through two or more terminals.

The operating system shares the computing resources among the different jobs so that it appears to
each user that he has entire machine to himself.

An example is provided by some dedicated transaction-processing systems, such as Airline Ticket
Reservation Systems, that supports hundreds of active terminals under control of a single program.

Multiprocessing Operating System

It is that class of operating systems that have the ability to support more than one process at the same
time i.e. allowing more than one programs to run concurrently on the multiple CPUs in a single
computer system. These operating systems differ from the time-sharing (or multi-user) operating
systems in the manner that these refer to utilisation of multiple CPUs.
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In such operating system, the resources are allocated comfortably to the competing processes in a
reasonable manner which results in a high throughput.

Examples : OS/2 for high-end PCs, UNIX, MVS, etc.
Multitasking and Multithreading Operating System

These operating systems have the capability to execute more than one task concurrently on a
computer system having a single CPU. In these operating systems, CPU switches from one task to
another so quickly that it gives the illusion to the user of executing all the programs (or tasks) at the
same time.

Multithreading permits different portions of a single program to run concurrently and this it is having
the ability of an operating system to execute different parts of a program (called threads)
simultaneously. It requires the programmer to design the program so carefully that all the threads can
run at the same time without interfering with each other.

Examples : Windows 95/98, Windows NT, OS/2, etc.
Real-time Operating Systems (RTOS)

Real-time operating systems are used to control machinery, scientific instruments and industrial
systems.

These operating systems have the following peculiar characteristics:

Fast response time e  Feedback mechanism e Reliability
A primary objective of real-time operating systems is to provide quick response-times, and thus meet
the scheduling deadlines. In the design of these operating systems, user-convenience and resource
utilisation are of secondary concern.

These operating systems must be designed in such a manner that response-time to the external-
stimulus is very immediate as the same are designed for the purpose of controlling and monitoring of
external activities with timing constraints.

Such applications include :

¢ Industrial Control e Real-time Simulators
e Telephone Switching Equipments e Few Military Applications etc.
¢ Flight-Control

Examples:

Some examples of real time operating systems are:
e BLMX (Board-Level Multitasking eXecutive)
e BSO/RTOS (Boston Systems Office/ Real-time Operating System)
e CCP (Communication Control Program) Operating System for IBM System/3
e iRMX (Intel’s 8086 family Real-time Multitasking Executive) Operating System
e DMERT (Duplex Multiple Environment Real-time) Operating System
etc.
Distributed Operating Systems

A distributed operating system governs the operation of a distributed computer system and provides a
virtual machine abstraction to its users. The key objective of a distributed operating system is
transparency. Ideally, component and resource distribution should be hidden from users and
application programs unless they explicitly demand otherwise.
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The added services necessary for pooling of shared system resources include:

e Global naming

e Distributed file system, and

e Facilities for distribution of computations, such as inter-node process communication and
remote procedure calls.

Embedded Operating System

Embedded operating systems are mainly executed on computers that control devices. These devices
are mobile phones, TV sets etc. These systems consist of circuits and 32-bit microprocessors that
control the functioning of various operations.

Apart from the above main criterion for classification of operating systems, there will be other
criterion as well, like basing on whether it is open code or not and whether it is available for free and
similar.

Fig. 5.4 shows widely used operating systems in the market.
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Fig. 5.4: Widely used OS
5.12 PROGRAMMING LANGUAGES

A language is a vehicle for communication. In order to communicate with each other, humans
need languages like English, Hindi, etc. In the same manner, for communicating with the computer,
we use computer language called programming language. A programming language consists of all the
symbols, characters and usage rules that permit people to communicate with computers. Learning to
program requires learning all these symbols and rules.

Programming language is a systematic notation by which we describe computational process.
Computational process means steps for solving a problem. Programming language consists of
symbols, characters and certain rules. There are various programming languages each with a specific
purpose. Every language has its own instruction set that permits the operation to be performed.

If we want to make our computer to do something for us, we have to tell the computer what to do in a
language that a computer understands called a machine language (language of 0 and 1).
Communication with the computer is possible only if we develop a third language that can be
understood by both us and the computer. Such a language is called a Programming Language.

5.13 GENERATION OF PROGRAMMING LANGUAGES

Another categorisation on the basis of the introduction of the programming languages is as follows:
e First Generation Language : Machine Language
e Second Generation Language : Assembly Language
e Third Generation Language : High Level Languages
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¢ Fourth Generation Language : 4 GLs (4™ Generation Languages) or
Very High Level Language
¢ Fifth Generation Language : Natural Language

5.13.1 Machine Language

This is a sequence of instructions written in the form of binary numbers consisting of 1s and Os
to which the computer responds directly. A machine language would have two parts.

The first part is the command or an operation that tells the computer what functions are to be
performed. The second part of the instruction is the operand that tells the computer where to find or
store the data on which the desired operation is to be performed. The machine language is the only
one that computer can understand directly. In the earlier computers programmers had to translate
instructions directly into machine language from the computers understood. This task was very
difficult and very few programmers could do this job. So, this language was very difficult to
understand. But the main advantage of this language is that it is faster in execution as the computer
directly starts executing it.

5.13.2 Assembly Language

To ease the burden of the programmer, mnemonic operation codes and symbolic addresses were
developed during the early 1950s. The mnemonic refers to a memory aid. One of the first steps for
improving the program preparation process was to substitute letter, symbols and mnemonics for the
mnemonic machine-language operation codes. Today every computer has a mnemonic code, though
the actual symbols vary among makes and models.

Machine language is still used by the computer as it process data but assembly language
software first translates the specified operation code symbol into its machine language equivalent.
Symbolic addressing is the practice of expressing an address not in terms of its absolute numeric
location but in terms of symbols that are convenient for the programmers. Programmers no longer
assign actual address numbers to symbolic data items. Now, they merely specify where they want the
first location in the program to be and an assembly language program takes it from there, allocating
locations for instructions and data.

A program written by a programmer in an assembly language is called a Source Program. After
this source program has been converted into machine code by an assembler, it is referred to as an
Object Program. The main advantage of assembly language is that the programs written in it are easy
to understand as compared to the programs of machine language. And a big drawback is that they are
machine-oriented, depending upon the model of processor being used.

5.13.3 High Level Language (HII)

The development of mnemonic technique and macro-instruction led, to the development of high
level languages that are often oriented towards a particular class of problem. Unlike assembly
programs, HLL programs may be used with different makes of computers with the little
modifications. Thus, re-programming expense may be greatly reduced when new equipment is
acquired.

The main advantages of HLL are as follows:

Readability Programs written in these languages are more easily readable than those
in assembly language and machine language.
Portability Programs could be run on different machines with little or no changes.
Easy debugging Errors are easy to find and remove.
Easy software development Software could easily be developed using the HLL.

The time and cost of creating machine and assembly languages was quite high. And this was the
prime motivation for the development of high level languages.

High level languages may further be classified into following classes according their areas of
application:
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Scientific Programming Languages
Examples

i) FORTRAN (FORmula TRANsSlation)
ii) ALGOL (ALOGOrithmic Language)
iii) IAL (International Algebraic Language) [Later named as ALGOL]
iv) PL/I (Programming Language I)
v) COGO (COordinate GeOmetry Language)
vi) APL (A Programming Language)
vii) Pascal (Named after a great scientist Blaise Pascal)etc.
Business Programming Languages
Examples :
i) COBOL (COmmon Business Oriented Language)
ii) PL/I (Programming Language I)etc.
General or Multipurpose Languages
Examples :
i) PL/I (Programming Language I)
ii) Pascal
iii) BASIC (Beginner’s All-purpose Symbolic Instruction Code)
iv) C
v) JOVIAL (Jules’ own version if International Language)
vi) Adaetc.
Specialized Programming Languages
Examples :
i) LISP (LISt Processing)
ii) PROLOG (PROgramming in LOGic)
iii) Ada (Named after a first lady programmer Augusta Ada)
iv) LOGO (for teaching geometry, mathematics and programming to children)
v) RPG (Report Program Generator)
vi) Modula-2
vii) APT (Automatic Programming Tool)
viii) NELIAC (Navy Electronics Laboratory International Algol Compilers)
ix) CORAL (For Real-time Applications)
x) FORTH (Originally developed to be used by astronomers & later used for process
control applications)
xi) SIMULA/ SIMULA 67 (Simulation Language)
xii) GPSS (General Purpose Simulation System) Language
xiii) SNOBOL (StriNg-Oriented symBOlic Language)
xiv) SIMSCRIPT (Simulation Script) Languageetc.
Interactive Programming Languages
Example:
i) BASIC (Beginner’s All-purpose Symbolic Instruction Code)
ii) APL (A Programming Language)
iii) Interactive FORTRAN
iv) QUICKTRAN (Subset of FORTRAN and designed for use with multi-access
systems)etc.
Object-Oriented Languages
Examples :

C++ iv) Simula vii) CLOS, etc.
ii) Smalltalk v) Object Pascal
iii) Eiffel vi) Object C
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5.13.4 Fourth Generation Languages (4GLs): Very High Level Languages (VHLLSs)

The syntax used in 4GL is very close to human language, an improvement from the previous
generation of languages. 4GL languages are typically used to access databases and include SQL and
ColdFusion, among others.

Looking analytically into the wide-perspective of 4GLs, these can be classified mainly into three
categories:

Application Generators
Production-Oriented 4GLs
End-User-Oriented 4GLs

5.13.5 Fifth Generation Languages (SGLs): Natural Languages

These are known as 5™ generation language and are often called Natural Languages because of their
resemblance to the natural spoken English Language. These languages are still in the development
stages. Application of these languages will be quite beneficial in the area of Artificial Intelligence
(AI) and Expert Systems (ES).

S5GLs are currently being used for neural networks. A neural network is a form of artificial
intelligence that attempts to imitate how the human mind works.

5.14 OPERATING SYSTEM CHOICES

There are more than a dozen of operating systems commonly used by users. Few of these are
discussed below:

5.14.1 DOS

DOS is an acronym for “Disk Operating System”. DOS is a 16-bit, single-user operating system that
does not support multi-tasking. It is far easier to administer than UNIX, but less powerful. Compared
to graphical interfaces such as Windows and Mac OS X, it's also not particularly user-friendly.

DOS was the first operating system used by IBM-compatible computers. It was originally available in
two versions that were essentially the same, but marketed under two different names.

a) "PC-DOS" was the version developed by IBM and sold to the first IBM-compatible
manufacturers.
b) "MS-DOS" was the version that Microsoft bought the rights to, and was bundled with the
first versions of Windows.
DOS uses a command line, or text-based interface, that allows the user to type commands. While the

commands are simple to type, the user must know the basic commands in order to use DOS
effectively (similar to Unix). This made the operating system difficult for novices to use, which is
why Microsoft later bundled the graphic-based Windows operating system with DOS.

The first versions of Windows (through Windows 95) actually ran on top of the DOS operating
system. This is why so many DOS-related files (such as .INI, .DLL, and .COM files) are still used by
Windows. However, the Windows operating system was rewritten for Windows NT (New
Technology), which enabled Windows to run on its own, without using DOS. Later versions of
Windows, such as Windows 2000, XP, and Vista, also do not require DOS.

DOS is still included with Windows, but is run from the Windows operating system instead of the
other way around. The DOS command prompt can be opened in Windows by selecting "Run..." from
the Start Menu and typing cmd.
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5.14.2 Windows Operating System

Microsoft  Windows (or  simply Windows) is a  metafamily  of graphical operating
systems developed, marketed, and sold by Microsoft. It consists of several families of operating
systems, each of which cater to a certain sector of the computing industry.

The Windows operating system is developed and maintained by Microsoft, the company founded by
Bill Gates. The first version was released in 1985. Since then, it has grown significantly, and it now
dominates the market. Windows uses a graphical user interface to make it easier for people to use
their computers. The primary ways that people navigate are through icons on the desktop and the Start
menu.

As of April 2014, the most recent versions of Windows for personal computers, smartphones, server
computers and embedded devices are respectively Windows 8.1, Windows Phone 8.1, Windows
Server 2012 R2 and Windows Embedded 8. A specialized version of Windows runs on the Xbox
One game console.

The next version of Windows is Windows 10 and is currently available as a technical preview; it is
set for release for phones, tablets, laptops, and PCs in late 2015.

5.14.2.1Windows Explorer

Windows Explorer displays the hierarchical structure of files, folders, and drives on your computer. It
also shows any network drives that have been mapped to drive letters on your computer.

Windows Explorer is automatically launched any time you open a folder in Windows XP.

Using Windows Explorer, you can copy, move, rename, and search for files and folders. For example,
you can open a folder that contains a file you want to copy or move, and then drag the file to another
folder or drive.

There are other places in Windows where you can view and work with files and folders. My
Documents is a convenient place to store documents, graphics, or other files you want to access
quickly.

You can also view My Network Places, which lists other computers that are connected to your local
area network (LAN). When you delete files or folders from your hard disk, Windows places them in
the Recycle Bin, where you can retrieve them, until you empty the Recycle Bin. Files or folders
deleted from a floppy disk or a network drive are permanently deleted and are not sent to the Recycle
Bin.

To open Windows Explorer, click Start, point to All Programs, point to Accessories, and then
click Windows Explorer.

5.14.2.2Print Manager

Both in Windows 7 and Windows 8, the Print Management console is part of Administrative Tools.
However, it is not available in all editions of Windows. Only users of Windows 7 Professional,
Ultimate and Enterprise will be able to use it. In Windows 8§ it is available in Windows 8 Pro and
Enterprise.

While a search for the term Print Management in Windows 7°s Start Menu will return the appropriate
result, doing the same in Windows 8’s Start screen will not. That’s why, to make sure you find it, it is
best to open the Control Panel and go to System and Security -> Administrative Tools.



Operating System 95
Fig. 5.5: Administrative Tools Menu Remarks
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This will work both in Windows 7 and Windows 8.

When you first launch Print Management, its window will look similar to the screenshot below.
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Fig. 5.6: Print Management Menu
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5.14.2.3Control Panel

The Control Panel is a part of the Microsoft Windows graphical user interface which allows users to
view and manipulate basic system settings and controls via applets, such as adding hardware, adding
and removing software, controlling user accounts, and changing accessibility options.

To open the Control Panel, click the Start button on the taskbar and then click Control Panel on the
Start menu. Windows 7 gives you three different views for looking at your computer’s Control Panel:
To switch views, click the View By drop-down button (labelled Category by default) in the upper-
right corner of the Control Panel and then choose one of the views from the button’s drop-down
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Fig. 5.7: Control Panel Menu

By default, the Control Panel is displayed in Category view, which is separated into eight categories,
ranging from System and Security to Ease of Access. To open a window with the Control Panel
options for any one of these categories, simply click the category’s hyperlink.
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Fig. 5.8: Control Panel Menu
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5.14.2.4 Paint Brush
Paint formerly known as Paintbrush for Windows is a simple graphics painting program that has been

included with almost all versions of Microsoft Windows since its first release. It is often referred to as
MS Paint or Microsoft Paint.

The program opens and saves files as Windows bitmap (24-bit, 256 color, 16 color, and monochrome,
all with the .bmp extension), JPEG, GIF, PNG, and TIFF. The program can be in color mode or two-
color black-and-white, but there is no gray scale mode. For its simplicity, it rapidly became one of the
most used applications in the early versions of Windows—introducing many to painting on a
computer for the first time—and still has strong associations with the immediate usability of the old
Windows workspace.

Steps to Start the Paint Brush
1).Click on the Start Button.

2).Click Programs.

3).Click Accessories.

4).Click on Paint.

Then you will screen as shown below:
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Fig. 5.9: Paint Screen
Menus
Four of the Paint menus—File, Edit, View and Help—are common to almost all Windows programs.

Menus that are special to Windows Paint are Image and Colors. The menu of greatest interest is the
Image Menu.

File Edit “ew Image Colors Help

Fig. 5.10: Paint Menu
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Toolbox

All the little grey boxes down the left are called the tools and together they make the toolbox. The
individual tools will each be explained separately further down. Under the toolbox is a small area
where you see different options according to which tool you’re using.

Fig. 5.11: Paint Toolbox
Paste Options

In this picture, with the selection tool active, you have a choice between paste opaque and paste
transparent (selected, as you can tell by the dark background).

)

Fig. 5.12: Paint Paste Options
The Colour Palette

Under the main window is the colour palette. The two squares set apart from the rest at the left end of
the palette show the active colours; the colours presently in use. When you click on a colour in the
palette with the left mouse button, that colour will be the primary or foreground colour, here shown as
pink. The colour you click on with the right mouse button will be the secondary or background
colour, here shown as white.

5.14.2.5Calculator

You can use Calculator to perform simple calculations such as addition, subtraction, multiplication,
and division. Calculator also offers the advanced capabilities of a programming, scientific, and
statistical calculator.

You can perform calculations by clicking the calculator buttons, or you can type calculations by using
your keyboard. You can also use the numeric keypad to type numbers and operators by pressing Num
Lock. For more information about using the keyboard with Calculator, see Keyboard shortcuts.
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Fig. 5.13: Calculator
Calculator window

1. Open Calculator by clicking the Start button ©. In the search box, type Calculator, and then,
in the list of results, click Calculator.

2. Click the View menu, and then click the mode that you want. When you switch modes, the
current calculation is cleared. Calculation history and numbers stored by the memory keys are
retained.

3. Click the calculator keys to perform the calculation you want.

5.14.2.6Desktop

Desktop is a common term used to describe a desktop computer. When referring to an operating
system or GUI, the Desktop is a system of organization of icons on a screen. The Microsoft Windows
Desktop was first introduced with Microsoft Windows 95 and has been included with all versions of
Windows since then. Below is a basic example of the Microsoft Windows Desktop.

Windows 7 Desktop

Fig. 5.14: Windows 7 Desktop

In the above picture, is an example of the Microsoft Windows 7 Desktop. In this picture, there are no
icons on the Desktop and at the bottom of the window is the Taskbar.

Press the shortcut key Windows key + D at any time to get to the Windows Desktop. Press the same
keys again to restore Windows back to how they were before they were minimized.
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Some of the most common icons on the Desktop include the My Computer icon, Recycle Bin, your
Internet browser icon (e.g. Internet Explorer), and My Documents. On the Windows Desktop, you
can also have access to the Windows Start Menu through the Start button on the Taskbar and
the Windows Notification Area.

5.14.2.7My Computer

The ‘My Computer’ icon gives us easy access to our hard drives, removable flash drives and other
network-related locations. But if you’re one who enjoys a clutter-free desktop, then maybe you can
use this tweak to remove the many program and folder shortcuts on your desktop.
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Fig. 5.15: My Computer

Here’s a way to get more usefulness out of “My Computer” by adding the shortcuts that you need to
it. This also gives you quick access to the program or folder and works very well with Windows
Explorer tabs tweak like Clover.

5.14.2.8 Find and Run

Find is another great command line tool that every Windows user should know about because it can
be used to search content of files for specific strings of text.

As with every command prompt based tool in Windows, there are certain switches and parameters
you will need to know in order to use the tools effectively. These are listed and explained below.

1. /v — This switch will show any lines that don’t contain the string of words you specified.

2. /c — This switch tells the find tool to count how many lines contain your search terms.

3. /n— This switch shows the numbers that correspond with the lines.

4. /i— This switch tells find to ignore the case of text you are searching for.
Like every tool in windows, you will need to know how to enter your commands. The syntax below is
the perfect model.

FIND [SWITCH] "String" [Pathname/s]
Depending on your command, you will receive one of three %errorlevel% responses.

1. 0 - The string you were searching for was found.
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2. 1 —The string you were searching for was not found.
3. 2 — This means you had a bad switch or your parameters were incorrect.
There are several ways to launch or run commands in Windows and few of these are as under:

1. Launch the Command Prompt Using Search (Windows 7 & Windows 8)

Search is very helpful, both in Windows 7 and Windows 8. In Windows 7, open the Start Menu and
type command or cmd.

Programs (1}
Control Panel (3)

@ Control the computer without the mouse or keyboard
@ Set up a microphone
@ Start speech recognition

- 7 See more results

|c0mmand X | | Shut down | » |

Fig. 5.16: Launching command
Then, click the Command Prompt search result.
In Windows 8, go to the Start screen and type command or cmd.
Then, click or tap the Command Prompt search result.
2. Launch the Command Prompt from the Run Window (Windows 7 & Windows 8)

One of the quickest ways to launch the Command Prompt is to use the Run window (pressWin+R on
your keyboard to open it).

Then, type cmd or cmd.exe and press Enter or click/tap OK.

= Typethe name of a program, folder, document or Internet
— resource, and Windows will epen it for you,

Open: | cmd|

Fig. 5.16: Run Window
3. Launch it from the Start Menu/Screen (Windows 7 & Windows 8)

If you like clicking on stuff and you are using Windows 7, open the Start Menu. Then, go to All
Programs -> Accessories.
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Fig. 5.17: Running command from Start Menu
There you will find the Command Prompt shortcut.
5.14.3 UNIX

Unix (pronounced as YOO-niks) is a family of multitasking, multiuser and time-sharing operating
system that is derived from the original AT&T Unix, developed in the 1970s at the Bell Labs
research center by Ken Thompson, Dennis Ritchie, and others. UNIX is the trademark.

UNIX is a multi-user operating system. This means that multiple users can use the system at the
same time. Concretely, this means that, for instance, dozens of users can log in from a certain
location on the same server.

When logging in, you need to identify by means of your login and password - an evident
consequence of the multi-user nature of UNIX.

login: your_loginname

passwd: your_password

After your login, you're positioned in your personal home directory. This consists of the different
groups of users you belong to, followed by your login name.

/root/usersgroup/login$ forinstance

/staff/arc/fdgroot$

After the prompt (a $-sign) commands can be given in.

Keep in mind, the UNIX operating system is case-sensitive, in other words, a difference is made
between upper- and lower case. Always count this in when entering commands.

The information your home directory contains is built hierarchically. Files and directories belong
to this hierarchy. A file created by you is placed in a directory of your choice.
Under your home directory you can find several subdirectories and files. These subdirectories at
their turn contain other subdirectories and files.

Below, it is briefly explained which commands can be used to navigate through this structure.
5.14.3.1Few Common Unix Commands
1) Query the content of the present directory
To see the content of the present directory, enter the command Is (list files):
$1s

The output of this is the names of all files and directories under the current directory.
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If you want more info than only the name of the files and directories which are under the current
directory, then you can use the command ls -al:

$1s -al

With this command, you'll get info like permissions, the owner, the numer of links, the size, the
creation- or modification date and the name of the files and directories

2) Moving through directories
With the command ed (change directory) you navigate through directories.

$ed
moves you to the directory which is one level higher than the current one

$ed
moves you to your home directory

$ cd directory_name
moves you to the given directory

If you want to go to a directory two levels deeper then you could e.g. use the command
$ cd directory_name/directory_name.

The most important thing is to know in which directory you're positioned when entering the
commands. This can be displayed with the command pwd - print working directory:

$ pwd
3) Copying files and directories

Files can be copied with the copy-command cp. If the source is the name of a file then an identical
file with a new name is created.

If the target is an existing directory, then an identical file with the same name is created in this
directory. A few examples:

$cp filel file2
Creates an identical file with a different name.

$ cp filel directory
Copies this file to another directory in which it will be found under the same name

$ cp filel directory/file2
Copies the file to another directory where it will be found under the name file2.

A directory (together with its subdirectories and files) can be copied using the command cp -R:
$ cp -R dirl dir2

4) Move files and change filenames

To move a file or to change a filename, the move-command myv is used.

$ mv filel file2
This changes the name of a file.

$ mv filel directory
This moves the file to another directory.

$ mv filel directory/file2
This moves the file to another directory and gives it another name at the same time.

5) Removing files and directories

Files can be deleted with the removal command rm.
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$ rm filename

With the command rmdir you can remove directories The directory can not contain any files or
directories at that moment.

$ rmdir directory_name

Directories can be removed while containing their files and subdirectories using the command rm -
R.

$ rm -R directory_name

Pay attention using this command and check the content of the directory first. This prevents the loss
of needed information.

Use the command

$rm -i

then, before removing, a confirmation wil be asked.
Removing files starting with -

To remove files starting with - (hyphen) enter the command:
rm -- -filename

6) Creating new directories
To create a new directory the command mkdir.
$ mkdir directory_name

5.14.4 LINUX

Linux is a generic term that commonly refers to Unix-like computer operating systems that use the
Linux kernel. Linux is one of the most prominent examples of free software and open source
development; typically all the underlying source code can be used, freely modified, and redistributed
by anyone.

Ubuntu, NepaLinux, UserLinux etc are few examples of Linux distributions.

5.15 USER INTERFACE

Interface is a common boundary between the user and the computer system. OS provides two types of
User interface.

5.15.1 CUI (Command User Interface)

A CUI (command user interface) is a user interface to a computer's operating system or an application
in which the user responds to a visual prompt by typing in a command on a specified line, receives a
response back from the system, and then enters another command, and so forth. MS-DOS and UNIX
are CUI operating systems.

5.15.2 GUI (Graphical User Interface)

GUI is graphical user interface. It is user friendly and easy to understand and use. A GUI uses
windows, icons, and menus to carry out commands such as opening files, deleting files, moving files,
etc. and although many GUI Operating Systems are operated by using a mouse, the keyboard can also
be used by using keyboard shortcuts or arrow keys.

A few examples of a GUI Operating Systems: Microsoft Windows 95, Apple Mac OS etc.
A few examples of a GUI interfaces are: GNOME, KDE etc.
Desktop view of GUI of Windows 7 Home Premium is shown in Fig. 5.18.
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Fig. 5.18: Desktop View of Windows 7 Home Premium
5.15.2.1Common Features of GUI

A present day GUI has the following common features:

a)

b)

g)

h)

Pointing device(s): These allow users to point at different parts of the screen as well as can
be used to initiate a command. Besides, these can also be used to manipulate objects on the
screen by:

e selecting objects on the screen

e moving objects around the screen, or

e merging several objects into another object

Examples: Mouse, light pen, joystick, touch sensitive screen, touch pad and so on.

Windows : It graphically display the progress of the action initiated. When a screen is
divided into several independent regions, each one of these is called a window. Each window
can highlight results related to the action fired in the respective window.

Switching capability : Windows system offers the switching capability from one application
to another or for sharing of data among various applications.

Resizing and Movement : Windows system also support resizing as well as moving around
feature of windows.

Graphical Bit-mapped Displays : Bit-mapped display are made up of small pixels and offer
a very high resolution. Bit-mapped displays have almost replaced character-based displays.
Bit-mapped displays wonderful support graphic manipulation. This feature of these displays
is also called WYSIWYG i.e. What You See Is What You Get.

Functionality to support graphics along with height-parameters, color attributes, video-
attributes, etc.

Icon : Icons provide a symbolic representation of any system-entity or user-defined object,
etc. such as file, folder, address, table, book, applications and so on. A folder icon consists a
group of files or other folder icons. Double clicking on the folder icon causes a window to be
opened displaying a list of icons and folder icons representing the folder's contents.

Dialog box : Dialog box is used to capture user information or to present information to the
user. Normally, a dialog box is displayed to get additional information. Dialog boxes are also
used to indicate error messages in the form of alert boxes. Dialog boxes also use a wide range
of screen control elements to communicate with the user.

105

Remarks



106

Remarks

D

k)

)

Computer Applications in Business

Check box : Such a box is used to capture the information intending confirmation pertaining
to any kind of actions desired by the end-user.

Sliders : These are used to show the relative position of the contents or to move to a different
position.

Desktop Metaphors : In desktop graphical metaphor, users are not aware of applications and
they deal with files, folder, drawers, clipboard and an out-box. For example, merely clicking
the mouse on an icon representing the Report cause word processor to get started and to load
the report file automatically.

Menus : The functionality on a GUI system must be arranged in the form of structured
menus such as horizontal menus, pull-down menus, etc. From the menu, the end-user can
select any operation of his choice such as File, Edit, Search, Tool and so on. Rather than
remembering commands at each stage, a menu can be used to provide a list of items. Each
menu element can be either a word or an icon representing a command or a function. Menu
item can be invoked by moving the cursor on the menu item and selecting the item by

clicking the mouse.

5.15.2.2Components of GUI

GUIs consists of four major components :

a)

b)

d)

Windowing System : It allows to display multiple applications at the same time and it
includes programming tools for designing movable and resizable windows, menus, dialog
boxes, check boxes, and other items on the display.

Example : Macintosh, X Window, etc.

Imaging Model : It describes how fonts and graphics are designed on the screen and such a
model is capable of handling typeface, color, shading, dimension and size of graphical
primitives such as simple or complex lines, curves, etc. Some GUIs support more than one
imaging model.

API (Application Program Interface) : API is a set of programming language functions that
allow the programmer to specify how the actual application will control the menus, scroll
bars and icons that appear on the screen.

Set of Interface Development Tools : GUI development environments may incorporate
toolkits and frameworks. Most of these toolkits are based on object-oriented approach.

5.15.2.3 CUI Vs GUI Operating Systems

Table 5.1: CUI Vs GUI OS

GUI Cul

It is based on graphical user interface mode. | It is based on command user interface mode.
It is graphical and user friendly. It is more textual and less user friendly.

It is very common. It is less common.

It uses keyboard and mouse. It uses only keyboard.

It consists of different components such as | It does not consist such components.
text box, icon, desktop, pointing device etc.

E.g. MS-Windows OS E.g. MS-DOS OS
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SUMMARY OF THE LESSON

You learnt the following in this lesson:

The software acts as an interface between the user and the computer or a software can be
defined as a complete set of instructions written by the programmer which enables the
computer to obtain the solution to a problem.

There are different types of computer software such as Programming Software, System
Software and Application Software

An application package or application program is the software that has been written to
process or perform specific job.

Operating System (OS) is a collection of software written to provide the fundamental
instructions that a computer needs to manage resources, such as memory, the file system, and
processes.

The control programs consist of Supervisor Programs, Job Control Programs and
Input/Output Management Program

Windows Explorer displays the hierarchical structure of files, folders, and drives on your
computer. It also shows any network drives that have been mapped to drive letters on your
computer.

Both in Windows 7 and Windows 8, the Print Management console is part of Administrative
Tools.

The Control Panel is a part of the Microsoft Windows graphical user interface which allows
users to view and manipulate basic system settings and controls via applets, such as adding
hardware, adding and removing software, controlling user accounts, and changing
accessibility options.

Paint formerly known as Paintbrush for Windows is a simple graphics painting program that
has been included with almost all versions of Microsoft Windows since its first release. It is
often referred to as MS Paint or Microsoft Paint.

In Windows and other operating systems, the Clipboard is a short-term storage area for all
kinds of information that you have copied from one place and you plan to use in another
place.

The ‘My Computer’ icon gives us easy access to our hard drives, removable flash drives and
other network-related locations.

A programming language consists of all the symbols, characters and usage rules that permit
people to communicate with computers.

Programming language is a systematic notation by which we describe computational process.
Computational process means steps for solving a problem. Programming language consists of
symbols, characters and certain rules.

Another categorisation on the basis of the introduction of the programming languages is as
follows:

e First Generation Language : Machine Language

e Second Generation Language : Assembly Language

e Third Generation Language : High Level Languages

e Fourth Generation Language  : 4 GLs (4" Generation Languages) or
Very High Level Language

o Fifth Generation Language : Natural Language

Unix (pronounced as YOO-niks) is a family of multitasking, multiuser and time-sharing
operating system that is derived from the original AT&T Unix, developed in the 1970s at
the Bell Labs research center by Ken Thompson, Dennis Ritchie, and others. UNIX is the
trademark.
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o UNIX is a multi-user operating system. This means that multiple users can use the system at
the same time. Concretely, this means that, for instance, dozens of users can log in from a

certain location on the same server.

e Linux is a generic term that commonly refers to Unix-like computer operating systems that
use the Linux kernel. Ubuntu, NepalLinux, UserLinux etc are few examples of Linux

distributions.

e GUIs consists of four major components - Windowing System, Imaging Model, API
(Application Program Interface) and Set of Interface Development Tools.

SELF ASSESSMENT QUESTIONS AND EXERCISES

What is software? What are its different types?
What is a programming language?
What are different generations of programming languages?

Differentiate between application and system software.

What is meant by GUI ? What are the important features of GUI ? Explain.

What are various components of GUI ? Explain.
What is an operating system ?
Discuss the important functions of an operating system.

What is a bootstrap program ?

. What is a File Manager ? Outline its responsibilities.
. Is word-processing package a system software ? Justify your answer.
. Discuss the features of an integrated package.

. What are advantages of Windows environment ?

Enumerate functions of a monitor program.

. Chart the family of operating system.

. What is Windows operating system? List its important versions.
. What is the purpose of a clipboard?

. What is Print Manager?

. What is ‘My Computer’?

. What is Paint program/Paint Brush?

. What are main features of Windows operating system?
. What is Control Panel? How is it useful?

. What is UNIX operating system? How did it evolve?

. What are important UNIX commands?

. What is LINUX? What are its flavours?

. What are different types of user interaces?

. What are components of GUI
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E-Commerce

Meaning of E-Commerce

Features of E-Commerce

Types of E-Commerce System

Benefits of E-Commerce

E-Commerce Technologies

Electronic Fund Transfer

Security Schemes of an Electronic Payment System
Electronic Data Interchange (EDI)
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. Steps in an EDI System

10. Components of EDI

11. Application of EDI

12. Advantages of an EDI System

E-Commerce
1. Meaning of E- Commerce

E-commerce is defined as the online buying and selling of goods and services or the transfer
of funds or even transmission of the data/information electronically. It is primarily done
using the internet and regarded as a modern method for business. The use of platforms such
as Amazon, Flipkart, etc. has grown the online retail market. E-commerce has grown from
5.1 per cent in 2007 to 16 per cent of total sales in 2019.

e How does E-Commerce work?

Using the internet on mobile, laptops or computers, the customers can access and browse any
online store and then can place orders for various products or services. Data pertaining to the
order reach to the server hosting the website for the online store from the customer's
web browser and then conveyed to the central computer of the order manager.

After that the information is forwarded to various channels for processing:

A. To the databases for managing the inventory levels.

B. To the merchant system for managing payment information

C. To a bank computer for successfully processing the order.
Then the information circles back to the order manager. After the validation of the order, the
order manager notifies the server of the store by displaying a message which in turn will
notify the customer about the order status. After this, the order manager sends order data to
the warehouse (for tangible or digital product) or to the fulfilment department (for service) to
be successfully dispatched to the customer. Then the products may be dispatched to the
customer, or access to ordered service by the customer may be allowed to the customer.
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E-Commerce Includes:

Electronic Data Interchange
e-mail

Electronic Fund Transfer
Electronic Bulletin Boards
Other online modes

Electrenic Document Interchange

\

Electronic
Fund Transfer
(EFT)

Electronic Data
Interchange
(EDI)

Marketing,
Advertising

Infarmation
Sharing

Electronic
Publishing
Sales, Customer

Support

Corporate

Digital Library
Collaborative

Work

o

Cashless Payment: For the payment of the orders the use of cashless channels like credit
cards, debit cards, e-wallets, electronic fund transfer through net banking, etc.is made.

-

Electronic Messaging

2. E-Commerce has following features

Availability: E-commerce service is available 24x7 anytime and anywhere.
Advertising: The advertising and marketing of has increased manifolds using this platform.
Better Sales: E-commerce boosts the overall sales.

Support: -commerce provides assistance to provide better services to customers before,
during and after placing the orders.

Inventory Management: Due to automation, the product inventory management has
become very easy.

Communication improvement: E-commerce provides for easy, faster and efficient
communication with customers.

3. Types of E-Commerce

Business to Business E-Commerce

In B2B type, the products are first wholesaled to an intermediate. Then the wholesaler sells
these products through its retail outlets to the end user or final customer.

Business Organization

£
i 1
Supplies 1
B 1 Order
1 Processing

. . Orders

( Wholesaler Website

Sells

P, N
( Customer ]

\\\___—___//
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Business to Consumer E-Commerce

When the website trades directly with the customers, it comes under purview of B2C mod
of e-commerce. The customer can view, choose and order a product then and there.

Business Organization

A
; 1
Supplies 1
PP 1 Order
1 Processing
v
Orders
( Customer r————p Website
N o
e

Consumer to Consumer E-Commerce

When a website helps the consumers to sell their own assets like property, motorcars, bikes,

electronic items, etc. or to rent a room by advertising. Other consumers have the option to
buy the product on that website.

Places advertisement

Website

Want to sell products Want to buy products

e, receives products

'Z:_ Customer 1 ) ( Customer 2 )

Consumer to Business E-Commerce

A website under C2B model shows various business organizations or companies for [a
particular service. The consumer may visit the website and offer his budget for a particula
service. For example, interest rates of a particular loan are advertises by various banks. Th

bank meeting the consumer requirement with this budget may approach him/her back fq
offering its services.

= O =

Website

Processes Order Places money for
particular service

receives products

Business Organization

N4

—_—
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Business to Government E-Commerce

The government makes use of some websites to trade and to disseminate information about
its services to business organizations. The business organization may apply on these websites
for any trade/service with the concerned department of the government.

Government

Business Organization ‘l: Website [

Government to Business E-Commerce

Websites under G2B model are used by government to reach various business organizations
for auctions, tenders, etc.

Government

| Website [

Business Organization ‘

Government to Citizen E-Commerce

The websites under G2C type of e-commerce are used by the government to approach
citizens for delivering many of governmental services. Activities like auctions of motor
vehicles, machines, etc. and services like registration of marriage, birth/death registration and
application of various welfare schemes.. It greatly reduces the time for the service to reach
the citizens.

Government | [ Website =

* Citizen

\

Mobile E-Commerce (M-Commerce) is very popular now a days that features mobile shopping,
mobile banking and mobile payments.

4. Benefits of E-Commerce

1.

ii.

iii.

iv.

1.
1il.
1v.

Availability: Most of the websites associated with e-commerce are available 24x7.

Speed of access: E-Commerce sites run quickly on basis of bandwidth of both consumer device
and e-commerce site.

Wide availability. E-Commerce sites cover a vast area even all over the world where internet
facilities are available

Easy accessibility: Almost all the e-commerce websites are very easy and fast to use.

Lower cost: E-commerce businesses lessen that cost which would occur in offline mode.
However shipping and warehouse costs are associated with the e-commerce

Disadvantages of E-Commerce

Narrow customer service as some places are not approached by E-commerce websites.
Not being able to touch or see

Long Wait time

Security risk

5. E-commerce Technologies

To compete, earn more and maintain customer satisfaction and safety, various technologies are used
in the e-commerce market.
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i.  Artificial intelligence (AI)

Al reveals the valuable insights of what the customers prefer which are very useful in marketing
campaigns and communication automation. Mostly it is believed that the user experience is an
important tool for improving sales which is facilitated by Al. As Al can predict customer behaviour
and preferential patterns, websites can recommend relevant and useful information and suggestions to
the customers on various products and services.

1. The Cloud

The cloud is very essential for the instant access of data/information and to manage it. The cloud ERP
in e-commerce improves the delivery speeds and hence the stability and growth.

iii. Chatbots

Chatbots nowadays are replacing on-call solution scenarios. For customer satisfaction, Chatbots are
wide-spread in e-commerce applications which are very helpful in providing a variety of services and
solutions. Chatbots are available 24x7 (day and night) and provide answers after responding to the
queries.

1v. Voice assistants

This feature/technology may be called Voice commerce. It allows the customers to use voice
commands for e-commerce. Various voice assistants like Siri, the Echo, and Google Home are very
popular for their easy use.

v.  Audio brand signatures

Any specific auditory tone is considered an audio brand signature for a specific e-commerce
application. It provides recognition to the brand and helps customers to remember the same.

vi.  Assistive technology

In the e-commerce world, assistive technologies are very helpful to reach and approach those
customers who could not have this experience before. E.g. the visually impaired persons can also
experience e-commerce using speech-to-text technology.

vii.  Image search

Using this technology, customers can photograph the products of their interest and find alike products
on other websites offering better deals.

Electronic Funds Transfer

Now a days this technology is very popular which is used for transferring the funds/moneyfrom one
bank account which is debited to another bank account which is credited with the same amount
electronically and this transaction is referred to as a paperless monetary transaction. POS terminals in
retail stores are connected to EFT systems of banks via WANSs for instant payment.

Following are some of the types of electronic payments:
i.  Credit Card

The most common type of electronic payment is payment using an active credit card which is a
small plastic card having a distinctive number which is linked with an account. Card reader reads the
card no. using the magnetic strip embedded on this card. The issuer bank makes payment to the
acquirer bank for the customer when the customer purchases something from a merchant. After a
certain time period the customer will have to pay the credit card bill.
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ii. Debit Card

Debit card is a plastic card having a unique 16 digits number that is linked with the customer’s bank
account. It is also having name of the customer and expiry date of the card. On the back side of debit
card there is a 3 to 4 digit CCV number. When some payment is done using the debit card, the
amount gets debited from the linked bank account instantly if the transaction is successful. There is
no such compulsion of maintenance of account balance when the payment is done using the credit
card.

Remarks

iii. Smart Card

Smart card has a little microprocessor chip fixed in it. This chip can store the required encrypted
information. Smart cards carry cash and when used for some payment the amount gets deducted. This
type of card can only be accessed using customer self-given PIN. These cards are very safe and
secure because these store information in coded format. E.g. Mondex and Visa Cash cards.

iv.  E-Money

When payment of some purchase is made over the network. The transaction occurs very quickly from
one financial entity to another with no middleman. E.g. Paytm Wallet, Amazon Pay, etc.

v.  Electronically Fund Transfer

For transferring the funds or money electronically from one account of a bank to another account of
same or different bank. Transfer can be done using Net banking or even ATM. Customer's bank itself
makes the payment if the recipient is having an account with the same bank, otherwise the request for
transferring the funds is forwarded to an ACH (Automated Clearing House).

vi.  Security Schemes of an Electronic Payment System
Security in e-commerce is an important and challenging issue especially for electronic
payment. There are some requirements for secure electronic payment which are as follows:

e Confidentiality: All the information of a customer must be confidential.
e Integrity: Integrity of the information must be maintained.
e Authenticity: Authentication of the user must be verified systematically.

e Non-Reputability: It simply means that the sender cannot deny sending of a message and
the recipient of a message cannot deny the receipt regarding an electronic payment

e Encryption: Personal information must be encrypted which must be decrypted only by a
genuine customer.

e Auditability: The recorded data which is used for the transaction should be auditable so that
if there is some kind of fraud, it can be traced.

Data during electronic payment is encrypted to decrease its vulnerability to fraudsters. On the internet
platform, Secure Sockets Layer (SSL) and Secure Electronic Transaction (SET) are two important
standards used for secure transactions.

6. Security System of Electronic Payment System
There are some important measures which ensure security and safety of the online payments

e Encryption: It is a very effective and efficient way to secure the information. The encrypted
data can only be decrypted by a specified user.

e Digital Signature or e-signature is authenticated, valid and encrypted tool which ensures the
authenticity of the information.

e Security Certificate: It is a specifically provided distinctive digital Id used to verify the
authenticity of any website/user.
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= Security Protocols for Internet
The following security protocols are used over the internet to ensure the secure online transactions.
i.  Secure Socket Layer (SSL)

The most commonly used protocol which provides security and safety in terms of authentication,
encryption, integrity and non-reputability.

"https://" before the web address of any website is used with SSL instead of "http:/". An additional
‘s’ stands for secure.

ii.  Secure Hypertext Transfer Protocol (https)

This protocol supports multiple security mechanisms. The basis of this security protocol is
encryption which provides the security to the end-users.

iii.  Secure Electronic Transaction (SET)
MasterCard and Visa developed this security protocol which is having following components:

e Digital Wallet Software: Digital Wallet are the e-wallets associated with various e-
commerce websites. These wallets assist protected purchases online because payment occurs
through point and click interface then and there.

e Merchant Software; Such software help merchants in communicating and trading with the
customers in a secure and protected way.

e Payment Gateway Server Software provides a good feature for automatic, standard and
uninterrupted payment processes.

o Certificate Authority Software: The customers as well as the merchants enter into an
agreement and get their accounts registered for secure electronic payments.

7. Electronic Data Interchange (EDI)

Basics of EDI: It is an electronic and online way of sharing the soft copies of documents regarding a
business in an organisation internally (between its various departments) or externally (with suppliers
or customers). E.g. Word documents, Excel sheets, etc.

Electronic Fund Transfer facility like NEFT, RTGS in banking sector is a good example of EDI.
= EDI Documents
The important documents that are shared using EDI are following:
e Bills and Invoices
e Purchase orders
e Acknowledgement
e Shipping/dispatch Requests
e Correspondence/communication letters
e Letters with Financial information like that of related to bank accounts
8. Steps in an EDI System
The steps used in an EDI System are as follows:
I. A file containing the processed document is generated by a program.

II. Then the conversion of that document into a file with some standard format occurs.
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This file containing the document is sent electronically either internally or externally on the
network.

The trading partner on the other side receives the file delivered electronically.
At last an acknowledgement is generated which is shared electronically.
Components of Electronic Data Interchange (EDI)

Standard Document Format: A standard format which is agreed upon by both parties is
used for communication.

Translator and Mapper: A translator converts the raw data into meaningful information.
For this a mapper creates some conversion specifications.

Modem: It is a device which is used to transmit data from one computer to another.

Communication Software: It is used to transmit the data and convert various documents
into a specific standard format.

Communication Network: It provides a direct link between the two partners.
Point to Point link: It is a direct communication link between two computers only.

VAN: It is a type of network that connects the computer system of two or more
organisations.

. Applications of Electronic Data Interchange (EDI)

Retail Sector: Here in this sector usually the profit margins depend upon efficient inventory
management.

I""":II
POINT OF SALE TERMINAL SCM™
5 e
[STOCK UPDATE) Stock Motice NETWORK
via EDI \ Purchase
Request
LA AR TN A R 1L L LR R FI L E] i SUPPLIE
Product Delivery Natice via EDI i
EDI in Retail Sector

EDI in the retail sector helps in the maintenance and replenishment of goods that are stocked
at any of the retail outlets. The position of point of sale stock is updated continuously online.
This data is fed through EDI enabled SCM network (supply chain management network).
The EDI also helps in monitoring the logistics and updating of the original stock.

Manufacturing Sector: EDI in the manufacturing sector ensures the efficient management
of the materials that are required for the production of a commodity timely.

. o i .' [Tt > SUPPLIER

Inventory Request

k

Inventaory Update
(LSRR . MANUFACTURER

EDI in Manufacturing Sector
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The Inventory position is constantly updated using EDI and thus the supplier is informed
about this which help in further planning

2. Automobile Sector: Here the EDI is used to keep the customers updated with the current

products and their prices. EDI also ensures proper receipt of the product and facilitates
payment for speeding up the process.

3. Financial Sector: In this sector EDI efficiently replaces the labour intensive activities. These

include collection and dispersing of monetary payments. It facilitates the flow of money
without any human intervention. One account is debited and the other account is credited
electronically.

11. Advantages of an EDI System

Data entry errors are minimised.

Faster response time

Easy transfer of electronic form of data
Reduction in paperwork

Cost Effective

Standard and clearer means of communication

Self Assessment Questions

Short Answer Type Questions

XN R LD =

10.

What do you mean by E-Commerce?

Define E-Mail.

What is meant by cashless payments?

Explain C2C E-Commerce.

What is M-Commerce?

What do you understand by artificial intelligence?
What do you meant by chatbots?

What is meant by EFT?

What are the types of EFT?

Define EDI documents.

Short Answer Type Questions

AN e

What is E- Commerce? Discuss its working and features in detail.

What are various types of E-Commerce?

Define E-Commerce technologies.

What is meant by electronic fund transfer? Define various types of electronic payments.
What are the important measures to insure the safety and security of the online payment?
What is electronic data interchange? Discuss the steps and components of electronic data
interchange.

Define EDI. What are the various applications of electronic data interchange?
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CHAPTER-7

INTRODUCTION TO MS-WORD

OBJECTIVES OF THIS LESSON
This lesson is aimed to make you understand the concepts of word processing and MS-Word. Readers
will be able to understand the following:
e Concept and features of word processing

Basic concepts of MS-Word
Different components of Word document window
Different types of Menu and their various options
Various types of Toolbars with their different options
Different ways for text and document formatting
To check the spelling and grammar mistakes of text of document
Creation and formatting of table
Working with graphics i.e. various ways to insert the pictures in Word document
Concept of Mail Merge

STRUCTURE OF THIS LESSON

6.1 Introduction

6.2 Word Processing

6.3 Features of Ms-Word

6.4 Starting Ms-Word

6.5 Components of Word Document Window
6.6 Basic Commands of Ms-Word

6.7 Documents and Text Formatting

6.8 Tables and Setting

6.9 Working with Graphics

6.10 Introduction to Mailmerge

SUMMARY OF THE LESSON
SELF ASSESSMENT QUESTIONS OR EXERCISES

7.1 INTRODUCTION

There are many ways of conveying information. Writing is one of them. Earlier we were using
manual typewriters to prepare documents, then electronic typewriters and now we are using
computers to prepare any type of document. Many applications programs have been developed that
helps us to quickly create documents with a professional look. One such most popular program is
word processor. A word processor provides general tools for creating, editing, saving, formatting and
printing the documents. We can create all types of documents that are used in our daily lives with the
help of word processor. In fact word processor provides a great role in every field for creating
different types of documents. Therefore, it is suggested generally that every person must be aware of
word processing and its features.

7.2 WORD PROCESSING

Word processing specifies the use of hardware and software to create, edit, view, format, store,
retrieve and print documents. Word processor is a computer program that is used to type text, align
text, provide variety of font styles and sizes etc. With the help of this, users can make their document
more effective by combining text, graphics and images. There are number of word processors such as
MS-Word, Word Star, Write, Word Perfect, Chi Writer etc. MS-Word is the mostly used word
processing system.
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MS-Word is used to do simple as well as complex task. MS-Word facilitates for entering, editing,
formatting and printing text. It helps to type the text, correct spelling mistakes and grammatical errors
align text. It also offers different font styles and font sizes. This is used to create different types of
documents such as letter, calendar etc.

7.3 FEATURES OF MS-WORD

MS-Word is the most famous processing software package. MS-Word is composed of various
features and can help to edit, format or many other types of formatting with document so that it will
appear more attractive and effective. MS-Word is used:

- To enter text

- To edit text or to make changes in existing document.

- To define different page layout for a document.

- To format text in a document to enhance its appearance and readability.

- To display documents in different layout such as normal, web layout, print layout, and outline
etc.

- To save, retrieve and delete documents.

- To print documents and to see the preview of that document.

- To import text, graphics and images.

- To search and replace text strings.

- To check spelling and grammatical mistakes and to correct use of improper writing styles in a
document.

- To write text in different sizes of fonts.

- To link with other documents.

- To define page number on different documents.

7.4 STARTING MS-WORD
To start MS-Word:

e Click on Start button
e Then click on All Programs
e Click on Microsoft Office
e Seclect Microsoft Word.
@] s (L Renate Assstence ) Microsodt Dffce Tools v
2 (B} wirdows Mede Flayer [#] Mcroscft Office Bocmss 2003
‘& Windavss Messeager R windows Messenger (3] Microscit OFfice Excel 2003
@ Motenad @ wirdows Movie Maker [#] mieroseit office nforath 2003
c"_'E] CPULD ¥ _I_) Microsof Offace Cutlook 2003
@ Microsodt Office Exocd] W) Moails Frefos [l [@] prerescit oifice Pawerpeint 2003
) Bekin LISE WLAN Utity (B ticroscft Oiffice Fublisher 5003
fE | Microsaft Offics B Microsoit Office Word 2007

ifstart. £ YO Em

7.5 COMPONENTS OF WORD DOCUMENT WINDOW
The parts of Word Window are shown in Fig...... and they are described below.
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Title Bar Formating Toolbar
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Title Bar

This bar tells which application package and document are currently running. It also displays the
program and document name.

Menu Bar

This bar is just below the Title Bar. When you point to any menu title and click once with the mouse,
the menu will open displaying all the commands available under this menu title. Clicking the desired
command will tell word to execute that command. Some commands have ellipses (........ ) in front of
them. These commands have further sub-commands, or options. Commands appearing dimmed
cannot be used.

Standard Toolbar

The standard tool bar contains buttons, drop-down menus and other controls that help you quickly
alter the appearance and arrangement of document. Toolbars are very helpful and convenient in
quickly executing commands without having to go through menus. The Standard toolbar contains
icons for basic functions like opening files, saving files, printing files, cut, copy, Paste etc.

Formatting Toolbar

This toolbar contains icons styles, font for changing the appearance of text for example; there are
icons for changing fonts, font styles, font sizes, text alignment etc.

Ruler

The ruler helps to make changes in margins and indents, and also create document as per the
dimensions required.

Scroll Tools

Through this bar, you can travel within your document. You can go anywhere, up and down, and right
and left in your document using following-

Scroll Bar
Previous page

Scroll Arrows
Scroll Box

Next Page
Arrow Key



Status Bar

Status bar is also known as Status Area. Basically it is the last line on screen. This gives the following

information about the work-

Section Number

Line Number

Column Number
Cursor

Current Page Record Macro
Total Pages

Cursor point

Insertion Point is its other name. This denotes the place where text, graphics or any other item will be
placed when you type, overwrite or insert them.

Mouse Pointer

When mouse pointer looks like an I beam, you should be able to move it freely about the screen. This
is used for either placing the cursor at the desired place or choosing any command either from menu

or from toolbars.
Mouse Operations

1. Pointing:- Move the mouse pointer until the pointer is on the desired item.
2. Clicking:- Move the mouse pointer to the desired position and then press the mouse

button once.

3. Double Clicking:- Move the desired pointer to the desired position and then press the
mouse button twice in rapid succession.

4. Dragging:- Move the mouse pointer to the right place, press the left mouse button, keep
it pressed and move the mouse simultaneously.

FILE MENU

7.6 BASIC COMMANDS OF MS-WORD

L
§
1= TRRIE

Ciries =

File Search.

Permiccion
Wersions...

“Web Page Preview
Fage Setup...

Print Preview

=

Print... Chri+-P
Send To 3
Froperties

1 G\ Ybcom_6 may

2 G:\EXCEL OVERVIEW

3 G:\word-File[1]

4 G:\Word processorm . com

Exit

The File menu contains a number of options, which are following:-

e NEW- This creates a new document. It can be from scratch or from a template.
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EQ Document 1 - Microsoft Word

Ele w View  Insert Fgmy; Tools  Table W Help Type aquestionforhelp = X
0 e A o820 -E" 99 0 pirent
1] o oo enkann 12 .|n P’ u_.; EE.EEEEDA
Bl ] Cluse
[ ...|.<.1...|...2...|...3.H|...4...|<..5J~

1 Save s,
Save as Web Page. .
File Search, .
| Permission 14
| Wersions. ..
J ik

OPEN- Already prepared document is opened through this command. To open file following
steps are used:

Click on Open in file menu.

Specify the name of folder in which file is saved.

Select the file by clicking on it.

Then click open for opening the file.

Lookin: |E:]M5-'Documarls v|@-j|d}&a:v
) Company Reports
[CIDownleads
My Recent @m MMusic .
] Ename
Documents Lﬂ”‘f’ Pictures EName
— |Z)Presentations Prink
@ (L2 Time Wasters | Add kg My Places"
Rl Map E:&-mrk Drive.,
\' ; Properties
Py Documents
My Computer
I!g File name: v” m
Py Metwork . | | =
Places Files of type: | all word Documents v Cancel
e

CLOSE- currently working document is closed.

SAVE- It saves document either on H:/ drive or on C:/ drive or on disc or on CD ROM. This

can be done by clicking on Save option in File menu
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i File Edit  Yiew Insert Format  Tools

Table

[ oOpen... -0

ave Chrl+3

= |
Save As,.,
|4y Save asWeb Page...

File Search, ..

Permission

Versions...

Wweb Page Preview

Page Sefup...

Print Preview

W ke

Print... Chrl+P

Send To

Properties

1 Zi\Documents and Setkings', . \exceptiona

2 ChDocuments and Settingsilil.. .\Table

Exit

e SAVE AS- This command allows to save the current document again with different
location and/or under a different name. Steps are:

- Click on Save As in File menu

- Type the name of file in box

- Click on Save to make the changes safe.

2=
Sawe in: I@ Deskiop H@-a @ X i3 - [Taols ~
i lDMy Documents P
b’ J My Computer
My Recent % My Mebwork Pl
Documents 3 ¥ e Haces Add to "My Place
— Map Metwork Drit
Properties
Desktop -
|: Save Options. ..
35 Security Cptions
‘web Cptions...
My Dacuments £eh Uptions
Compress Pickure
;;J]g Save Yersion..,
'.--
My Cornputer
i File name: IDDU doc j Save
Iy Mebwork
Places Save as bype: IWord Document . doc) j Cancel )

e SAVE AS WEB PAGE- Saves the document as a web page and can be linked to web.
e SEARCH - The Word files containing the key words type in the box will be searched by this

command.
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VERSION — used to save different version of document, by date.
WEB PAGE PREVIEW - to preview how document would look like as a web page.

PAGE SET UP- to set the margins selects page orientation, selects paper source and size, add
line numbers and borders and view the page in preview mode.

Page Setup =N =

Margins | Paper | Layout
Margins
Top: [1] - Bottom: | 1 -
Left: 1.25" S Right: |1.25" =
Gutter: 0 +| Gutter position: |Left E]
Portrait Landscaps
Pages
Multiple pages: Normal =
Preview
Apply to:
Whole document =]
Default...

To change the Page Margin
Select the Margin tab on Page Setup Screen in File menu
Enter the value for set the margin in box.

To set the Gutter Margin

Select the Margin tab on Page Setup Screen in File menu

Enter the value for set the margin in box.

Click on right or upper in Gutter Position Box to give the space.

PRINT PREVIEW- This view shows how a document will appear on paper without actually
printing it. This is helpful to make the appropriate document if there is any mistake in that
document.
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PRINT- Print all pages in the active document or the currently selected page or a range of
pages.

Steps are:

Select Print option from File menu.

Select Printer or default printer for printing.

Select All (If all the pages of document are to be printed) or write the number of pages in
Page option to print the specific pages.

Click OK.
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e 2|

Printer
Mame: | <58 \FTYPRESS P DeskJet 570C =] Properties
Status: Idle
Type: HP Desklet 670C
Where: LPTL: I~ Print to file
Comment:
Page rang Copir
Al Number of copies: 1 E‘
™ Current page ™ Selection
" Pages: || 11 11 ¥ Collate
Enter page numbers and/or page ranges
separsted by commas. For example, 1,3,5-12
rZoom
Print what: IDncumEnt 'l Pages per sheet: 1page vI
Print: IAII pages in range VI Scale to paper size! (Mo Scaling VI
optins..._| cose_|

To Print More than one copy at same time
- Select Print from File menu
- Write the number of copies in box for printing.
- Click OK.
To Print Even/ Odd numbered Pages
- Select Print from File menu
- Write the Even or Odd pages from drop down list in Print box.
- Click OK.
e SEND TO — used to send document to a variety of places.
PROPERTIES - to show the details of current document.
e EXIT- used to exit from both the document and M.S. Word.

EDIT MENU

BN

: o &1 Cut Crl+
s ER ke
G b= et
ol 8] Office Clipboard. ..
_
) 4 Paste Chri+y
- Paste Special...
- Paste as Hyperlink
5 Clear 3
i Select all Chrl4+-a,
: #4 Eind... Ctril+F
- . a8 PPET]
Repiace.., Cori+H
- Go To. . Ctil+G
- Links. ..
. Ohiect
| o

This menu involves a number of editing options, which are following:-
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UNDO & REPEAT — This command undo or repeat the action that has performed.

CUT- It takes out the highlighted text.

) Undo Oear CoHZ
% cu ek
43 Copy CtriC
[ Office Clipboard...
% Paste Chri+Y

COPY- used to copy the highlighted text.

€} Undo Clear  Chrl+Z

& Cut Chrl2
T

|k Office Clipboard. ..

% Paste Cerl+y
Select All Chrl4a
3 Bnd... Chrl+F

| ¥

OFFICE CLIPBOARD - used to collect text and graphics from different documents or other

program and then paste them into any office document.
PASTE — used to paste copied text or graphics.

PASTE SPECIAL — used to paste text in HTML or unformatted text.

PASTE AS HYPERLINK — used to paste material as hyperlink into document.
CLEAR- it is the other way of delete as it clears all formats or contents.
SELECT ALL- It selects the whole text for formatting or deleting.

Jek Office Cliphoard...
4 Paste Ctrl+V
Paste Special...
Clear . i
elect All Chrle o
c——-“'
3 Find... Ctrl+F
: Replace... Ctrl+H

FIND- It looks for a word or phrase within your document.
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Fimd |Reglace| Go To I

Find what: I j

™ Highlight alliterns Found in:
IMair. Document j

Il Fird ezt I Cancel

Search Options
Search: all -
[ Match case
™ Find whale words only
[ Use wildcards
I Sounds like (English)
™ Find all word Forms (English)

Find

Format = | Special = | Mo Formathing |

e REPLACE- It replaces a word or phrase in your document with any other word or phrase.

e GO TO- This command will take you to the place in your document where it finds the text

Fird Replace | GoTo |

Find what: I LI

Less % | Heplace Feplace &l | Find [Hext I Cancel

Replace with: | ;I

Search Options
Search; all -
™ Match case
I Find whale words only.

I Use wildcards
I sounds like (English)
I Find all word Forms (Endlish)

Replace

Farmat = Special * IoFarmathing

you type in the box.

Find IRep_Iace Go To |

G0 ko what; Enter page number:

Enter + and — to mave relative bo the current
location. Example: +4 will move Forward Four
items,

Fooknoke

Endnote v
J Previous | Mext I Close
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The view Menu involves a number of viewing options, which are
following:-

Computer Applications in Business

LINKS — used to display or change information for each link in current file. (It is unavailable
if no links are present in document)
OBJECTS — used to edit the objects placed in document.

NORMAL: This view lets the user to see the document
using the whole screen including any formatting.

WEB LAYOUT- Through this view, user can see the
document as it would appear on a webpage.

PRINT LAYOUT-Through this view, user can see ruler
and can adjust margins or tabs. It also allows seeing the
edge of document as it would appear when it is printed.
OUTLINE- User can see the document as in Normal view
but without any formatting.

TASK PANE — used to show the options like templates for
new documents from other documents, the clipboard,
ClipArt & Styles and Formatting.

TOOLBARS- You can see all the different toolbar options
and to invoke and customize them.

RULER- For adjusting margins, this command activates the ruler in PRINT LAYOUT view.
DOCUMENT MAP — used to see different styles that have been applied to document.
HEADER and FOOTER- It allow creating Header and Footer for document. In this we can
add time, date, page number etc.

FOOTNOTES- This command allows to go to the footnotes, which already prepared in
document.

MARKUP - used to display or hide comments or track changes such as insertion, deletions
and formatting changes.

FULL SCREEN - it allows using the entire screen to view the document without any Menu
or Toolbar.

ZOOM- used to zoom in or out of document.

] P Y

Insert Menu Insert | Format Tools Tabi
Insert menu has many commands which are very useful for inserting Eeakm - ]
different things into document. These are following: ] 2o tumers. - I
Date and Timne. ..
e BREAK - used to insert Page break, Column break or text - SwtoText »
Wrapping Break into document. Field...
e PAGE NUMBERS- used to insert page numbers into document. Symbol...
e DATE AND TIME- used to insert date and time into document. | Comment
e AUTO TEXT - used to insert automatic text into document Reference >
selected from a list of options.
e FIELD — used to set a field within document such as user name, Picture >
address block etc. £33 Diagram...
e SYMBOL — used to insert a symbol into document either picture || ~J| Text Box
or alphabetical symbol. File...
e COMMENT - used to insert a comment into document. Object...
e REFERENCE - used to insert a caption, footnote, cross- Bookmark...
reference or an index and table into documents. & Hyperlink...  Chri4K
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WEB COMPONENT - used to insert web pages components as link bars for navigation.
PICTURE- allows inserting picture from Clipart or from file.

DIAGRAM - used to insert an organizational chart from different choices.

TEXT BOX — used to insert text anywhere within the document and move the whole box
around.

FILE — used to insert another file directly into document.

OBJECT — used to insert an object into document such as Adobe Photoshop Image, Acrobat
file or Bitmap image.

BOOKMARK - used to identify a location or text selection that user name and identify for
future reference.

HYPERLINK- adds a hyperlink when the address of a webpage is typed.

Format Menu

These are different options:

!
E.
i
I!Z
:

s
H

FONT- It changes the style of font, size, color and formatting

applied to fonts. ; ;;;x b I
PARAGRAPH- used to change alignment, indentation and :i= suiets sndpumberna. . —
spacing. Biordders and Shadng,. |
. E8| Columns..,

BULLET AND NUMBERING — used to change bullets, their Lobs. —
indentation and the indentation of bulleted text. Dran Can
BORDER AND SHADING - used to apply border to o
document, to apply shading to paragraph(s) or document. ;a'ckr:;_: \
COLUMNS - used to insert and edit columns into document. & Theme...
TABS- It sets the tabs for document. =

A MukoFormat...
DROP CAP - allows taking first letter of word and gy syiesasndrometng...
capitalizing it and pulling it away from text. AL ReyeslFormatting... Shit+Fi
TEXT DIRECTION — used to rotate selected text in table = 'm=trextee

cells that the user can read it from top to bottom or from bottom to top.

CHANGE CASE - used to change words to upper case, lower case, toggle case, title case or
sentence case.

BACKGROUND - used to change the color of document, add pictures, watermarks, pattern
etc.

THEME - used to apply formatting theme ( heading, fonts, background colors and bullet
point) to document

FRAMES - used to make information easier to access or to display the content of web sites
that has multiple pages.

AUTOFORMAT - allows choosing settings that will automatically apply those changes to
every document written by user.

STYLE AND FORMATTING — used to apply heading styles and formatting to text.
REVEAL FORMATTING - shows all different formatting options have been applied to
document.

OBJECT — used to edit object inserted from INSERT Menu.
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Tools Menu

Various options are:

1

i

2 [
A

o

TR S———

SPELLING AND GRAMMER- This command checks the 2 e B
spelling and grammar in the document. =B B
LANGUAGE — used to set the language and look words up e N
in thesaurus. ol T I
WORD COUNT- It allows you to count how many words § - Afesummeis E
you have in your document like paragraph, pages and weed) i
lines_ Shusred Wloronace
AUTOSUMMARIZE - used to create summary as main § I IrsdCherges Qs chitaE
points and then allows placing that in different parts of Compare and Merge Documents. ..
document. Broiect Donument =
TRACK CHANGES - it allows specifying changes in e , -
current document and keeps track of changes by reviewer’s : __ o _
name. SEEEEEE -
MERGE DOCUMENTS - used to merge the document o '
and to display the merge result in current document, target Bemglubes o R+ Ins—

document or in a new document. S siolered Optors

ONLINE COLLABORATION- used to schedule meeting Sustomize.

and web discussion related to document. Opions....

LETTERS AND MAILING - This option consist Mail

merge, envelopes and letters, and letter wizard etc. it is used to create an address for printing
on envelope, create letter from template or merge address created into a label format that is
ready for printing.

MACRO- used to automate the task, if a task performed repeatedly. Basically, a macro is a
series of word commands and instructions that can be group together as a single command.
TEMPLATE AND ADD-INS — used to attach a different template to active document,
modify document styles or to load add-in programs

AUTOCORRECT — used to correct common mistakes that the user make personally and want
to correct them.

CUSTOMIZE - used to customize toolbar settings and to

show description for all toolbar/menubar options. ; | Table | Window Help Foxit Re
° OP".FIONS. - used f[o set the parameters for printing, % “4| Oraw Table i
saving, editing, spelling and grammar etc. " — 1
Table Menu ] Delete v |
This menu allows inserting and then modifying the table within ~ Select B
document. It consists following options: ™
e DRAW TABLE — used to draw a table into document.
e INSERT — used to insert a table into document.
e DELETE — used to delete the table, cells, columns and/or #Z7] Table AutoFormat...
rows. AutoFit »
e SELECT - table, cells, columns and/or rows can be
selected by using this.
. Convert »
e MERGE CELLS - used to merge two or more cells into ¥
one. 24 sort...
e SPLIT CELLS — used to split one cell into two or more POmRASES
cells. E Hide Gridlines
e SPLIT TABLE - this is used to split the table. ble Propert
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e TABLE AUTOFORMAT — used to apply a specific format to table.

e AUTOFIT — used to automatically set the area where the text will fit and rows and columns
are also evenly distributed.

e HEADING AND ROWS REPEAT - it allows the user to keep the heading and row in place

at the top of each page as table spans in many pages.

CONVERT - used to change the text to a table, and a table to text format.

SORT — used to sort the text alphabetically forwards or backwards.

FORMULA — used to input formula.

HIDE GRIDLINES — used to hides the table’s gridlines.

TABLE PROPERTIES — used to edit the properties of table such as: alignment of table and

text wrapping, row, column and cell alignment.

Window Menu

The Window menu provides different options to _—

move between documents, and these are —I
’ Window | Help  Foxit Reader PDF

following:
NEW WINDOW - used to open new window New Window

with same content as the active document
consists. So different parts of document can be
viewed at the same time. Compare Side by Side with bcom_6 may

ARRANGE ALL — used to show all open files in
separate windows on the screen that makes easy
dragging between files.

SPLIT — used to define a split into two panes or 2 Document3
removes the split

Arrange All

P B

‘ St

1 bcom_6 may

DOCUMENT 1 — It shows all currently open active documents.

Help Menu
The Help menu gives the idea to do something in Word or [

how something works. This menu has following options:

w | Help | Foxit Reader POF

MICROSOFT WORD HELP -—used to provide the 4@ #crosoft Office Wordtieh  Fi [ 4
possible topics related to answer of query typed in E | Show the Office Assistant O
subject of question. = ———— =
MICrosorc LIMCE Unane
SHOW OFFICE ASSISTANT - it shows an animated -~ Contact Us
paperclip that gives suggestions about what the TR .
computer thinks related to the work performed by user e D
on document. Shek forpdates
. | Detect and Repair...
WHAT’S THIS — used to reveal the formatting where - =
cursor clicked? PChiD FoducE
Customer Feedback Options...
OFFICE ON THE WEB — used to take the user to About Mcrosaft Office Word

website with tips on MS Office software.

WORDPERFECT HELP — used to provide a help menu related to WordPerfect document if user
is working on that.

DETECT AND REPAIR — used to find and fix errors in all Office files.

ABOUT MICROSOFT WORD - it specifies information about Word i.e license information
etc.
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7.7 DOCUMENTS AND TEXT FORMATTING

Formatting is helpful to assign the numbers on pages. For this following steps are used:

(A) To Insert Page Number

Page Numbers

- Click on Page number in Insert menu. N .
Position: Preview

- In Page number dialog box, Set the position,
alignment and show number on first page with

Alignment:

default setting Right [v]
- Click OK.

| Show number on first page

In it, Preview is used to specify the changes done in (Fomatn ] [

d A oKk | | Cancel
ocument.
(B) To Insert Date and Time puesnd time
A 3 Language:
Engish (U.S.) 7]

To insert Date and Time, Select Date and Time option from
Insert menu. It inserts date and time on each page of
document. But Header and Footer will also used for this.

May-15

5/11/2015 6:03PM
5/11/2015 6:03:21 PM
6:03:21PM

18:03

18:03:21

e Update automatically

[ pefaut... | [ o« ][ canca |

(¢) AUTO TEXT

This command is used to insert the Auto text. For this, select Auto Text from Insert menu. Select the
name of Auto Text from list. The text is appeared at that position where clicking is done in document.

(D) FONT

Document can be formatted by changing the font. There are different options for changing the font
- FONT OF TEXT-
e Select the text you want to change
e Click a font name in the Font box on the Formatting toolbar.
- SIZE OF TEXT -
e  Select the text you want to change.
e Click a point size in the Font Size box on the Formatting toolbar.

[A_Font.. |
ﬁ Paragraph... ; Fonk I Character Spacing I Texk Effects I
= Bullets and Numbering. .. r Eent: e Szss dize:
ITimes Mew Roman IReguIar
Borders and Shading. .. F Bl =] ] -
Tahoma 9
E= | Columns... Ternpus Sans ITC Bold 10
= Times —1 " Eald Ttalic 11
Tabs... R I | = <
Drop Cap... Font color: Underline style: Underline color:
. I Automatic LI I(nnne) LI I LUbamatic ﬂ
“ll Text Direction. ..
Effects
Change Case...
9 = ™ strikethrough ™ shadow I Small caps
Background » I Double strikethraugh I Qutline I all caps
= ™ superscripk I Emboss ™ Hidden
& Theme... I Subscript I Engrave
Frames » Preview

-2]| AutoFormat... )
Times INew Eoman

A4 styles and Farmatting. ..

r- 3 Reveal Formatting..,  Shift+F1 This iz a TrueType font, This font will be uzed on bath printer and screen,

Object. .. Default. .. | Ok I Cancel
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BOLD TEXT-
Select the text you want to change.
Click Bold on the formatting toolbar.
ITALIC TEXT-
Select the text you want to change.
Click Italic on the formatting toolbar.
UNDERLINE TEXT-
Select the text you want to change.
Click underline on Formatting toolbar.

(E) Add Bullets or Numbering

Select the items you want to apply bullets or
numbering to

To add bullets, click Bullets on Formatting
toolbar.

To add numbering, click Numbering on
Formatting toolbar

(F) Change The Color of Text-

Select the text you want to change the color.
Click the Font Color on the Formatting toolbar.

For applying different color, click the arrow next to the Font Color button

(G) Horizontal Alignment of Text-

Align Text With The Left Margin
e Select the text you want to align left.

Bullets and Numbering 1 2]
Bulleted NumbeSﬂl
1. 1) I
Mone 2. 2 Il
3 3 I
a) a i
by b. ii.
C. ) C. iii.
Size: | 100 Eﬁ % of text Start at: |1 Eﬁ
Color: | I~
Reset: | Cancel |

e C(Click Align Left (Ctrl+L) on the formatting toolbar.

Align Text With Right Margin
e Select the text you want to align right.

e Click Align right (Ctrl+R) on the formatting toolbar.

Center Text
e Seclect the text you want to center.

e Click Center (Ctrl+E) on the Formatting toolbar.

Justify Text
e Select the text you want to justify.

e  Click justify (Ctrl+J) on the Formatting toolbar.
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Z Document1 - Microsoft Word
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i Mormal + 14pt = TemestewRoman = 14 = | B r 1 | BF 3 [W|m =i & % - A-Bie

e (o T | Insert \bord Fleld ~ | dee 2L 4t =) H e o
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This text is left aligned. This texx is left aligned. This text is left aligned
This text is left aligned. This text is left aligned. This text 15 left aligned

z This text is left aligned. This text is left aligned. This text is left aligned
- This text 15 left aligned. This text 15 left aligned

- This text is left aligned

= This text is centered. This text is centered

This text 15 right aligned Thas text 15 right aligned This text 15 right aligned.
This text is right aligned This text isright aligned This text 15 right aligned.
5 This text 1s right aligned Thas text isright aligned This text 15 right aligned.
. This text is right aligned
[This text is right aligned.

-

= This text 15 justified This text is justified Thas vext is justified This text is

& justified. This vext iz justified This vext is justified This text iz justified of
- This text 15 justified This text 15 justified Thas text 15 justified. This text is =
E justified. This text is justified. This text is justified. This text is justified @
- =
= o wie >
iRraw: o |Aucshapest N WOl A @E Y- L-A-SmEad)
Page 1 Sec 1 11 At 3.6°  Ln 23 Cdl 1 (2=}

(H) Spelling Check-

Spelling is one of the best features of Word since it frees you from bothering about the spelling of
your text.

o Select Spelling from the Tools menu.

o A spell check dialog box appears. The spell check program starts picking up each word in
your document and searching that word in its dictionary. If the word is found in the
dictionary, the program moves on to the new word.

Spelling and Grammar: English (L.5.) |z|
Fragment;

Word offer a features that helps prevent this )
from happening. =

Check grammar

(I) CHANGE THE CASE OF TEXT -

Sometimes, it is required to change the case of text. The case could be upper case, lower case or title
case.

e To change case choose format menu, then click change case.
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Fg_rmd:lluds Table Window Hel
Fontk...

Paragraph...

Bullets and Mumbering. ..
Borders and Shading. ..
Columns. ..

Tabs...

il 4 =

i

“L} Texk Direckion
Change Case...
Backgrourd 3

(OO

Theme...

Frames »
:f] AutoFormat...

A styles and Formatting...

A Reveal Formatting... Shift+F1

y ="

e A dialog box will appear with following options:
o Upper case o Sentence case
o Lower case o Toggle case
o Title case

Change Case E|

| O H Canicel

e Select the text you want to change.

e Click on Change Case on Format menu.

(J) Add Or Change The Background Color Or Texture —

e Select BACKGROUND from FORMAT menu, and then click color (required for
background) or click MORE COLORS to see additional color choices. Click on FILL
EFFECTS for special effects, such as texture.

e Select the option according to choice.

(K) Remove Background —
e Select BACKGROUND from FORMAT menu.
e (Click on No Fill.

7.8 TABLES AND SETTING

In MS-Word, There are two ways to specify table in a document i.e. to draw table and to insert table.
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Remarks | (A) Create A Table

e Click on the Table menu.

e A drop down menu appears.

-_-i Table Properties. ..
e The Insert Table window appears after clicking Insert Table.

e Enter the Number of Rows and Number of columns.

e C(Click OK.
— Format Tooks Teble Window Help
Insert Table [X| A AR A R ) === ) e K R AT
2% g Ee o) B o ) = Al A A= ) saes ) T A BRI s =
Table size wesewRomen  + 12 - | B 7 1 | = .. AN
Humber of coumns: 5 % e SEEAREEN EEENERRE KXER iR SN
Number of rows: 2 -
AukaFit behavior
(%) Fixed column width: Lo = SNo Marne: of Number of Tumber of Holidays
= sl Morth days working days
Tr il 7 5

() AutaFit to contents
() AutaiFit to window

Table style: Table Gid

[l —|

[] remember dimensions for new tables
| o« || canent |

(B) Inserting Row and Column in Existing Table
To insert rows and column in existing table, steps are following:

- Place the cursor in table, where row is to be inserted.

- Click on table menu option.

- Click on insert. A submenu will appear.

- Click on Rows above or Rows below depending on choice.
In the same way, column can be inserted also.
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New row added above

0o

[

—

2=

(C) Delete A Table
e  Click the table.

e Pointing to Delete on the Table menu, click Table.

Table | Window Help

Foman + 1

_ﬁ Draw Table

| Insert

.

Select

5 Split Cells...

Split Table

ﬂ Table AutoFormat. ..
AutoFit
Heading Rows Repeat
Convert

2] Sot.

Formula...

Hide Gridines

Table Properties ...

=l

51 a 1s0%

Columns to the Left
Columns to the Right
Rows Above

Rows Below

Cells.

(D) Delete Row or Column

The Insert option has
everything vou need to

add rows or columns.

The Delete option
allows vou to delete
rows, columns, or the
entire table.

e Take the mouse pointer in the row or column that you want to delete.
e Click the Table menu option.

e A submenu will appear as soon as, you click on Delete.

e Click on the option Rows or Column, depending on your requirement.

(E) Change The Column Width

in A Table

e Place the pointer on the column boundary you want to do wide until it becomes and then drag
the boundary until your column gets the desired width.

e Ifyou want to change the column width to a specific measurement, click a cell in the column,
on the Table menu, click Table Properties and then click the Column tab.

e Select the options you want.
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i Table Window Help
BF9- 08 A0REH S I190% - @ik
-» -BsruEE=El=- e Dv-A-0
| o L R S |

oo - 1 s 5 s e e o GEIEEEEEE

RO - - 1 o5

5 Column 1:
l Preferred width: | 2.05"

Measure in: | Inches E

[ 44 previous Column | | next Columndr |

(F) Change The Row Height in A Table

e Place the pointer on the row boundary you want to move until it becomes and then
drag the boundary.

e If you want to change a row height to a specific measurement, click a cell in the
row, on the Table menu, click Table Properties, and then click the Row tab.

e Select the options you want.

Table Properties

Table Row ]Colgmnl Cell I

Dptions
¥ allow row ko break across pages

[~ Repeatas the
% Previous Row Mext Row # ]

(G) Autofit

Auto fit is a great feature in word. This feature automatically tries to adjust text in cells so as to keep
consistent look of the data in table. For using autofit, perform following steps:

e Click on Table menu.
e Select Auto fit. A submenu will appear.
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it

[

M i)

(LT
=

el

Select one of the following:-

W= e

width.

Auto fit to contents: Automatically adjust the width of columns in the table.
Auto fit to Window: Automatically resizes the table to make it fit into window.
Fixed column width: This option will make width of all columns same as current column

4. Distribute rows evenly: This will make all rows of same height.
5. Distribute columns evenly: This will make all columns of same height.

(H) Sorting Text in Table

Microsoft word allows us to sort data in a table. For sorting ascending and descending are the two
options. It is also possible to sort data from two or more columns. To perform sorting, steps are:

e Select column which we want to sort.

e Click on table menu—>select sort option.

e A dialog box will appear.

Paragraphs

My lst has
Header row
" gptions... |

I
]

=
3
i
i
4

G0

@) Ascending

m Type: Text .
L Cescending

W

[

@ M3 header row

oK | [ cance |

e Specify column name, its type and sort order. Press ok.

(I) Formatting Text in Table

Once a table is created, we can easily enter text in the table. The table data could require formatting.
The formatting can be done on individual cells of the table or whole table data can be formatted in

one time.

e Click on cell or select table to format.
e Apply formatting as normal text using formatting toolbar.
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Remarks | (J) Formatting of Table

Like table text, the whole table can be formatted also. We can add and remove borders, change the
border type, border colors, and cell fill color. The text of table can be formatted like normal text. We
can also change the direction of text in table cells.

There are two ways to format a table:
e Click on table menu—> choose Table AutoFormat.
e A dialog box will appear. Choose required formatting.

i
by
]
ril

B3 T 0% - @ digead i
EHEEE X =2 Y |

" 1| Table AutoFormat

oy
=

S
[
]

Category:
All table styles .E
Table styles:

Table Classic 4 -
Table Colorful 1

Table Colorful 2 —

Table Colorful 3 ‘ ‘ Delete...
Table Colurmns 1

Table Columns 2
Table Columns 3
Table Columns 4

Table Columns 5 Modify. ..
Table Contemporary =

Table El t

S — | (o

Preview

|t

Jan Feb
East 7 7
West 6 4
South 8 7
Total 21 18

3
g
=N

[S=R =N N | I
(=
=1

Apply spedal formats to
Heading rows Last row
First column Last column

[ Apply ] [ Cancel

o Select tables and borders toolbar from view menu—> toolbars=>tables and borders.

Tables and Borders

AR = o] rzlclEals

E-@E =-08 0 Allhlal 2>

7.9 WORKING WITH GRAPHICS

In MS-Word, mainly two types of graphics are used. These are drawing objects and pictures. Drawing
objects include Autoshapes, curves, lines, and WordArt drawing objects. Pictures are graphics that
were created from another files. Pictures include bitmaps, photographs, scanned pictures and clip art
etc.
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Tl Document1 - Microsoft Word .

Format  Tools  Table ‘wWindow Help Foxit Reader PDF
TR N W= 0=-Y

i ple Edit View

Break...

Page Mumbers...

Date and Time...

AukoText
Eield...
Symbal...
Comment
Reference

‘Web Component...

Clip &rt...

Erom File...

From Scanner or Camera...
New Drawing

AutoShapes

‘Wordart...

Organization Chart

) Picture &l

N Diagram. .. kﬂ

. Texk Box z

- File...

: Object... @-

. Bookmark. .. _4

: 2, Hyperlink...  Ctr4+K

“ [l chart

» Inserting A Picture Using Clip-Art

MS - Word provides many options to insert a picture and for this we can use clip art, we can insert a
picture from file, scanner or camera, in our document. The picture option shows drawing option and
word art option. The new picture could be in the form of charts. We can also use clip art in ms-excel

and power point also.

Steps to insert clip art:-

1. Click on insert menu - picture—> clip art.
2. Select an image from clip art.

3. A dialog box will appear on screen from which image can be searched.
4. Select the image that you want to insert in your document.

=i
A iClip Art i

Search Faor:

computer
Search in:

All collections ~ |
Results should be:

all media file types ~ |

t

ATTh
rtrny ‘

» Inserting A Picture From File

Steps to insert a picture from file :
e Click on Insert menu—> picture - From File.
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¥ Document? - Microsoft Word _

i Fle Edit Wiew | Insert | Format  Tools  Table ‘Window Help  Foxit Reader PDF

] e AN R AR W W i

Page Mumbers. ..

Remarks

Date and Time. ..

AukoTexk 3
- Figld...

Symboal...
- Comment

Reference 3

Web Component. ..

-

Picture

| @l Clip At
Diagrarn. .. |E Erom File. ..

Texk Box

From Scanner or Camera. .,

File... Mew Drawing
Object... Autoshapes
- Bookmark. .. Wordart..

Hypetlink...  Chrl+k

Qrganization Chart

e A dialog box will appear that will ask for name and location for picture to be inserted.

Insert Picture

Loakin: @ My Pickures V| @ -@Q X i B - Tools~

My Recent = =
Documents L—'J

@ 7] :

Desktop Ficasa My Computer Sample Fictures

¥

My Documents

My Computer

@

. File pame: || v | Trgert
My Netwark,

Places Files of type: | Al Pictures vl ﬁ

e Give picture name and location to insert the picture.

» Inserting A Picture From Scanner or Camera
e On the Insert menu in Microsoft word, click on picture, and then click on From Scanner or
Camera.
If camera is selected, a picture needs to be clicked first, then it will be inserted.
e [f scanner is chosen, firstly we have to set image settings. Then image will be displayed on
screen.

» Drawing Objects in a Document

For drawing graphics objects in a word document, we can use drawing toolbar. While clicking on
Insert menu, then picture, then new drawing, A drawing canvas will appear on word document. By
using drawing toolbar, we can draw any kind of picture.
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» Inserting Autoshapes

We can insert pre-defined shapes in our word document.
e Click on insert menu—> picture—> autoshapes.
e A AutoShapes toolbar will appear.
e Choose the desired shape from that and draw it.

&JE’%&%%IE‘:

» Inserting a Picture Using Word Art
e Click on insert menu—> picture—> word art.
o A dialog box will appear.

WordArt Gallery X

Select a WordArt style:

et yordA sworaar, Worahr

WordAr!

Wyt WordAnt| Wordet o2+ Weediet) £
Werdin wl wardar || -WordArt \\‘de,-’m W
Wiordaet|WardAve | Wordbt | Wigglg | ot § %

e B e

BRpavr

e Choose a word art style, press ok.

e Type the text in next dialog box and press ok.

M ow [ o )
oK Cancel
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e For editing the word art object, either double click on object or choose word art toolbar from
view menu—>toolbars>WordArt.

» Inserting A Chart

It is a feature in MS Word which enables the user to see chart in document.

In main menu we can select insert > picture —>chart to see any chart in a document.

Chart is used in different word documents mainly in business documents which has numerical values.
Chart enables the correct and better view of numerical values.

As we choose chart option, a chart is appeared with datasheet in document. Modify the data sheet as
per requirements and click outside the chart and datasheet. The chart will appear in document.

window  Help

STl s s oo Ena s WEEH] S o) @ B e

oo P 5.

100

0 DEast

» mWest
20 OMNorth
0

ist 2nd  3rd  4th
atr O Otr Ot

A B [ D
| 1st Otr 2nd Qv |3rd Otr |4th O

1_afl]East 20,4 274 920 204
2 afl|West 30.6 38.6 .6 3.6
3 ﬂﬂ‘Nuth 459 46.9 45 439

» Symbols:
These are special characters and can be inserted by INSERT—-SYMBOLS in document. Steps are
following:

- Select the place to insert the symbol in document.
- Choose the symbol from SYMBOL WINDOW.
- Double click on symbol to specify that in document.

Symbol
Symbols | Sgacal characters |

Font: | (rormal text) [~] Sybsets | Currency Symbols [=]
G|F| £ |m|®[Ps[Rsw|w| ¢ [E] K| |0 4P °
Glala|c] Fl%] ¢ Ne|™alelss]a]n]]%
W %kl = Lt alalllly ] -
Vol =[#[=]<]z]e| =[] .

Recently used symoois:
[Py S v g [ T R R B R R
(E|L|¥[O|®IN £ F|<|x]+|x[o|p|a|p

1
ELRO SIN Character code: | 0AC from: | Unicode (rex) Lz

[BwioCorect... | [Stortasther... | shortct keys Atecirive

ez ) o),
7.10 INTRODUCTION TO MAILMERGE

Mail Merge does what it says-----merges mail. When you want to send the same document to
different persons with different addresses, Mail Merge is the best option. Through this facility you
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can create a database of your contacts and automatically merge the main body of letter and this
database in such a manner that many personalized letters would be generated. Each of these letters
would be addressed individually to different people and every recipient would feel as if you have
personally written the letter to him or her.

The file that contains the ‘form-letter’ is called the main document and the file containing the
database is called the data source. Each entry in the database file (data source) containing details
about one person is called a record and each item of detail in this record(like name, phone number,
subscription number ) is called field.

Steps for Mail Merge:-
e First type the document which is to be sent to different people.
e Click Tools menu.
e Click letters and Mailings.
e C(Click Mail Merge

at | Tools | Table Window Help Adobe PDF Acrobat Comments
| ':ff" Spelling and Grammar.. F7

- i

VR Werd Count... =
_| Letters and Mailings 3 || Mail Merge... Nl
7% AutoCorrect Options... Show Mail Merge Toolbar W,
Customize.., =1 Envelopes and Labels...
Qptions... Letter Wizard...
¥
Message options -
To: Emaildddress el
Subject line: | Tnfarmation For class in 5. Burlington
Mail Format:  |HTML w
Send records
@il
() Current record
2 Erom: I | I | |

You learnt the following in this lesson:

e Word processor is a computer program that is used to create, edit, view, format, store,
retrieve and print documents.

e MS-Word is one of the popular word processing software that consist various tools and
functions to format the document.

e MS-Word consist different menu options used to give direction to software.

e Data can be exported and imported in MS-Word.

In MS-Word, pictures can be inserted by various ways such as using AutoShapes, ClipArt,

From Files, from scanner and Camera etc.

Multi-Column facility makes more than one column in single document.

With the help of spell check option, we can make error free document.

MS-Word also provides the facility of table.

Mail merge option is used to send letters to many people at the same time.
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—

What do you mean by Word Processor?

Discuss the components of Word Document Window.
What is the use of title bar?

What is the purpose of standard toolbar?

What is the purpose of formatting toolbar?

Write down the steps to create a document.

Discuss various ways and steps to save a document.

Discuss the steps to close document.

Y ©® N kR WD

What is editing? Explain various commands used for editing.

—
S

. Write the steps to find and replace text from the document

[a——
[a——

. What is the purpose of undo and redo?

—_
N

. State the steps to cut and copy the text.

—_
W

. How can you find out the text available in document?

._.
n

. Explain various option of help menu.

—_
93]

. State the steps to align text.

—
(o)

. Explain the steps to change the font and font size by giving example.

—
\]

. Discuss the use of Clip-Art Gallery.

—_
o9

. What is the procedure to print a document?

—
Ne)

. How many types of text alignment are present in MS-Word? Discuss all of them.

[\
(]

. What is the procedure to print a document?

[\
—

. What is the use of Frame? How a frame can be created?

N
[\

. Discuss Table- handling in MS-Word.

[\
W

. How multi-column document can be created?

®)
=~

. What are the steps for recording and running of a macro?

[\
9]

. What are the steps to insert Bullets and Numbers?

[\
(@)

. Discuss various ways to insert picture in a document.

[\
~

. How a table can be created?

[\
o0

. What are the steps to insert row and column in a table?

N
O

. How a document can be corrected from Misspell?

(98]
=]

. Discuss the purpose of red and green underline in a document.

98]
—_

. What is Mail Merge? Write down the steps for creating Mail Merg
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INTRODUCTION TO MS-EXCEL
OBJECTIVES OF THIS LESSON

MS-Excel is a spreadsheet package which organizes various types of data. It offers enormous
features. This lesson is aimed to make you understand the following:

Basic concepts of MS- Excel i.e. Rows, Columns, Cell etc.
Various Menu and Toolbar options

Creating, opening and saving of worksheet

Formatting and printing of worksheet

Linking of different worksheets

Creation and printing of charts or graphs

Use of Macros and built-in functions

STRUCTURE OF THIS LESSON

8.1 Introduction
8.2 Ms-Excel
8.3 Features of Ms-Excel
8.4 Starting Ms-Excel
8.5 Basic Terms in Excel
8.6 MS- Excel Window Elements
8.7 Creating, Opening and Saving Workbook/Worksheet
8.8 Working with Excel
8.9 Formatting
8.10  Printing A Worksheet
8.11  Macro
8.12  Functions
8.13  Charts (Graphs) in Excel
8.14  Adding Graphics
8.15  Uses of Worksheet in Different Areas

Summary of the Lesson

Self Assessment Questions or Exercise

8.1 INTRODUCTION

MS-Excel is a spreadsheet package that is offered by Microsoft as a part of their suite. A Spreadsheet
is a tool that helps you organize, analyze and evaluate data. It allows you to creating a computerized
ledger. With the help of this, arithmetic calculations can be performed very easily and it also make
easy to change different numerical values.MS-Excel also provides graphical user interface and user
friendly environment. In MS-Excel, charts or graphs are used to show the graphical representation of

data. In brief, working in spreadsheets saves a lot of time by its different functionalities.
8.2 MS-EXCEL

Microsoft Excel is a spreadsheet package, which organizes all types of data especially numerical data.
It is a tool for not only storing or managing data but also analyzing and querying data. A spreadsheet
offers considerable ease of performing such tasks by automating all arithmetic calculations and
making it easier to change certain numerical values. Spreadsheet is a primary document which
consists of cells that are organized into columns and rows. Excel not only does accounts related work
but it is cool graphical user interface and user friendliness, even while doing some very sophisticated
tasks. Working in spreadsheets saves a lot of time.



148

Remarks

Computer Applications in Business
8.3 FEATURES OF MS-EXCEL

Some of the features of MS-Excel are:

Data can be manipulated in tabular form.

Excel contains workbooks, in which worksheets are present. Each worksheet consists of 256
columns and 65536 rows.

Data from excel can be exported to other compatible softwares.

Excel supports charts and graphs for pictorial representation of data.

Excel provides built-in functions to perform calculations.

This spreadsheet package offers many features that helps to handle complex data like goal
seek, what-if analysis.

N —

SN kW

8.4 STARTING MS-EXCEL

e C(Click on Start button.

e Select the option Programs

e Click on Microsoft Excel
MS-Excel window will appear

(] Wecrosoft Excel - Bookd.
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8.5 BASIC TERMS IN EXCEL
- ROWS:-
All the rows are numbered numerically i.e. 1, 2, 3.... and so on. There are 16384 rows in
each spreadsheet. We can insert a new row also by clicking insert menu. We can also do
formatting on rows.

-  COLUMNS:-

All the Columns are labeled alphabetically i.e. A, B, C..... and so on. There are 256
columns in each worksheet. We can also change the width of column. We can also do
formatting on columns.

-  CELL:-

Intersection of a row and a column is called cell. It contains Text or Numbers. We can apply
formatting on cells. We can also insert or delete cells. The active cell has a dark outline.
When a cell is active, data can be typed into it.
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Range of Cells:-

Many spreadsheet operations consists a range of cells instead of a single cell. A range of cells may
involve many cells and entering every individual cell address for performing an operation on them
may be time taking. To resolve this problem, the concept of cell ranges is used. These are of
following types:

1.

2.

3.

Row Range: It includes a set of adjacent cells in the same row. For example, the range
BS...DS refers to the cells BS5, C5 and DS.

Column Range: It includes a set of adjacent cells in same column. For example, the range
C5..C9 refers to the cells C5, C6, C7, C8, and C9.

Block Range: It includes a set of adjacent cells in a rectangular group of cells. For example,
the range BS5.. D9 refers to the cells BS, B6, B7, BS, B9, C5, C6, C7, C8, C9,D5, D6, D7, DS,
and D9.

Cell Contents:-

In spreadsheets, different types of data can be entered in a cell. The four commonly used types of cell
data are:

1.

g

Label: A label is any string of alphanumeric text. Label can be used to enter either
alphanumeric values in cells, or descriptive data or titles to make the contents easier to
understand.

Numeric value: A numeric value is a number on which spreadsheet can perform calculations.
Formula: A formula may include numbers, mathematical operators, mathematical functions
supported by spreadsheet and cell addresses.

Date and time: Date and/or time contents type in a spreadsheet are used to display the actual
date and time.

Cell Referencing:-

Reference to a cell can be done in three ways:

1. Relative referencing:
The copied formula presents the positional relationship among the cells and this type of
referencing is called Relative referencing. For example, suppose the cell ES contain the
formula = B5+ C5 + D5. Excel provides the facility to copy the content of a cell or group
of cells. If the formula in ES is copied to E10, Excel copies it as BS +C5 +D5.

2. Absolute referencing:
Referring to the value in a cell rather than the position of the cell is called Absolute
referencing. For example, suppose D5 contain the formula = C3*12. We wish to copy the
formula to cell D6, such that it appears as =C3*12 in this cell. If C3 is taken as a relative
address then the copy of the formula to the cell D6 will be C4*12.
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MS-Excel uses $ (dollar) symbol to distinguish absolute and relative referencing. To
make the relative reference “C3” as absolute “$C$4” will have to be typed in formula in
D5. So we type the formula in D5 as = $C$3*12. Absolute reference remains unchanged
when that is copied.

3. Mixed referencing:

In the example of absolute referencing, “$C$4” makes both the row and column absolute.
On the other hand “C$4” or “$C4” are treated as half relative and half absolute and this
type of referencing is known as Mixed referencing.

- COLUMN HEADINGS:-
L a1 &8 [ ¢ | o [ E [ F |

Each Excel spreadsheet contains 256 columns. Each column is named by a letter or combination of
letters.

- ROW HEADINGS:-

e LD B —

Each spreadsheet contains 65,536 rows. Each row is named by a number.
-  NAME BOX:-
B4 -

This shows the address of the current selection or active cell.
Workbooks And Worksheets

A workbook automatically shows in the workspace when you open Microsoft Excel 2003. Each
workbook contains three worksheets. A worksheet is a grid of cells consisting of 65,536 rows by 256
columns. Spreadsheet information—text, numbers, or mathematical formulas—is entered in the
different cells.

[ N A S

Navigation Buttons And Sheet Tabs
4 4 » w[\Sheetl f Sheet? f Sheet3 /

Navigation buttons allow you to move to another worksheet in an Excel workbook. They are used to
display the first, previous, next, or last worksheets in a workbook.

Sheet tabs separate a workbook into specific worksheets. A workbook defaults to three worksheets.
Each workbook must contain at least one worksheet.
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8.6 MS-EXCEL WINDOW ELEMENTS
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Excel Screen Elements

- Title bar

Microsoft Excel - Book1

Excel Title bar

Title bar is located on the top of the Excel Screen. Excel displays the name of the workbook (i.e. file)
being used currently.

- Menu bar

IE_‘!] File Edit Wiew Insert Format  Tools  Data Window  Help Type aquestion for belp = o & xI
Excel Menu bar

Menu bar is located directly below the 'Title bar'. Menu bar contains Menu tabs File, Edit, View,
Insert, Format, Tool, Data, Window and Help. The first letter of menu tabs is underlined. Typing 'Alt
+ the underlined letter' or a click on the 'Menu tab' will open the drop-down menu associated with the
tab. Menus are used to give commands to the software.

- Standard Toolbar
Prirt Format ALtoSUm Sort Drawin hicrosoft
Niw STE PreIiew Resiarch C"lw F‘airer RTD Dezcending a Excel Help

L
logdialdig@sbn. Fa -t 8z i @e o -of
U ..

* ... : &
| | InJer‘t Slr‘t C}]\ar‘t

Open Print Speling Cut Paste ndo Hypetlink  Aszcending  Wizard Zoom
Excel Standard toolbar

The Standard Toolbar provides shortcuts to various 'commands' being used frequently by the user like
opening or a creating workbook (file), opening, Saving, printing a workbook, Print preview, Cut,
Copy, Paste, Undo, Redo, Sum, Sort Ascending, Sort Descending the contents of selected cells, Zoom
etc. On moving the mouse over the icons on the tool bar, the command associated with the icon is

displayed in a pop up.

151

Remarks



152

Remarks

Computer Applications in Business

- Format Toolbar
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Excel Format toolbar

Format toolbar provides commands for formatting the cells and its contents, merging / de merging
cells, increasing or decreasing height of rows and width of columns, horizontal and vertical aligning
of cell contents etc. A user can add or remove icons (commands) to the toolbar as per requirements.

- Formula bar

| D - 2 |
Excel Formula bar

Formula bar has Name box on the left to display the address of the selected cell. The other box on the
formula bar displays number, text, formula or other contents of the selected cell. You can enable or
disable display of the Formula bar by clicking on View followed adding or removing check mark
against Formula bar.

- Status bar
| ready MUM Fie |

Excel Status bar

The Status bar is located at the bottom of the Excel screen. The bar displays status of the window on
the left. The word 'Ready' indicates that Excel is in the Ready mode and is awaiting your next
command. Other indicators appear on the Status bar in the lower right corner of the screen are:

e The letters "NUM" on the Status bar in the lower right corner of the screen indicate that the
Num Lock is on.

e The letters "CAPS" on the Status bar in the lower right corner of the screen indicate that the
Caps Lock is on.

e The letters "SCRL" on the Status bar in the lower right corner of the screen indicate that the
Scroll Lock is on.

e The letters "END" on the Status bar in the lower right corner of the screen indicate that the
End key is on.

e The letters "EXT" on the Status bar in the lower right corner of the screen indicate that the
Extension of selected cell / range is on. Pressing F8 key anchors a cell / range for extension
by pressing arrow keys and repressing F8 key removes the anchor.

A right click on the Status bar displays Sum, Average, Count, Maximum or Minimum of the
selected cells. You can enable or disable display of the Status bar by clicking on View followed
adding or removing check mark against Status bar.

8.7 CREATING, OPENING AND SAVING WORKBOOK/WORKSHEET
e Creating A New Workbook:-

By default, excel document is called a workbook. Workbooks are named as Book1, Book2 and so on.
Every workbook contains 3 worksheets. New worksheets can be added anytime in a workbook.
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e To create a new workbook, click New button

o YOUu can also select New from File menu.
You can also press Ctrl+ N.

Microsoft Excel - Book1

£
1 lon standard toolbar

‘Web Page Preview

Page Setup...
Prink Area 3

Prink Prewview

W e

Prink... Zkrl+P

Send To 3

Properties

Y P Y Y Y

Exit

—
g

1
1

e Opening A Workbook

@_]EiTI Edit  Wiew Insert  Format  Tools Daka  window  Help  Foxit Reader POF
i0 dew.  arw g g Ga o Flo o oo @ 3 - 81 AL
ijﬂj open... el
Close
= save Chrl+5 | D E | F | & | H ]
Save As...
Gy Save as Web Pags...
Save Workspace. ..
#1 File Search...
Permission ]

e To Open an existing workbook, click Open button E on standard tool bar.

You can also select Open from File menu.

You can also press Ctrl+ O.

e Saving A Workbook

To save the document, click Save button

You can also click Save from File menu.
You can also press Ctrl+S.
A dialog box will appear.
Save the document with name and extension.
Following are the extensions for excel document saving:
1. xls: saving a workbook.
2. xlw: saving workspace.
3. xlt: template.
4. xlk: backup file.

¥
lﬂ on standard tool bar.
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e Closing A Workbook:-

Steps to close a workbook are:

e Choose close from File menu to close active workbook.
e  We can also press close on right side of menu bar.
EEECIUEN . W |

e W T——
5] fe [t View fuen Fomat Tooks Data Window Help Type 2 question for help --8x
BT RN - AN T 2 0E -4 R g i ==
Aial 7] BIUSEEsSy ol Es - H-A-0 |
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I A { B [ 1] E F G H 1 ] K L ] N 5] P [*] R B T u—

Steps to close excel are:
e To quit excel, choose Exit from File menu.

- e We can also click on close button on right side of title bar.
— T T -
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8.8 WORKING WITH EXCEL

- Navigation:

In MS-Excel, to move around the spreadsheets, keyboard arrow keys are used for going up(?), for
going down(]), for going left(«—), for going right(—), Page up for going one screen up and Page
down for going or use the mouse to traverse the different parts of worksheet.

Selection of cells:

A cell is to be selected before it is to be used. Single cell can be selected using mouse or keyboard.

A group of cells selected is called a range. A range is a rectangular group of cells is referred to by its
diagonal corners (top-left cell address and bottom-right cell address separated by a colon). Example
A1:C3 implies a rectangle covering all the 9 cells from Al to C3, i.e. Al, B1, C1, A2, B2, C2, A3, B3
and C3.
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- Selection of cell with mouse:
The mouse is helpful to select the specific cells.

- To select a single cell, simply point and click on it to make it active.
- To select entire row, click on a row number.
- To select entire column, click on column alphabet.
- Click and drag to select a range of cells.
- Click on empty button at the intersection of the column and row numbers to select the entire
worksheet.
Working in Workbook and Worksheet

To insert worksheet:

To add new worksheet in workbook, select WORKSHEET from INSERT menu. A new worksheet
will open in the left side of active sheet.

To delete worksheet:

Select the worksheet to be deleted and choose DELETE SHEET from EDIT menu. Then click on OK
to delete the worksheet.

To change the name of worksheet:

Select FORMAT—SHEET—RENAME or double click on desired worksheet to change the name of
worksheet.

To copy/move worksheet:

For this purpose, select MOVE or COPY command from EDIT menu.

(o )
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To hide the workbook/worksheet:
Hiding of workbook or worksheet saves the data from deletion and there is less number of worksheet
on screen. This is the best way to secure the data from undesired changes.
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Entering Formula:

The Excel worksheet is helpful to modify the data table and to calculate the specific cells. For this
purpose, the unique characteristic of Excel named formula and function is used. Formulas are entered
in worksheet cell and must start with an equal sign ‘=". The formula includes the cell addresses whose
values have to be manipulated using correct operands. The formula calculates the cell range
automatically specified in it.

8.9 FORMATTING
- Conditional Formatting:

This feature helps to copy the formatting style from a selected cell to another. To do this, simply copy
the cell and paste its format to another cell. We can also copy format to a range of cells. Following
are the steps:
e Select the range of cells in the worksheet to which conditional format is to be copied. The cell
is to be copied must be the part of the range.
e Select Format menu—> Conditional Formatting.
e A dialog box will appear.

Conditional Formatting

C_undition L _ _
and

“ | |between A4

Preview of format to use

when condition is true: No Format Set

[ fidd = H Delete... ] I OK H Cancel |

e Fill the required details.
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- Moving Through Cells

While working in the worksheet we can use mouse to select a specific cell or row. We can also use
keyboard to move through cells in a worksheet.

To move to the next cell, press the Arrow Keys.

To move to the next cell to the right, press TAB.

To move to the next cell to the left, press SHIFT + TAB.

To move to the edge of a data region, press CONTROL + Arrow Keys.
To move to the first cell in the row, press HOME.

To move to the first cell, press CONTROL + HOME.

To move to the last cell, press CONTROL + END.

To scroll down, press PAGE DOWN.

To scroll up, press PAGE UP.

To scroll to the right, press ALT + PAGE DOWN.

To scroll to the left, press ALT + PAGE UP.

To move to the next worksheet, press CONTROL + PAGE DOWN.
To move to the previous worksheet, press CONTROL + PAGE UP.

To go to a cell using the "Go To" dialog box, press F5 to open the "Go To" dialog box, type
the cell co-ordinates in the Reference box and press ENTER.

- Adding rows:

e Select the cell.

e Click on Insert menu—=> Row

e A new row will be inserted above the selected cell.
- Adding Columns:
e Select the cell.
e Click on Insert menu~> Column
e A new column will be inserted before the selected cell.
- Resizing Rows:
e Select the row.
e Click on Format menu~> Row
e A sub menu will appear with following options:
o Height
- Resizing Columns:
e Select the column.
e Click on Format menu—~> Column
e A sub menu will appear with following options:
o Width

- Selecting Cells:
A cell is to be selected before it is to be used. Single cell can be selected using mouse or keyboard.

A group of cells selected is called a range. A range is a rectangular group of cells is referred to by its
diagonal corners(top-left cell address and bottom-right cell address separated by a colon). Example
A1:C3 implies a rectangle covering all the 9 cells from Al to C3, i.e. Al, B1, C1, A2, B2, C2, A3, B3
and C3.

B3 Microsoft Excel - Book1
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Moving Cell Contents:

The contents of a cell can be moved using cut and paste. For this, following are the steps:

Choose the cell to be moved.

Click on Edit menu—> Cut.

Now, go to that position where data is to be moved.
Click on Edit menu—> Paste.

Copying Cell Contents:

The contents of a cell can be moved using copied and paste. For this, following are the steps:

Choose the cell to be copied.
Click on Edit menu—> Copy.
Now, go to that position where data is to be copied.
Click on Edit menu—> Paste.

Drag And Drop Option:

This option can be used to move the cell contents to a short distance. To perform Drag and Drop,
simply drag the highlighted border of the selected cell to the destination cell using mouse.

Freeze Panes:

To make the heading visible at all times in big worksheet, where the heading will disappear as the
worksheet is scrolled, freeze panes feature is used. It can be performed by following steps:

Click the label of the row below the row that should remain frozen at the top of the
worksheet.

For adding Frozen panes, select Window—Freeze Panes from menu bar

To remove the Frozen Panes, select Window— Unfreeze Panes from menu bar

The freeze panes will remain stationary while the remaining rows and column will move
when worksheet is scrolled.

To Change The Font Used in A Cell or Range of Cells:

Select the cell or range of cells you wish to change.

On the Excel Formatting toolbar choose a font from the Font drop down list.

To Change Other Font Characteristics

Select the cell or range you wish to change.

From the Format menu, click Cells.

From the Format Cells dialog box displayed, select the Font tab to change the Font, font
style, or size.

Select the Underline: drop down list box to select a style of underline or None to remove the
underlining.

Select the Color: drop down list box to choose a font color.

In the Effects section, you can tick Strikethrough, Superscript, or Subscript.

To change all the settings in the dialog box back to the Normal style which is set in the Style
dialog box, tick the Normal font check box.

Select OK to close the Format Cells dialog box.

To Align Data between the Left and Right Sides of a Cell

Select the cell, or cells, you wish to align.

On the Excel Formatting toolbar, click on the Align Left icon to align data with the left
edge of the cell.

Click on the Align Right icon to align data with the right edge of the cell.

Click on the Center icon to center data in the cell.
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To Align Data Between The Top and Bottom of A Cell

Select the cell, or cells, you wish to align.

From the Format menu, click Cells.

From the Format Cells dialog box displayed, click on the Alignment tab.

In the Text alignment section, choose the Top, Center, or Bottom option in the Vertical area
to align the data in the cell.

To make the lines of data fit evenly within the height of a cell, tick the Justify distributed
option and click on OK.

To Change The Orientation of Data Cells

Select the cell, or cells, you wish to change.

From the Format menu, click Cells.

From the Format Cells dialog box displayed, click on the Alignment tab.

In the Orientation section, you can change the Degrees of the text or use the mouse to drag
the 'red small diamond' up or down. When satisfied, click on OK.

Crientation
* .
+
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To Wrap Multiple Lines of Data in A Cell

Type the data you require into the cell and press Enter. The entry will appear as one long line
and select the cell, or cells, you wish to format.

From the Format menu, click Cells.

From the Format Cells dialog box displayed, click on the Alignment tab.

In the Text control section, tick the Wrap text check box and click on OK.

To Shrink The Text Into One Cell

Type the data you require into the cell and press Enter.

From the Format menu, click Cells.

From the Format Cells dialog box displayed, click on the Alignment tab.

In the Text control section, tick the Shrink to fit check box and click on OK.

To Merge Several Cells

Select the cells that you wish to merge to become one cell.

Right-click on the selected cells, click Format Cells.

From the Format Cells dialog box displayed, click on the Alignment tab.

In the Text control section, tick the Merge cells check box and click on OK.
Note: You also can use the Merge and Center icon on the Excel Formatting toolbar.

To Change the Color of Text

Select the cells containing the data you want to change the color.

On the Excel Formatting toolbar, click the down arrow next to the Font Color icon.
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rv -

Aukomatic

e Choose a color from the Font Color palette.

e The color you selected from the Font Color palette will be displayed on the new icon face.
Click on the icon face to apply the new color to the cell.

- To apply colors to cell(s)
e Select the cell or range of cells you wish to color.
e On the Excel Formatting toolbar, click the down arrow next to the Fill Color icon.

e  Choose a color from the Fill Color palette.

Mo Fill

To turn off the cell(s) color

Select the cell or range of cells you wish to color.
On the Excel Formatting toolbar, click the down arrow next to the Fill Color icon.
Choose No fill.

To Change Number Formatting Using The Formatting Icons

e We can quickly change the formatting of a cell or selected range by using the following icons
on the Formatting toolbar.

| 8 % » i 40

Currency 12345 will become $12,345.00
Percent .25 will become 25%
Comma 98765 will become 98,765.00

Increase Decimal [12,345.00 will become 12,345.000
Decrease Decimal |98,765.00 will become 98,765.0
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This is a useful feature for formatting the text. If the cells have already formatted using specific font
style, date format, and other formatting option, then another cell or group of cells can be formatted
using the same style. To do this, place the cursor within the cell containing the format that is to be
copied. Then, click the FORMAT PAINTER button on standard toolbar. Now the pointer has
paintbrush as FORMAT PAINTER is initialized. Highlight the cell to which same selected formatting

To Format A Number As A Currency
Select the cell or range of cells you want to format.

From the Format menu, click Cells.

From the Format Cells dialog box displayed, select the Number tab.

In the Category: section, select Currency.

Format Cells &]
Mumber | alignment | Font Border | Patterns | Protection
Category: Sample
| General
| Mumber i
| Currency: Decimal places: |2 &
| &uccounting 3 i
|Date Symbol;
| Tirne: It
| Percentage (-
| Fraction
| ?uenhﬁc FMongolian {Cyrillicy
filext + English {Australia)

| | Special J

4 English {Canada)

4 English {Caribbean)

£ English {Mew Zealand)
% English {United States)

| 4 French {Canada) :
| Currency Formats are used Fof QEnEral monetary valles, Use sccounting

| Formats ko align decimal points in a column,

| | Custom

I Ok ][ Cancel ]

Select the number of decimal places you require by using the Decimal places: spin box

arrows.

In the Symbol: section drop down list, select the type of currency.
Click OK.

To Format A Number As A Percentage
Select the cell or range of cells you wish to format.
From the Format menu, click Cells.

From the Format Cells dialog box displayed, select the Number tab.

In the Category: section, select Percentage.

Select the number of decimal places you require by using the Decimal places: spin box

arrows.
Click OK

Format Painter:

1s added.

This feature is helpful to obtain professional-quality format for data. Auto formats are combinations
of formats, such as lines and fills, that Excel applies to the indicated range of cells. Steps for Auto

Auto Formatting

formatting are :
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Select cell(s) in table.

Click Format menu, then click AutoFormat.

Click Premade format in Table Formats list, to select the appropriate format.
Click Ok when done.
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8.10 PRINTING A WORKSHEET

To Print an active document, click Print button I d on standard toolbar

You can also click Print on File menu.
You can also press Ctrl+P.

A dialog box will appear.

Fill the necessary information.
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8.11 MACRO

A macro is a set of instructions that tells Microsoft Excel to perform one or more actions as per user
requirements. Macros are like computer programs, but they run completely within Excel. We can use
them to automate tedious or frequently repeated tasks.

Macros can carry out sequences of actions much more quickly. For example, we can create a macro
that enters a series of dates across one row of a worksheet, centers the date in each cell, and then
applies border format to the row. Or we can create a macro that defines special print settings in the
Page Setup dialog box and then prints the document.

Macros can be simple or extremely complex. They can also be interactive; that is, we can write
macros that request information from the user and then act on that information.

There are two ways to create a macro: we can record it, or we can build it by entering instructions in a
module. Either way, the instructions are encoded in the programming language Microsoft Visual
Basic for Applications (VBA).

- Recording A Macro

On the Tools menu, point to Macro, and then select Record New Macro.

In the Macro name box, enter the name of the macro. Click Ok.

A Stop Recording toolbar will appear. Drag it to a new position if it is in the way.
Perform actions we want to record.

Press stop recording on toolbar. A macro will be saved.

ek b

12355

eI e
i

- Running A Macro

e Click on Tools menu, select Macro.

e A list of macros, earlier saved will appear. Choose macro we want to run.
e Click Run.

Magosin: All Open Workbooks

Description
Macro recorded 07-05-2015 by User
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8.12 FUNCTIONS

Functions are power tools which help to perform calculations on data. FUNCTIONS are predefined
formulas that will calculate selected data. The user has to simply provide the values based upon which
calculations are to be done. All Excel functions consist of three (3) parts: The = sign, the function
name, and an argument or range enclosed in parentheses.

A FUNCTION is always identified by the =SIGN preceding the function name. The FUNCTION
NAME indicates which function is being used. The ARGUMENT or RANGE is enclosed in
parentheses and specifies the range of cells on which the function will act. The ARGUMENT can be
a real number, a reference to a cell, a reference to a group of cells, a formula, or another function. A
function can be added to the worksheet by two methods:

1. Place the cursor where you want the function result to appear and select Function from Insert
menu.
2. Manually type the function at desired place.

Tota J=su|

|
SUM(numberd, [rumber?, ...)

Functions are characterized by purpose. There are 9 function categories.
1. Mathematical Functions:

With math and trigonometry functions, we can perform simple and complex mathematical

calculations

- SUM (Range)- Sum of a group of numbers

- SQRT(X) - Displays the square root of a number (X)

- PRODUCT (range) — multiplication of given values

- MODE (argument 1, argument 2) — will give remainder after dividing argument 1 by
argument 2

2. Statistical Functions:

Statistical worksheet functions perform statistical analysis on ranges of data. This includes
average, highest and lowest values, standard deviation, median, and other statistics.

- AVERAGE (Range) - Gives the average of a group of numbers

- COUNT (Range) - Counts the items in a list
- MIN (Range) - Displays the smallest number in the range
- MAX (Range) - Displays the largest number in the range

3. Financial Functions:

Financial functions perform common business calculations, such as determining the payment for
a loan, the future value or net present value of an investment, the principle and interest etc.

- FV — To calculate future value of investment
- IPMT — to find interest payment

4. Logical Functions:

Logical functions are used to see whether a condition is true or false or to check for multiple
conditions. Like,

- AND - OR - NOT - IF



5. Lookup Functions:

When we need to find values in lists or tables or when you need to find the reference of a cell,
we can use the lookup and reference worksheet functions.

- ADDRESS - returns a cell reference as text

- COLUMN - returns the column number of reference

- COLUMNS - returns number of columns in a array of reference
6. Text Functions:

With text functions, we can manipulate text strings in formulas. For example, we can change the
case or determine the length of a text string. We can also join, or concatenate, a date to a text
string. To manipulate the text, excel provides many functions like

-  CHAR - LEFT - REPLACE
- CODE - LEN - RIGHT
- FIND -  LOWER - SEARCH

7. Date & Time Functions:

With date and time functions, we can analyze and work with date and time values in formulas.
For example, if we need to use the current date in a formula, use the TODAY worksheet function,
which returns the current date based on computer's system clock. There are other main function
like

- DATE - NOW
- DAY - TIME
- MONTH - YEAR

8. ENGINEERING FUNCTIONS: The engineering worksheet functions perform engineering
analysis.

9. DATABASE FUNCTIONS: A set of functions that allows calculations on database.
Following are the functions:

DAVERAGE - returns the average of values in a list or database.
DCOUNT - counts the cells in a record that matches a specified condition
DMAX - returns the maximum value from the list or database

DMIN - returns the minimum value from the list or database

Remarks
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Search for & function:

Type & brief description of what you want to do and then Go
dick Go
Or select a category: | Most Recently Used [‘;'

Most Recently Used
Al

Finandial

Date & Time

Math & Trig
Statistical

Lookup & Reference
Database

Text
SUM{numberl,nun| lfgi%llc.;laﬁon

Adds all the numbers in a range of cells,

Help on this function [ oK l [ Cancel ]

i Total lice:ca) |
e —

UM

Number1 | I I *::| - (300;50; 150}
Number2| =

= 500
Adds all the numbers in a range of cells,

Number1: number 1,number2,... are 1 to 30 numbers to sum. Logical values and text
are ignored in cells, induded if typed as arguments.

Formula result = 500

Help on this function [ oK l ’ Cancel

8.13 CHARTS (GRAPHS) IN EXCEL

A chart is a graphical representation of the data in your worksheet. You can create an embedded
chart, which appears on the worksheet beside the data, or, you can create a chart sheet as a separate
sheet in the workbook so that it can be displayed apart from its associated data. Whichever method
you choose your chart data is automatically linked to the worksheet from which it was created. If you
change the data on the worksheet, the chart will change accordingly.

Excel offers many different chart types, each of which has several subtypes or variations:

e Column

e Bar e Radar

e Line e Surface

e Pie e Bubble

e XY (scatter) e Stock

e Area e Cone

e Doughnut e Cylinder
e  Pyramid

Standard Chart Types

The main chart types are as follows (arranged in alphabetical order):
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Area chart

An area chart shows the relative importance of values over a period of time. It is similar to a
line chart but emphasizes the amount of change (Magnitude of values) rather than time and
the rate of change.

Bar chart

Bar charts illustrate comparisons between items. Although they are similar to column charts,
the categories on a bar chart are displayed vertically and the values are organized
horizontally. This concentrates on comparing values and places less emphasis on time. A
stacked bar chart shows the relationship of individual items to the whole.

Bubble chart

A bubble chart is a variation on an xy scatter plot. The size of the bubble (data marker)
indicates the value of a third variable. Arrange the data with x values in one column (or row)
and the corresponding y values and bubble size in the adjacent columns (rows).

Column chart

Column charts can be used to illustrate how data changes over a period of time, and to
compare various items. Categories are displayed horizontally, values vertically.

Doughnut chart

Doughnut charts are similar to pie charts but, unlike pie charts, can show more than one data
series. Each ring represents one data series. These charts are widely used in the Far East.

Line chart

This shows trends or changes in data over a period of time, at even intervals. A line chart
emphasizes time flow and rate of change rather than the amount of change. If you need to
show trends or changes in data at uneven or clustered intervals, an xy (scatter) chart is more
appropriate.

Pie chart

A pie chart can only show one data series. It compares the size of individual items with the
sum of them all.

Creating A Chart

e Choose a range of data for which we want to make a chart.
e Either Click on the Chart Wizard button on the toolbar

Or

Select Chart from the Insert menu.

The first Chart Wizard dialog box will appear. The Chart Wizard —

Step 1 of 4 — Chart Type dialog box that appears has two tabs. The popular built-in chart types can be
found on the Standard Types tab. Chart types designed by us, the user, and combination charts
designed by Excel, can be found on the Custom Types tab.
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Step 3 of 4 — The number of tabs displayed in the Step 3 — Chart Options window varies, depending
on the chart type. Here we have three — Titles, Legend and Data Labels.

Chart Wizard -Step 3 of 4 - Chart Options
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Step 4 of 4 — Specify chart location in window, we can specify where this new chart is to go. You can
choose to place the chart.

Chart Wizard - Step 4 of 4 - Chart Location gn
Place chart:

‘._l_ () as new sheet: Chart1

s o B

E (®) as object in: Sheet1 v
[comcel ][ <gock ] - [_Ensh |

* As new sheet in which case a chart sheet containing just the chart will be entered in workbook —
type a name for the sheet in the adjacent box.

* As object in so that the chart will be placed in an existing worksheet

— the current one where our data is, or a different one (click on the down-arrow to select one).

8.14 ADDING GRAPHICS

Graphics can easily be added to charts and are a useful way to draw attention to a particular feature or
to provide an explanation. We may decide to add an arrow and some text to chart. Whatever we are
doing, you should first make sure that the Drawing toolbar is visible:

Select View | Toolbars | Drawing.
There are two possible scenarios:
* The graphics are confined to the area of the chart
* The graphics are partly/completely outside the chart area
Adding Graphics:
e Click on the chart to select it.
e Click on the Arrow button on the Drawing toolbar.
e Draw an arrow on your chart.

If the graphics are confined to the area of the chart, we can move the chart and the arrow will move
with it. If the graphics are partly outside the chart area, the arrow will not move with the chart unless
we also:

e Select the chart, arrow and text box (using Shift+click).
e Right-click on this selection.
e Select Grouping | Group.
e C(Click away from the selection.
Adding Trendlines:

Trendlines are used to show the trends of data in graphical form. As the name suggests, trendlines
show the up and down of data. In Excel, trendlines are of six types. These are:

- Linear - Logarithmic
- Polynomial - Power
- Exponential - Moving Average

To add trendlines following steps are required:

169

Remarks



170

Remarks

Computer Applications in Business

Select the range of data

Select Add Trendlines from Chart menu (present in menu bar as chart is created)
Specify the type of Trendline in dialog box.

To apply the changes, Click OK.

8.15 USES OF WORKSHEET IN DIFFERENT AREAS
Worksheet can be used for different purposes. Some of them are:
Used as Database in Accounting:

Spreadsheet is the combination of rows and columns in worksheet. Database is also like a worksheet
consists rows and columns to represents different types of data. So, spreadsheet is used for database.
Spreadsheet is used to create and save the accounting database. It also provides the facility of
database charts, different types of data and pivot tables. Database is created for the validity and
security of data and Excel provides these facilities. Sorting of data is also available in spreadsheet.

Marketing:

Spreadsheet is used in marketing to make the detailed marketing plan. These plans are helpful to get
the target, to make the advertisement effective, safety from mistakes and for training to employees
etc.

It is also necessary to update the marketing plan routinely.
Financial and personal sector:
Now days, financial data kept in database. It provides the information that can be used for different

purposes. For example, customer database that consists their name, address, phone number etc. and
employee database consists name of employees, designation, department etc. each value is defined in
field such as name, salary etc. Collection of field is called record and record collection is known as
database.

SUMMARY OF THE LESSON

You learnt the following in this lesson:
e MS-Excel is spreadsheet package used to organize data and to perform calculations.
e MS-Excel is used to create the simple database as well as prepare the document for WWW.
e In MS-Excel, a workbook, by default contains three worksheets.

e MS-Excel worksheet has a grid of cells arranged in rows which are numbered and columns
which are named with letters for organizing data and performing mathematical operations.

e The content of cell can be activated by double clicking on the cell or by clicking once in the
cell and then pressing function key F2.
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o Different types of Menu, toolbar and their options are used to format the worksheet. Remarks

e Excel toolbars help to use various options such as opening, creating, renaming, merging,
moving, formatting, analyzing, saving and printing a worksheet.

e Macro facility is also available in MS-Excel. These are called to speed up any general editing
sequence that a user executes in Excel spreadsheet.

e Data can be represented in graphical format using chart or graph option.
e  Worksheets can be linked using hyperlink command.

e MS-Excel provides various built-in functions for different purposes such as mathematical
functions, statistical functions, logical functions etc.

e Spreadsheet can be used in different areas such as in accounting as database, in marketing etc.
SELF ASSESSMENT QUESTIONS AND EXERCISES
Discuss the features of MS-Excel.

How a worksheet can be created?

How rows and columns can be added in Excel worksheet?

Differentiate absolute, reference and mixed referencing in Excel using examples.
Explain the steps to create, save, open and close workbook.

State the steps for opening and saving of worksheet.

What is the use of formatting toolbar in MS-Excel?

How can the content of a cell in MS-Excel be activated?

A S A A o e

State the steps to Move Cells content.

—_
(=)

. State the steps to Copy Cells content.

[a—
[a—

. Write the steps to fill color in a cell.

—
N

. Write the steps to insert row and column.

—_
W

. State the steps to change the height of a row and size of column.

—_
~

. How different worksheets can be linked with each other?

—_
9]

. How worksheet functions can be categorized?

—
(o)}

. Write the structure of the Function.

—_
\]

. Discuss various logical and statistical functions.

—_
o0

. State the purpose of different mathematical functions.

—
Ne)

. How charts or graphs can be created in MS-Excel?

[\
=]

. Write the steps to print a graph or chart.
. What is the use of ‘Macros’ in MS-Excel?

. Explain the steps to Record and Run a Macro.

NN
W N =

. Explain various References to a cell.

)
=

. What is the advantage of using keyboard shortcuts?

[\
)

. Discuss the use of spreadsheet in different area.




CHAPTER-9

INTRODUCTION TO POWERPOINT
OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the concepts of PowerPoint. Readers will be able to
understand the following:

8.1
8.2

8.3
8.4
8.5

Basic concept of PowerPoint
Creation of presentation
Insertion of slides Concept of animation

Insertion of effect and animation Presentation view
STRUCTURE OF THIS LESSON

Working with graphics
Formatting of presentation

INTRODUCTION

STARTING POWERPOINT

8.2.1 POWERPOINT SCREEN ELEMENTS
8.2.2 VIEWS IN POWERPOINT

8.2.3 POWERPOINT SLIDE MASTER

8.2.4 CREATING AND SAVING OF POWERPOINT PRESENTATION
8.2.5 INSERTING FUNCTION

8.2.6 INSERT SLIDE

WORKING WITH GRAPHICS IN POWERPOINT
FORMATTING OF PRESENTATION
PRESENTATION VIEW

SUMMARY OF THE LESSON
SELF ASSESSMENT QUESTIONS AND EXERCISES

9.1 INTRODUCTION

PowerPoint is a graphics package which allows to create drawings, charts etc. and then used for
presentation purpose. It makes the presentation very effective. There are two basic features which are
used for simplifying the task in PowerPoint and these are Presentation Design and Auto Layouts.
PowerPoint consist the tools for arrangement of word processing, outlining, drawing, graphics and
presentation. These tools are very easy to use and make the presentation attractive.

Basic terms in PowerPoint

Presentation: The primary type of file, PowerPoint is used to create. Presentations typically
have the file extension .ppt; however, we can also save PowerPoint presentations as Adobe
Acrobat documents with the file extension .pdf. Finally, we can save your presentation as a
web page, with the file extension .html or .htm.

Slides: Individual parts of a presentation. Slides are similar to the individual pages in a print
document, and can contain text, graphics, and animation.

Layout: The specific arrangement of text and images on a slide. Layouts can be very simple,
consisting of simple titles and text, or they can be more complex and include elaborate colors
and images. We can also include animation, sounds, and other multimedia objects in layout.

View: Microsoft PowerPoint has three main views: normal view, slide sorter view, and slide
show view. Normal view is the main editing view. Slide sorter view is an exclusive view of
slides in thumbnail form, helpful for rearranging the order of slides. Slide show view takes up
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the full computer screen, like an actual slide show presentation. In this full-screen view, we
see your presentation the way audience will.

- Design Template: The specific “look™ of a slide or group of slides. A design template can be
very basic - with black text on a white background - or it can be very colorful and complex.

- Slide Show: The way a presentation appears when you are presenting it. When you display
your slides in a slide show, the slides typically take up the whole screen, and they appear in
sequence.

9.2 STARTING POWERPOINT

To start PowerPoint, go to the Start menu and select Programs ->Microsoft Office ->Power Point,

W2 rricrosort office wor

@ o crvome
L= ot remier
Prcrco orfce wor]

— -
Microsoft Office Pow
=3 Zoas

9.2.1 Powerpoint Screen Elements

The very first screen that appears when we first open power-point consists of following elements:

Menu Bar Title Bar Formatiing Toolbar Help
Standard Y Mikcrosof: PowerPuint - [Presentationt) (@
Toolbar DH) e Tgdt Yew fest fgmat Lok SeShow Widw o " T
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Outline & Slides 4@ 7 wrie :
Tabbed Planes R0 O \X e Presentation x

' leleia]
:| 3
Hioens —1— Tesk Pane

G From desep tamgiee
Y rom suencortare v
8] From enstrg seesetston...

Froto stusn,
Templates
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Click to add title N o

& 0n ey computer
S oy Web e,
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Office Assistant
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Butions
Cick 0 ki rotes:

Click to add subtitle
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Status Bar Tri-Pane View Drawing Toolbar

The PowerPoint window has toolbars and panes to help you quickly create presentations. Most of
the toolbars are common in Office applications but may feature options unique to PowerPoint:

o Title Bar: Displays the document name followed by a program name

e Menu Bar: Contains a list of options to manage and customize documents

e Standard Toolbar: Contains shortcut buttons for the most popular commands
¢ Formatting Toolbar: Contains buttons used for formatting
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Status Bar: Displays slide position and the type of design in PowerPoint
Drawing Toolbar: Contains tools for drawing lines, shapes, and objects
Task Pane: Allows you to select tasks in different categories and quickly enhance your slides

in a few steps; provides quick access to the most common actions and features in PowerPoint
Outline and Slides Tabbed Pane: Lets you easily view a presentation in outline format
(text), as well as a list of all the slides in the presentation (with visuals)

Help: Provides quick access to Help topics

/ Outline *{_ Slides % X
A= 0 \x

The Outline and Slides tabbed panes are located on the left side of the screen. Click the tabs to
view an outline or slide of your presentation. The tabs render differently based on the size of the

pane.

9.2.2 Views In Powerpoint

Microsoft power point offers three views: Normal View, Slide Sorter View, and Slide Show View.

Normal View Blcontains the Outline and Slides tabbed panes on the left, the Slide pane in
the center, and the Task pane on the right.

o The Outline View shows the text of your presentation for easy editing, while the
Slides View shows text and graphics of the slide you're working on. Click the tabs to
switch between the two views. Under the center slide area is a place for notes.

Slide Sorter View 58 Jets you see small versions of all the slides you have created. You can
delete, copy, and move slides in this view.

Slide Show View = lets you see your presentation electronically as it will appear to an
audience.

The views can be seen using View menu or at lower left corner in powerpoint screen.

9.2.3 Powerpoint Slide Master

PowerPoint offers a slide master feature that gives your presentation a consistent, professional look.

A slide master is helpful if you want every slide in your show to be the same color, to have the same
header or footer, or to carry a particular logo. The background color, title, and images on the slide
master appear on every slide of presentation. Universal style changes can be made to every slide in
presentation by formatting the master slide, leaving the content of each slide unchanged.

To create a Slide Master:

Start a new presentation or open an existing one.
Click View =+ Master —* Slide Master.
A slide with placeholders appears.
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Click to edit Master title style
+ Click to edit Master text styles

—Second level
« Third level
- Fourth level
» Fifth level

stefime: docters

e Perform desired editing.
o After editing click View menu—> Normal to see applied changes.

e  Or choose Close master View in slide master view toolbar.

9.2.4 Creating And Saving of Powerpoint Presentation

o’ -
:| (==F open... Crr+O 3
Close
]l save Chri+S

Save As...

In Micro-soft power-point, there are many ways to create a new presentation.

Creation of New Power-Point Presentation

@bl Save as Web Page...
e Click on file menu-> then click on new. Pl Seae ]
o . . . . Package For CD...
e A task pane will open in right side of power-point. i et rase previen
Page Setup...

e Choose blank presentation. T -

Send To >

Wl Properties

Exit

Option 2: Click on new button IHI | on standard toolbar

Option 3: Press Ctrl+N from keyboard.

Click to add title

Click to add subtitle

Opening an Existing Presentation T ——

e Click on file menu - open.

Or

e Press Ctrl+O to open presentation.

Or
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e Choose open button g’-——' from standard toolbar.

e A dialog box will appear.

Loak in:
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File name: ‘ v l

My Computer

My Metwark.
Places Fies of type: ‘AII PowerPaint Presentations v]

e Type file name and location to open existing presentation.
Saving A Presentation
e Click on file menu—> save.
Or
e Press Ctrl +S.
Or
e Choose save button on standard toolbar.
When we first time save the presentation, it will ask for name and location of file to be saved.
Power point will save the file with .ppt extension.
Closing Presentation
e Choose close from file menu to close current presentation.
Or
e Press close button on right side of menu bar.

[ ticrose#t PowesPoint - [Presestatisa3] =S
D3] g Bt Wew [t Foma [ods Sdeshow window Heb Trpe 2 questionfor heb__ [
HR RSN BN TH= NENk -
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Closing Powerpoint

e Choose exit from file menu to close power point.
Or
e Press close button on right side of title bar.

I Microseft PowesPoint - [Presentationd] BE
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Running Powerpoint Slide Show

Once created slides, we can run your Slide Show:
Do one of the following:
e Press F5.
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e Choose Slide Show > View Show from the menu.

e C(Click the Slide Show icon , which is located in the bottom left corner of your screen.
The slideshow will appear on screen.
Page Setup

e Click on file menu—> choose page setup.
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e A dialog box will appear.

Page Setup
Slides sized for: Orientation -“
vi| - sides
wih Ot
10 + | Inches () Landscape
icht: Motes, handouts & outline
75 5
s m:m @ Portrait
ers Olandscape

e Set the values like width, height and slide orientation of slides and notes, handouts & outline.

Editing of Presentation

Edit menu

This menu involves a number of editing options, which are following:-

UNDO & REPEAT — This command undo or repeat the action

57 File [ Edt | Wiew Insert  Format  Tool
that has performed. g o
CUT- It takes out the highlighted text or graphics. IO”’E '

5% Office Clipboard. .

COPY- used to copy the highlighted text or graphics. = Rl
OFFICE CLIPBOARD - used to collect text and graphics from e o
different documents or other program and then paste them into o
any office document. 2| £nd. e
PASTE — used to paste copied text or graphics.

PASTE SPECIAL - This command connect the content of
clipboard with present or working file.

PASTE HYPERLINK — This command is used to connect to files or link the files with
each other.

CLEAR- it is the other way of delete as it clears all formats or contents such as text or
graphics.

SELECT ALL- It selects the whole text for formatting or deleting.
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Remarks | 9-2-5 Inserting Function
- SLIDE COPYING: For slide copying, select Duplicate slide from Insert menu. This will create the

same copy of slide.

Click to add title

Click to add subtitle

SLIDE NUMBERING
- Select Header and Footer from View Menu.
- Click on Slide number checkbox.

- Click on Apply to all button. It will assign the number on all present slides.

Sid= 3 0f 3 Defauk Desgn Engish (US.) o

Printing of Presentation
- Select Print from File Menu and select the printer.
- Click on Properties

- Click on Ok.
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9.2.6 Insert Slide

From Insert Menu

The first way to insert a new slide is to Click the Insert Menu and then New Slide. PowerPoint will

insert one new slide into the presentation and display in the Slide Pane.

Holding down the Control Key and pressing M (Ctrl+M) will also inset a new slide.
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PowerPoint does several things when you create a new slide. First it automatically opens the Task
Pane on the right side and sets it to display the Slide Layout Task Pane. Second it creates a new
content slide that includes a title and text and displays it for editing in the Slide Pane. Finally, it crates

a new thumbnail image and displays it in the Outline/Slides pane on the left.
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Insert a New Slide from the Formatting Tool Bar

Another way to insert a new slide into a presentation is to Click New Slide from the Formatting

Toolbar. When clicked, the new slide button also creates a new content slide that includes a title and
a text box.
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Insert A New Slide From The Outline/Slides Pane

Another way to create a new slide is to Right Click the mouse on a thumbnail in the Outline/Slides
Pane. This will bring up a context sensitive menu. From the menu, Click New Slide. PowerPoint will
insert a blank content slide that includes a title and text box.

You can also highlight a thumbnail image and then Hit the Return or Enter Key to inset new slides
into the presentation.
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Insert A New Slide From The Outline View

You can insert new slides from the Outline/Slides Pane by clicking on a slide and hitting the Return
or Enter Key. You can also Right Click in the Outline view bringing up a context sensitive menu.
From the menu, you can choose New Slide.
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Inserting A New Slide From The Slide Sorter View

You can also insert a new slide from the Slide Sort View by Right Clicking in any area in the view. A
context sensitive menu will pop-up. Click on New Slide from the menu, and PowerPoint will insert
the new slide into the Slide Sorter View.
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9.3 WORKING WITH GRAPHICS IN POWERPOINT

Graphical elements can help to create attractive slides for presentation. PowerPoint provides the
option of adding AutoShapes, WordArt, Flowcharts symbols, and ClipArt etc.
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Autoshapes

In PowerPoint, with some AutoShapes text can be added and with others, flowcharts can be created.
1) Add an AutoShape to presentation:
- From Insert menu, click Picture and then click AutoShapes
- Click the AutoShapes inserted on slide.
- Click the upper-right corner of the slide and then drag the object down diagonally about
one inch.
- To delete an AutoShape, right-click the AutoShape to be deleted and then click cut.
2) Add an AutoShape with text to a presentation:
- On the AutoShapes toolbar, click Callouts.
- Click Rounded Rectangular Callout.
- Click the upper-right corner of the slide and then drag the object down diagonally about
one inch.
- Type the text of choice.
- Select the text jst typed.
- Right click the Callout box, click font, change the font size and then click OK.
- Click and drag the upper-right corner of Callout box until all the text fits within it.
- Close the AutoShapes toolbar.
Clipart
There are different ways to add the ClipArt on the slide. It can be added from Insert menu option or
Drawing toolbar.
- On the Drawing toolbar, click insert ClipArt.
Select a category such as bird
Click keep looking to view additional graphics.
To insert the graphics, click the graphics and then click insert clip.
Move the graphics by dragging it to the desired location.
- Resize the graphics by selecting the graphics and moving the handles until the graphic is the
desired size.

Adding Textbox

Text box can be added by selecting Text box from Insert menu. In the text box, text can be typed and
graphics can be added.

Add The Picture From Scanner or Camera

In presentation, picture can be added from scanner or camera. For this
- Select insert from main menu
- Select picture and then select From Scanner or Camera.

Add The Picture From File

To insert the picture from file, place the cursor in the document where picture is to be inserted and
then click. After that, select Picture from Insert menu. A dialog box is to be opened to ask the name of
file where picture is to be stored. Select the file and then click insert.

Add Organizational Chart/ Diagram

To insert the Organization chart, following steps are used:
- Select INSERT > PICTURE > ORGANIZATION CHART
- Click on Diagram from Organization Chart.
- Click on Ok.
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9.4 FORMATTING OF PRESENTATION

Formatting is used to define different formats of specific aspect related to slides such as the process of
changing the appearance of the text, deleting a portion of the text or moving a part of the text. It is
necessary to select the text before move, format, delete or changing text.

e tab on dialog box.
Change the color of slide by selecting the color swatch beside FONT OF TEXT

e Select the text you want to change

e Click a font name in the Font box on the Formatting toolbar
SIZE OF TEXT

e Select the text you want to change.

e Click a point size in the Font Size box on the Formatting toolbar.
BOLD TEXT

e Select the text you want to change.
e Click Bold on the formatting toolbar.

ITALIC TEXT

o Select the text you want to change.

e  Click Italic on the formatting toolbar.
UNDERLINE TEXT

e Select the text you want to change.

e Click underline on Formatting toolbar.
ADD BULLETS OR NUMBERING
Select the text you want to apply bullets or numbering to

To add bullets, click Bullets on Formatting toolbar.
e To add numbering, click Numbering on Formatting toolbar.
e Click on Ok.
ALIGNMENT OF TEXT
Align text with the left margin
e Select the text you want to align left.
e Click Align Left(Ctrl+L) on the formatting toolbar..
Align text with right margin
o Select the text you want to align right.
e Click Align right(Ctrl+R) on the formatting toolbar.
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Center text

e Select the text you want to center.
e Click Center(Ctrl+E) on the Formatting toolbar.

Justify text

e Select the text you want to justify.
e  Click justify(Ctrl+]J) on the Formatting toolbar.

Line Spacing

This is used to set the space between selected lines. For this, select Line Spacing from Format menu
for setting.

Slide Layout

Each page of presentation is specifying as slide layout. The layout of slide can be changed by
selecting the slide. For this, select Slide layout. Then select the desired layout.

Color Schemes

The color scheme of designed slide template can be modified and a new color scheme can be added to
blank presentation. The steps are following:

Select Format > Slide Color Scheme from Menu bar.

e Click one of the preset color scheme in Color Schemes box.
e Click Preview button to view how the scheme will appear on the slide.
e To make changes to color scheme, click Custorn name of element and click change color
button.
e After finishing all color formatting, click Apply to All to apply the color scheme to all the
slides in presentation.
Background Fill

Background can be modified or added to a new slide. Following steps are used for this:

Select Format > Background from menu.

Select a color from drop-down menu below the Background Fill preview or choose More
Colors.... for larger selection.

Select Fill Effects from drop-down menu to add gradient, texture, pattern or picture to
background.
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Spell Check

The spell check feature provides helps to check and correct spelling in the presentation. To start
correction of spelling in presentation, select Tools > Spelling from menu bar or press F7 on keyboard.
The steps are following:

e The spell check prompt to make correction in first word that is spelled wrong.

e If the word spelled correctly or not to be changed then click Ignore or Ignore All if the
same word appear several times in presentation.

e If the word spelled wrong, highlight any one of the displayed Suggestions or type own
spelling in Change to box. Click Change to correct the occurrence of word.

o Click Close to abort spelling check early.
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Macro

Macro can be created, edited and deleted in PowerPoint. Macro can be recorded by Tools > Macro >
Record New Macro.

9.5 Presentation View

To make effective presentation, animation effects can be inserted in slides. Audio video clips can also
be inserted in slides to make the presentation attractive

To Insert Transition Effect

The time specified for opening of slides can be defined by transition effect. It can be done by
following way:

- Select Slide Show > Slide Transition from main menu.
- Click effect from drop-down menu.

- Select the speed for effect i.e. Slow, Medium or Fast.

- Click Apply to All to make the slides effective.

Adding Sounds

One way to incorporate sound into presentation without creating problems with disk space is to play a
portion of a CD from the computer’s CD drive. (You can do this only if you are running your
presentation from the hard drive or the floppy disk drive, rather than from the CD drive.)

o Click the Insert button on the menu bar at the top of your screen.
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e Select Movies and Sounds from the drop-down menu, followed by Play CD Audio Track.

Remarks
This will display the Movie and Sound Options dialog box shown in Figure.

¢ Enter the track of the CD you want to play.

¢ Also note where in the track you wish to begin and end; enter this information in minutes
and seconds.

[P — ]
Clip selsction
Start at track: H Eime: Iﬁﬂ seconds
End at track: m tirne: [ﬁ:uo =] seconds
Play options
I Loop until stopped

Sound volume: ﬂ

Display options
I™ Hide sound Icon during slide show
Information
Total playing tims:  00:00

File: [CD Audio]
oK ] Cancel I

e When you click OK, another dialog box will ask if you want the sound to play automatically
when the slide appears on screen or when you click the sound icon. In most cases, you
should choose the second option, so you can control exactly when the CD will play.

o After you make your selection, the dialog box closes and a sound icon appears on the screen.
You can place the icon anywhere on the slide by dragging it to your desired location.

Another way to incorporate sounds into a PowerPoint presentation is to download sound clips from
the Internet. You can use a clip that you have downloaded previously, or you can download one
specifically for your speech. In either case, the procedure is the same for inserting the clip onto a
PowerPoint slide:

e Click Insert on the menu bar, followed by Movies and Sounds from the drop-down menu.

o Select Sound from File to display the Insert Sound dialog box (Figure).
o Find the file that contains the clip you want and click OK to add it to your slide.
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Adding Animation

In PowerPoint, “animation” refers to the way objects enter or exit a slide. Without animation, all the
items on a slide appear at the same time when the slide is displayed. With animation, you can control
when words, pictures, and even parts of graphs show up on the screen.
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Preset Animation

One way to generate animation is by using PowerPoint’s preset animation effects. To add preset
animation to an individual slide, display the slide in Normal view and follow these steps:

e Click Slide Show on the menu bar at the top of your screen, followed by Animation
Schemes from the drop-down list. The left column on your screen will show thumbnails of
all the slides in your presentation. The right column will present a list of animation effects
arranged by category: No Animation, Subtle, Moderate, and Exciting,

pply
Animation io
All Slides

e Click the effect you want and it will be added to the slide that is currently on screen.
e To test the animation, click Play at the bottom of the right column.
e If you want to apply the animation to all the slides in your presentation, click Apply to All
Slides.
Custom Animation
Custom animation gives full control of all your animation effects. There are six steps in adding
custom animation:
e Make sure the slide to which you want to add animation is displayed in Normal view.
e Click Slide Show on the menu bar at the top of the screen.
e Choose Custom Animation on the drop-down menu to display the Custom Animation task
pane at the right of your screen—as seen in Figure.
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Remarks e Click on the object or text you want to animate.

e Click Add Effect in the Custom Animation task pane, followed by Entrance and More
Effects from the resulting shortcut menus shown in Figure.
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e The Add Entrance Effect dialog box will now be displayed on screen (Figure). Click on any
effect to preview it. Once you have decided which effect to use, click OK to apply it to your
slide.
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When choosing an animation effect, stick with those in the Basic, Subtle, and Moderate categories—
such as Appear, Dissolve In, Strips, and Stretch. Those in the Exciting category are fun to experiment
with, but are too distracting for most speeches. Also, stick with a limited number of animation effects
and use them consistently from slide to slide.

Timing, Direction, and Speed of Animation Elements

Depending on the animation effect you pick, you may need to choose its timing, direction, and speed.
You can adjust all of these with the boxes under Modify in the Custom Animation task pane.

e To open the pane, make sure the slide to which you want to add animation is displayed in
Normal view.

e Click Slide Show on the menu bar at the top of the screen.

e Choose Custom Animation on the drop-down menu to display the Custom Animation
task pane at the right of the screen.
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e The default option for starting animation effects is On Click, which prevents objects from
showing up on screen before you’re ready. If you want items to appear automatically, click
the arrow at the right of the Start box to expose a drop-down menu and select another option.

e To control the direction and speed of animated items, highlight the desired item and click the
down arrows in the Direction and Speed boxes in the Custom Animation task pane. This will
expose drop-down menus with a number of options. Click the desired option to apply it to
your slide.

As with other aspects of animation, choose direction and speed options that are not going to distract
your audience. For example, if you’re using Fly In, it’s usually best to choose From Left for text that
is located on the left of the slide and From Right for text that is on the right of the slide.

Although the best speed will depend on the exact animation effect you select, Fast and Very Fast are
usually preferable because they get the text or object on screen quickly without drawing undue
attention to the animation effect.
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Hiding of Slide

In PowerPoint presentation, slides can be hiding. These are not visible at the time of slide show. To
hide the slide, Select Slide Show > Hide slide from main menu.

To Show the Invisible Slide in Slide Show:

This can be done by selecting the hiding slide in Normal view and right click on it.

SUMMARY OF THE LESSON

You learnt the following in this lesson:

Microsoft power-point is an effective component of Microsoft office package to make
attractive presentations in very small amount of time.

A presentation mainly is composed of slides. A slide is like a page that can have any type of
data over it. The data could be text, images, audio or a video file.

Data can be inserted in a slide by many ways.

There are three types of views in power-point: Normal view, slide sorter view and slide show
view.

A slide master is a master slide which can be configured to give a consistent look to complete
presentation. All the formatting to be applied over all slides can be incorporated on slide
master.

A new slide can be inserted by many ways: Pressing CTRL+M from keyboard, choosing
New Slide from Insert Menu or clicking on new slide button on formatting toolbar.

The major benefit of power-point is to create any type of presentation. It could be for
students, employees for common people.

The AutoShapes toolbar allows drawing a number of geometrical shape, arrows, callout and
other graphics on a slide.

Several predefined animation are available in PowerPoint which can be used through drop-
down menu.
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12.

SELF ASSESSMENT QUESTIONS AND EXERCISES
What do you mean by PowerPoint presentation?
What are main screen elements of PowerPoint screen?
Explain the types of views available in PowerPoint.
What is slide master?
What are the different ways of inserting a new slide in presentation?
What are the steps to insert sound on a slide?
Explain the concept of clip-art.
How charts can be created on a PowerPoint slide?

What do you understand by animation? What types of animation can be applied
over a presentation?

When we use paste as hyperlink command?
How custom animation is different from pre-set animation?

What are the page margins? Why page setup is required.
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CHAPTER-10

INTRODUCTION TO LOTUS SMARTSUITE
OBJECTIVES OF THIS LESSON

This lesson is aimed to make you understand the concepts of Lotus SmartSuite. Readers will be able
to understand the following:

e Basic concepts of Lotus SmartSuite

e To make effective worksheet in Lotus

e Concept of Cell Referencing

e Use of in-built functions

e Goal seek and Backsolver tool

e  Working with graphics in worksheet

e Sharing of data with other desktop application

e Making of error-free worksheet

STRUCTURE OF THE LESSON

9.1 Introduction

9.2 Structure of Spreadsheet and use in Accounting
9.3 Opening Lotus 1-2-3

9.4 Components of Lotus Window

9.5 Basic Terms and Definitions
9.6 Structure of Lotus 1-2-3 Window
9.7 Built in Functions

9.8 Using Graphics
9.9 Sharing Data with other Desktop Applications
9.10  Strategies of Creating Error Free Worksheet
Summary of the Lesson
Self Assessment Questions and Exercises

10.1 INTRODUCTION

SmartSuite is an office suite from Lotus Software. The office suite has two versions: one for windows
and other for OS/2.SmartSuite is not officially supported by IBM on versions of windows after XP,
but it does work well on both the 32 bit and 64 bit versions of windows vista and windows 7.

Components of Lotus SmartSuite
The following applications are included in SmartSuitee for Microsoft windows:

Lotus word pro — word processor

Lotus 1-2-3 — spread sheet

Lotus freelance Graphics — presentation software

Lotus approach — relational database

Lotus organizer — personal information manager

Lotus Smart center — a toolbar to quickly access programs
Lotus Fast Site — web design software

Lotus ScreenCam — screen recording software

PN RO =
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Package Components Working of Min. space required Max. space required
component (in MB) (in MB)

Word Pro Word processor 16 38

1-2-3 Spreadsheet 12 22

Approach Relational Database 8 19

Freelance Graphics Presentation software | 9 19

Organizer Personal Organizer 7 11

Screen Cam Screen Capture 3 3

Smart Centre One click icons 1.5 1.5

Total Space Required 56.5 118

System Requirements

» IBM Compatible System.
» VGA Monitor

> Min. 8 MB RAM
WordPro

» DOS 3.1 and DOS 4.x
» Min. space required: 56.5 MB
» Max. space required: 118 MB

Earlier known as AmiPro, WordPro is word processing software. “Take a tour” is a feature, which
allows getting complete knowledge about software. “Take a tour” option is available in toolbar. It
shows following options:

Starting WordPro, Frames, Graphics, Tables, Help, Text Formatting, Share Document, Spell Check &
Format Check, Arrange document, Review & Comment Tool, and printing.

Lotus 1-2-3

Spread sheet software is used to save information to be processed. Spreadsheet allows users to work
with numbers and apply formulae on that numeric data. Spreadsheet allows users to arrange and
organize data as per requirements.

Lotus 1-2-3 is a member of spread sheet family of software. It is integrated with Lotus SmartSuite
which is an office suite. It is capable of doing three specific functions:

1. Electronic spreadsheet/worksheet: allows analysis of numeric data.
2. Database management : allows to handle great amount of data and querying on that data
3. Graphics/Charting: allows the user to represent data in pictorial form.

10.2 STRUCTURE OF SPREADSHEET AND USE IN ACCOUNTING

Spreadsheet is a datasheet that contain cells which are used to specify the rows and columns. Each
cell consist different types of data such as alphanumeric, numeric and formula etc. Formula shows
how calculations are done in cells. In financial matters, spreadsheet is mostly used due to change in
whole spreadsheet on the basis of change in one cell.
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Financial and Marketing based Function:
It consists mainly three parts.

1.

Customer Oriented:

In any business, one thing is kept in mind that what are the customer requirement and what
he/she wants. After analysis of all these, things can be launched in market.

Matter of Profit:

In business, there should be some profit for businessman when they provide services to their
customers. It is necessary to run the business smoothly. Without profit, one cannot think
about the requirement or need of customers.

Unity :

According to this, if there is no unity in different departments then marketing is not
successful.

For each business, some more things are required also known as financial tools:

Balance sheet:

This is the most important document in accounting. The main purpose of the balance sheet is
to provide the information regarding total assets and liabilities of the business organization.

Profit and loss statement:

The role of profit and loss account in any business organization is to give information about
the income of the organization in terms of profit and also the total outflow in terms of losses.
Cash flow statement:

Any business organization may be interested in the cash flow. How much cash inflows and

how much of that goes out, can be determined from a special type of document called cash
flow statement.

10.3 OPENING LOTUS 1-2-3

Double click on application icon of Lotus 1-2-3 to open or launch the application.
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Closing Lotus 1-2-3

To quit Lotus 1-2-3, click on file menu, and then choose exit.
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10.4 COMPONENTS OF LOTUS WINDOW
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When we launch Lotus 1-2-3, the main window is visible which include control panel at the top of
screen, a document window called work area at bottom and status line below that work area. The
control panel consists of 3 rows: title bar followed by menu bar and the edit line.

Title bar

BT otus smartsuite 105 [

Displays the name of application “Lotus 1-2-3”, the control menu box on the far left and minimize,
maximize and close button on far right.

Menu bar

File Edit View Create Range Sheet Window Help

Displays main commands
The commands can be clicked by mouse left button or by pressing keyboard shortcuts.

Edit Line

[ TT—T |

This row contains four parts, which are:

a) Selection indicator: displays current cell address
b) Navigator: allows moving around worksheet
c) Function selector: lets you choose functions
d) Content box: displays text you enter in a cell
Status bar
|7 Hehetica | 12 &z B/ Z|U]  Nostde | General | rm = | ‘Rea&«li

This bar is located at very bottom of document window. It displays the information about the current
state of the program. It displays the properties of selected object, the current file, current mode and
status of lotus. The status line also contains button controls that let you change the following:

a) Number format
b) Font face of current selection
c) Point size of current selection
d) Smart icon bar

When you point to these items and click the left mouse button, additional menu items
appears.
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10.5 BASIC TERMS AND DEFINITIONS
Cell

It is the basic unit of any spread sheet. It is the place where information is actually stated. Cell is
defined by its row and column. For example, C6 means a cell in third column and 6" row.

Al A | B | ¢
i
2

Active cell

Active or selected cell is the cell that which has highlighted outline box around it. This is the cell
ready for inserting or editing the data.

Range

Range is referred to a cell or a group of adjacent cells forming a rectangle. A range is defined by the
addresses of two cells that are in opposite corners of the rectangle area. A range can be selected to
work upon a group of data values.

Worksheet

In Lotus 1-2-3, a file may have one or many worksheets. Each worksheet may have different type of
information contained in it. Worksheets are used for data management and numerical calculations.

Workbook

Lotus for windows allows you to work with a collection of worksheets/ spreadsheets at a time. This
collection of worksheets are called workbook. Workbook allows you to keep related spreadsheets
together and make global changes.

Applications of worksheet/Spreadsheet

1. Worksheets can be used for accounting purpose. Data can be represented using rows and
columns. User can create database using worksheets. Database charts and Pivot tables can be
created within the spreadsheet also.

2. Worksheets can be used for creating marketing plans.

Type of data in Lotus 1-2-3

a) Label: text information is referred as label
b) Value: this can be number, cell reference, formula or function.

10.6 STRUCTURE OF LOTUS 1-2-3 WINDOW
Info Box

This is the place where we can change and modify the properties of any object. Properties of object
include name, color, size and security features. Select an object and click on Range menu - Range
Properties. It will open info box for the object. Here, we can change the properties of the object.
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Cell comment: -

MName and Date Stamp

Tabs in INFO BOX
Info box contains a series of tabs. Every tab has a set of specific properties.
Use of smart icons:

These are the shortcut icons of commands in LOTUS 1-2-3 which are frequently used by the user.
These icons are above the workspace. When we mouse over these icons, LOTUS 1-2-3 shows their
workings.
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Cell Referencing in Worksheets

Each cell has a unique address formed by combination of its row and column address. When a cell
address is referred to in a formula, its writing style determines how that cell will be referenced during
calculations. There are three referencing styles in a worksheet:

a) Relative referencing b) Absolute referencing c) Mixed referencing
Relative referencing

In a formula copied from one column to another, a reference to a range in the first column becomes a
reference to a adjacent range in the second column. For example, when copying a formula from
column C to column D, a reference to range C1..C3 becomes a reference to adjacent range D1..D3.
The range address in this copy operation is relative reference. A similar adjustment occurs when we
copy a formula from one row to another.

Absolute referencing

When we want all or part of cell address not to get adjust as it is copied, we need absolute
referencing. This means that cell address is referencing a fixed location and does not adjust as it is
copied. To make a formula absolute put a dollar sign ($) in front of row/column reference that should
not change as the formula is copied.

Mixed referencing

A cell address contains two parts — column letter and row number. If we put a $ sign before both
parts, the cell address becomes absolute. If we do not put $ sign before anyi, it is relative address. And
if we put § sign before any one part, it is mixed reference.
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10.7 BUILT IN FUNCTIONS

A function is a shortcut for formula. A formula is that which is seen on one side of equation. For
example,

=3+ (7-4)

=B4+G7

A formula works well for small range of data. But say we have a list of 50 values, that would be one
long formula. Here the concept of function is used.

@SUM(B1..B50)

A function consists of @ sign, then the name of function (e.g. SUM) followed by arguments within
the parentheses (e.g. B1..B50).

@Function List

LCategony:

0K

2l ffunctions :
@Functions: Cancel

addil

ABS :‘ Help
ACCRUED
ACCRUED2Z
ACOS Menu >>
ACOSH ~]

Description

@{D[location)

Retums the contents of the cell whose name or address
is specified in anather cell

Type of Functions

Various functions available in Lotus can be categorized as:

1.

Financial Functions. They analyze investments, annuities and securities; determine
depreciation; and calculate cash flows and loans.

Logical. They Calculate the results of logical formulas

Mathematical. They, simplify various Mathematical operations such as calculating square
roots and replace complex trigonometric calculations.

Statistical. They, performs calculations on lists of values.

String. They, provides information about text in cells and perform other operations on text.

Financial Functions

S.No. | Function Name Syntax

1 @FV (Future Value) (@FV(payment amount, periodic interest rate, no. of items)

2 @PMT (Payment) @PMT (principal, periodic interest rate, no. of terms)

3 @PV (Present value) @PV(payment, periodic interest rate, no. of terms)
Mathematical Functions

S.No. Function Name Syntax

1 @ABS (Absolute Value) @ABS(Value)

2 @EXP (Exponent Value) @EXP(Value)

3 @INT (Integer Value) @INT(Value)

4 @LN (Natural Logarithm) @LN(Value)

5 @LOG (Base 10 Logarithm) @LOG(Value)

6 @MOD (Reminder from division | @MOD (Numerator, Denominator)

of two integers)
7 @ROUND (Rounded Value) @ROUND (Value)
8 @SQRT (Square Root) @SQRT(Value)
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Statistical Functions

S.No. Function Name Usage
1 @AVG To find the average of a range
2 @COUNT To count number of cells in a range
3 @MAX To find the largest value of a range
4 (@MIN To find the smallest value of a range
5 @SUM To find the sum of values of a range
String Functions
S.No. Function Name Syntax
1 @LEFT @LEFT(String, n)
2 @LENGTH @LENGTH(String)
3 @LOWER @LOWER(String)
4 @MID @MID(String;pos;n)
5 @RIGHT @RIGHT(String, n)
6 @UPPER @UPPER(String)
Logical Functions
S.No. Function Name Usage
1 @FALSE Reurns the logical value 0 (false)
2 @TRUE Returns the logical value 1 (true)
3 @IF To evaluate condition and returns true or false

e.g, @IF(A4>500;@TRUE; @FALSE)=0
Goal Seek

It is also a part of Lotus 1-2-3 commands. It is also called what-if analysis tool. Goal seek allows the
user to use the desired result of a formula to find the possible input value necessary to achieve that
result. The goal seek command is a process of calculating an output by performing various what-if
analysis on a given sets of input. E.g., we know the total profit to be gained and number of units to be
sold and we want to know what should be the cost of per unit so that desired profit can be gained.

Backsolver Tool

Backsolver tool is selected from Range = Analyze = Backsolver. When we click on Backsolver, a
dialog box appears. This tool is used when we know the result of the formula, but we do not know
how to get it.

What-If Solver : What-If solver can be used to solve linear and non-linear both types of problems.
This feature is added to Lotus 1-2-3 in 1990.

10.8 USING GRAPHICS

One of the important features of Lotus 1-2-3 is that it represents tabular data in pictorial form which
is easily understandable. This pictorial form could be in form of charts or graphs.
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10.9 SHARING DATA WITH OTHER DESKTOP APPLICATIONS

One of the important features of Lotus 1-2-3 is Lotus notes which is client in client server
architecture. This feature allows other applications to link data with other applications. The Text field
is used to make OLE object. Linked data is directly associated with real data of other application.
Therefore we can see changes are reflected at both places. By double clicking on OLE object the link
is opened up with original application.

10.10 STRATEGIES OF CREATING ERROR FREE WORKSHEET

A Worksheet is used for numerical calculation which must be error free for every business
organisation it is important to have accurate output. A small error can affect many business decisions.
While creating a worksheet user must be careful about following errors:

1. Syntax Error:
This kind of error means we have written formula by wrong way.

2. Run Time Error:
This kind of errors are difficult to find e.g. a value is divided by zero.

3. User Error:
Errors created by user e.g. wrong entry in a cell. It is not necessary that user make errors, errors
are performed by mistake also. Therefore, such kinds of errors are very difficult to find. For
example, a wrong entry in cell may change entire output.

Therefore, it becomes important for us that we must try to make error free worksheet. If errors are
there, they should be found and rectified. One method of creating error free worksheet is to lock
those cells where critical data or formulae are saved.
Using LOOKUP for data entry and avoiding errors
In LOTUS 1-2-3, we can use lookup functions to minimize the chances of errors. Following are the
lookup functions:
1. HLOOKUP:
By using @HLOOKUP(X; range; row-offset) we can see the value of a special cell in a row. The
output will be a horizontal table.
X: X could be any value but it should be equal to or greater than values of range. Otherwise
output would be the last value of range.
Range: The range could be any specific row or the first row labels.
2. VLOOKUP:
By using @ VLOOKUP(X; range; row-offset) we can see the value of a special cell in a row. The
output will be a vertical table.
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SUMMARY OF THE LESSON

You learnt the following in this lesson:

e LOTUS Smart suit is a professional package for office automation. It consists of many
components like word pro, LOTUS 1-2-3 etc.

e Spreadsheet is a data sheet which looks like a normal sheet like on paper. It contains rows
and columns which makes cells. A cell is a place where data can be entered.

e LOTUS 1-2-3 is a kind of spreadsheet. This component is a part of LOTUS SmartSuite which
is an office suite.

e LOTUS 1-2-3 is an electronic spreadsheet used to process data, analyze it and perform
calculations over it.

¢ Info Box is a place where object properties can be modified according to user requirements.

e Goal seek feature is used when we know the final value but we do not know what would be
the input to get that final output.

e Errors are the mistakes in a worksheet which could be of any type and can cause the
unexpected output.

A e T

8.
9.

SELF ASSESSMENT QUESTIONS AND EXERCISES

What do you mean by LOTUS SmartSuite? Describe the components of SmartSuite.
What is LOTUS 1-2-3?

Discuss the system requirements of LOTUS 1-2-3.

How LOTUS 1-2-3 is helpful in accounting and marketing?

What are the types of data in LOTUS 1-2-3?

Explain the concept of referencing. What are the types of referencing?

What do you understand by functions? What are the types of functions available in
LOTUS 1-2-3?

How backsolver tool is useful and how is it different from what-if solver?

Write the steps to create a workbook.

10. What is goal seek feature?

11. Explain the strategies of creating an error free worksheet.

12. How data is shared from LOTUS 1-2-3 to other applications
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INTRODUCTION TO TALLY
OBJECTIVES OF THE LESSON

This lesson is aimed to make you understand the concepts of Tally.ERP9 software. Readers will be
able to understand the following:

e Basic concepts of Tally. ERP9
e Use of TallyERP9
e Creation of Accounting Voucher and Invoice
e Creation of payroll statement
e Maintenance of inventory records
¢ Final account and maintenance of accounting books
STRUCTURE OF THE LESSON
11.1  Introduction
11.2  Accounting
11.2.1 Types of Accounting
11.2.2 Major Reports in Financial Accounting System
11.2.3 Types of Accounts
11.2.4 Debit and Credit
11.2.5 Accounting Principles
11.2.6 Accounting Terminology
11.3  Woking in Tally.Erp9
11.4  Creation of Voucher and Invoice
11.5  Creation of Payroll Statement
11.6  Maintenance Of Inventory Records
11.7  Maintenance of Accounting Books and Final Accounts
11.7.1 Modification in Report:
11.7.2 Day Book
11.7.3  Accounts Book
11.7.4 Preparation of Financial Reports
11.7.5 Stock Summary
Summary of the lesson
Self Assessment Questions and Exercises
11.1 INTRODUCTION

Tally is powerful accounting software which is easy to use and designed to simply complex day to
day activities associated in an enterprise. Tally, accounting software, provides a solution around
inventory management, stock management, invoicing, purchase order management, discount, stock
valuation methodology etc.

The technology used by Tally makes data reliable and secure. In Tally, data can be seen by only
application and this increase the security of data.

Tally ERP 9 is an advanced and simple to use accounting software. It is software with the help of
which accounting process is carried out mechanically through instructions given by user with the
selection of graphical represented information of computer screen.

Features of Tally ERP 9

e It is user friendly. Users can create their own names for their accounting data in their own
language.
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e tis easy to install and easy to use.

e [t provides complete business solutions. Accounts can be managed either with inventory or
without inventory.

o It enables to work with multiple company accounts simultaneously.
e It provides the facility to automate the management of employee records i.e. payroll system.
e [t provides powerful audit capabilities.
e [t gives varieties of management reports.
e It provides the facility of invoicing.
11.2 ACCOUNTING
Meaning of Accounting
Accounting is defined as the process of identifying, measuring and communicating the economic
information of an organization to its users where the information is needed for decision making.
11.2.1 Types of Accounting
Accounting can be classified into three categories which are following:
1) Financial accounting;
i) Cost accounting; and
iii) Management accounting.
Now, let us understand these terms.
Financial Accounting

Financial accounting concerned with the financial state of affairs and financial results of operations. It
is the process of generating information in the form of financial statements for external use i.e.
preparation of financial statements for the use of outsiders like creditors, debenture holders, investors
and financial institutions. The financial statements i.e., the profit and loss account and the balance
sheet, specifies the manner in which operations of the business have been conducted during a
specified period.

Cost Accounting

Cost accounting concerned with the accumulation and assignment of historical costs to units of
product and department, mainly for the purpose of valuation of stock and measurement of profits. It
includes the application of different techniques to evaluate and control costs. Its application is suitable
for manufacturing concerns. It generally relates to the future and consists an estimation of future costs
to be incurred.

Management Accounting

It is an accounting for the management i.e., accounting which provides necessary information to the
management for discharging its functions. Information may be in the form of budgets and forecasts,
that enable an enterprise to plan effectively for its future or may include an assessment based on its
past performance and results.

Management accounting is not only restricted to the area of cost accounting but also covers other
areas (such as capital expenditure decisions, capital structure decisions, and dividend decisions) as
well.

11.2.2 Major Reports in Financial Accounting System
The documents used in financial accounting system are following:
- Voucher: entries are defined in voucher at the first time.

- Journal: This is the primary book of accounts in which business transactions are recorded in
chronological and systematic order, with the help of voucher. In journal, accounts to be
debited and credited are specified together with explanation for the entry.

- Ledger: A ledger is summary statement of all transactions related to a person, assets, expense
or income taken place during a period of time and shows their net effect. In ledger, entries are
defined on the basis of group and after that calculation are performed.
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On the basis of above defined documents, different types of reports are generated which are
following:

Trial Balance: This is the statement containing the balance of all ledger accounts, at any
given date, arranged in the format of debit and credit column to check the arithmetic accuracy
of ledger.

Profit and Loss report: This is prepared to know the net profit and loss of the business.
When debit side is excess that means there is loss and if the credit side is excess it means
profit is there.

Balance Sheet: This is the statement of assets and liabilities of a business. This is prepared to
know the exact financial position of business

11.2.3 Types of Accounts
The accounts can be classified into two categories: Personal and Impersonal.

Personal Accounts: Accounts which represents person or group of Persons and organizations are
known as personal accounts. These accounts are necessary, in particular, to record credit transactions.
Personal accounts are of the following types:

(C))

(b)

(©)

Natural persons: An account that consist transactions with an individual human being is
termed as a natural persons’ personal account. eg., Mary’s account, Ram’s accounts etc.
Males and females both are included within this type of account.

Artificial or legal persons: An account that consist financial transactions with an artificial
person created by law or otherwise is termed as an artificial person, personal account, e.g.
Firms’ accounts, limited companies’ accounts, educational institutions’ accounts, Co-
operative society account.

Groups/Representative personal Accounts: An account indirectly representing a person or
persons is known as representative personal account. When accounts are of a similar nature
and their number is large, it is better to group them under one head and open representative
personal accounts. e.g., prepaid insurance, upstanding salaries, rent, wages etc. When a
person starts a business, he is known as proprietor. This proprietor is represented by capital
account for that entire he invests in business and by drawings accounts for all that which he
withdraws from business. So, capital accounts and drawings account are also personal
accounts.

The rule for personal accounts is: Debit the receiver, Credit the giver

Impersonal Accounts: All other accounts which are not personal accounts are called Impersonal
Account. These are not related to persons. Impersonal accounts are of different types:

(@)

Real Accounts

Accounts relating to properties or assets are known as ‘Real Accounts’. A separate account is
maintained for each asset e.g., Cash Machinery, Building, etc., Real accounts can be further
classified into tangible and intangible.

(b)

Tangible Real Accounts: These accounts represent assets and properties which can be seen,
touched, felt, measured, purchased and sold. e.g. Machinery account Cash account, Furniture
account, stock account etc.

Intangible Real Accounts: These accounts represent assets and properties which cannot be
seen, touched or felt but they can be measured in terms of money. e.g., Goodwill accounts,
patents account, Trademarks account, Copyrights account, etc.

The rule for Real accounts is: Debit what comes in Credit what goes out
Nominal Accounts

Accounts relating to income, revenue, gain expenses and losses are termed as nominal accounts.
These accounts are also known as fictitious accounts as they do not represent any tangible asset. A
separate account is maintained for each head or expense or loss and gain or income. Wages
account, Rent account Commission account, Interest received account are some examples of
nominal account.

The rule for Nominal accounts is: Debit all expenses and losses Credit all incomes and gains.
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11.2.4 Debit And Credit

Whether a debit increases or decreases an account depends on what kind of account it is. In summary:
an increase to an asset account is a debit. An increase to a liability or to an equity account is a credit.

Conversely, a decrease to an asset account is a credit. A decrease to a liability or equity account is a

debit.

Debit Credit
Asset Increase Decrease
Liability Decrease Increase
Income/Revenue Decrease Increase
Expense Increase Decrease
Equity/Capital Decrease Increase

11.2.5 Accounting Principles

Accounting principles means those rules of action or conduct which are adopted in recording
accounting transaction. These principles can be categorized into two categories:

Accounting concepts
Accounting conventions

Accounting Concepts:

These refer to the accounting assumptions upon which accounting is based and accepted and obeyed
by all. Some of these concepts are as follows:

i)

ii)

iii)

iv)

V)

vi)

Business entity concept: According to this, a business is separate and distinct from the
person or persons who own it. The business and the businessman are considered two
separate things.

Money measurement concept: According to this, all business transaction are recorded
in the books of business in terms of money and transaction or events which cannot be
expressed in terms of money are not recorded in the books of account.

Going concern concept: According to this, it is assumed that business will continue to
operate for an indefinitely long period in the future. So the long term assets of business
are shown at their book value.

Accounting period concept: The life of business is supposed to be indefinite and the
owner of business cannot wait for a long period for the determination of its income.

Cost concept: According to this, a long term asset is recorded in the books at the price
paid to acquire it i.e. its actual cost and this cost is the basis of all subsequent accounting
for that asset.

Matching concept: According to this, to ascertain the profit made during a period, the
expenses incurred in the accounting period should be matched with the revenues realized
in that period.

Accounting Conventions:

These are used to signify customs and traditions that guides in the preparation of accounting
statements. These are following:

i)

Convention of consistency: According to this, same methods of accounting should be
used to record the business transactions every year, so that the result of the business can
be comparable of various years.

Convention of conservatism: According to this, all prospective losses should be taken
into consideration and leave all prospective profits. This convention compels the
accountant to safeguard the business against possible losses and uncertainties.

Convention of materiality: As per this, accountant should attach importance to material
details and ignore insignificant details there is almost unlimited amount of financial
information which can be provided for any business.

Convention of full disclosure: According to this, all the information must be honestly
disclosed in the books of accounts and in the financial statements.
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11.2.6 Accounting Terminology

It is necessary to understand some basic accounting terms which are daily used in business world.
These terms are called accounting terminology.

Transaction

“An event, the recognition of which gives rise to an entry in accounting records. It is an event which
results in change in the balance sheet equation. That is, this changes the value of assets and equity. In
a simple statement, transaction means the exchange of money or money's worth from one account to

another account. Events like purchase and sale of goods, receipt and payment of cash for services or
onpersonal accounts, loss or profit in dealings etc., are the transactions”. Transactions are of two

types:

1) Cash transaction: is one where cash receipt or payment is involved in the exchange.

ii) Credit transaction: will not have ‘cash’ either received or paid, for something given or

receive respectively. It gives rise to debtor and creditor relationship.

Debtor
A person who owes money to the firm mostly on account of credit sales of goods is called a debtor.
Creditor
These are the persons from whom goods are purchased on credit or a person to whom money is owing
by the firm is called creditor.
Capital
It means the amount (in terms of money or assets having money value) which the proprietor has
invested in the firm or can claim from the firm. It is also known as owner’s equity or net worth.
Owner’s equity means owner’s claim against the assets.
It will always be equal to assets less liabilities, say:
Capital = Assets - Liabilities.
Liability
It means the amount which the firm owes to outsiders that is, accepting the proprietors. In simple
terms, debts repayable to outsiders by the business are known as liabilities.
Asset

Any physical thing or right owned that has a money value is an asset. In other words, an asset is that
expenditure which results in acquiring of some property or benefits of a lasting nature. Assets are of
five types: Fixed, Current, Fictitious, Intangible and Wasting assets.

Goods

It is a general term used for the articles in which the business deals; that is, only those articles which
are bought for resale for profit are known as Goods.

Revenue

It means the amount which, as a result of operations, is added to the capital. It is defined as the inflow
of assets which result in an increase in the owner’s equity. It includes all incomes like sales receipts,
interest, commission, brokerage etc.,

Expense

The terms ‘expense’ refers to the amount incurred in the process of earning revenue. If the benefit of
an expenditure is limited to one year, it is treated as an expense (also know is as revenue expenditure)
such as payment of salaries and rent.

Expenditure

Expenditure takes place when an asset or service is acquired. The purchase of goods is expenditure,
where as cost of goods sold is an expense. Similarly, if an asset is acquired during the year, it is
expenditure, if it is consumed during the same year, it is also an expense of the year.

Purchases

Buying of goods by the trader for selling them to his customers is known as purchases. As the trade is
buying and selling of commodities purchase is the main function of a trade. Purchases can be of two
types i.e. cash purchases and credit purchases. If cash is paid immediately for the purchase, it is cash
purchases, If the payment is postponed, it is credit purchases.



Introduction to Tally

Sales

When the goods purchased are sold out, it is known as sales. It can be of two types: cash sales and
credit sales. If the sale is for immediate cash payment, it is cash sales. If payment for sales is
postponed, it is credit sales.

Stock

The goods purchased are for selling, if the goods are not sold out fully, a part of the total goods
purchased is kept with the trader unlit it is sold out, it is said to be a stock. If there is stock at the end
of the accounting year, it is said to be a closing stock. This closing stock at the yearend will be the
opening stock for the subsequent year.

Drawings

It is the amount of money or the value of goods which the proprietor takes for his domestic or
personal use. It is usually subtracted from capital.

Losses

Loss really means something against which the firm receives no benefit. It represents money given up
without any return. It may be noted that expense leads to revenue but losses do not.

Account

It is a statement of the various dealings which occur between a customer and the firm. It can also be
expressed as a clear and concise record of the transaction relating to a person or a firm or a property
(or assets) or a liability or an expense or an income.

Invoice

While making a sale, the seller prepares a statement giving the particulars such as the quantity, price
per unit, the total amount payable, any deductions made and shows the net amount payable by the
buyer. Such a statement is called an invoice.

Voucher

A voucher is a written document in support of a transaction. It is a proof that a particular transaction
has taken place for the value stated in the voucher. Voucher is necessary to audit the accounts.

Proprietor

The person who makes the investment and bears all the risks connected with the business is known as
proprietor.

Discount

When customers are allowed for any type of deduction in the prices of goods then that is called
discount. When some discount is allowed in prices of goods on the basis of sales of the items, that is
termed as trade discount, but when debtors are allowed some discount in prices of the goods for quick
payment, that is termed as cash discount.

Solvent
A person who is capable to pay his liability in full is called solvent.
Insolvent
A person whose liabilities are more than the realizable values of his assets is called an insolvent.
Bad Debts
The amount of debtors, which is irrecoverable, is called Bad debts. It is a loss which is incurred by
the business when debtor fails to pay or all the chances of recovery of debts are lost.
11.3 WOKING IN TALLY.ERP9
There are different ways for data processing in Tally. These are following:
Starting and Closing of TALLY.ERP9:

To start Tally: Click on START—-PROGRAMS—TALLY.ERP9. Tally can be opened or started by
double clicking on the icon of Tally if that is on desktop. When Tally is loaded, then Simplicity
screen is appeared. As the Start —up screen is available, working on Tally can be started. Screen of
Tally is as like:
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Elements of Tally Screen:

- Title bar: It consists version number, system date and time, and Tally version.

- Gateway of Tally: It consists menu, screen and reports and it accepts those options which are
responsible for availability of data and to see that data.

- Calculator ODBC Server: It is used for calculation work.

- Button Toolbar: It consists various buttons to do work in Tally. These buttons provide quick
interaction with Tally.

- Minimize Button: It is used to minimize Tally screen to switch over another application.
Switching in Screen Area:
As Tally started, Gateway of Tally screen is appeared. To work in that Gateway of Tally screen and
Calculator ODBC server Ctrl+N and Ctrl+M are used. These are used to switch over from one area to
another area. The active area of the screen is highlighted by green bar.
Exit From Tally:
For exit from Tally, press ESCAPE key until QUIT? YES or NO message is appeared on screen.
Then press ENTER or YES to exit. This can be done by pressing Ctrl+Q in Gateway of Tally.

11.4 CREATION OF VOUCHER AND INVOICE

A voucher is a document that contains the details of a financial transaction. For example, a purchase
invoice, a sales receipt, a cheque, a bank interest statement etc.

Groups, ledgers, types of vouchers and quit options are present in ‘Accounts Info’ menu. F11 key is
used to configure these options and after configuration ‘Accounts Info’ is shown like:

Gafeway of Tally

Groups
Ledgers

Woucher Types

it

11.4.1 Accounting Voucher:

Tally is pre-programmed with a variety of accounting and each used to perform a different job. There
are number of vouchers in Tally, which can be created, displayed, altered or deleted. These vouchers
are of following types:

1.Contra Voucher:
Contra Voucher is used to record below transaction: -
e (Cash transfer from one cash account to another (Cash a/c to petty cash a/c)
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e Cash deposit in the bank account
e Cash withdraw from the bank account
e Fund transfer from one bank account to another bank account
Contra voucher is created by:
Gateway of Tally. ERP9 Accounting Vouchers > F4: Contra

Contra Voucher Creation screen will appear as shown below:

Py & Mooept | Detete | Cancnt

— =
Tally MAIN —> Gatoway of Tally —> Accounting Voucher Cosation [c} Tally Schations Py, Lid, 1383 Sat, 16 May, 201° 072904

2.Payment Voucher:

Payment Voucher is used to record all cash & bank payments. In payment vouchers, entries related to
payment are defined. For examples 1. cash payment for conveyance. 2. Bank payment to supplier
settle purchase bills.

Payment voucher is created as follows:
Gateway of Tally.ERP9 Accounting Vouchers — F5: Payment

Payment Voucher Creation screen will appear as shown below:

[K: Comtsal Cantre| = Support Canlre| H: Halp

Siya Ram Lbd

Cur Bat 1395008 Cr
Particulars

Rent
Cur Bat d, MOLN Dy

Chrd + ™
{ich Tally Sokitions Pvt. Lid., 1963-2012  Thu, 26 Mar, 2005 065623

T) by project - Miroso... | (B kally projct pic
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3.Receipt Voucher:

Receipt Voucher is used to record all cash & bank receipts. For examples 1. Cash/bank received from
customer against sales.

It can be created by:
Gateway of Tally.ERP9 Accounting Vouchers — F6: Receipt
Ways of Adjustment: A number of ways are used for adjustment such as

- Advance:

- Against Reference:
- New Reference:

- On Account:

- Transaction:

4. Journal Voucher:

Journal Voucher is used to make adjustments in accounts. It does not involve any cash or bank
accounts. For example depreciation charged to the fixed assets, Rent payable entry etc.

[=RPT oY)

M: EMail 0= Uplead : Shep e |K:Keyboard | K: Comnl Centre| - Suppon Cantre| H: Help

nnnnnnnnn

5. Sales Vouchers:

Sales Voucher is used to record sales transaction whether it is Cash or Credit. Sales voucher can be
enter mainly in two modes.

Sales Voucher in Voucher Mode:

Voucher mode is used for simple sales entry with less detail. It is good for professionals because there
is no need to maintain inventory.

Sales Voucher in Invoice Mode

For enter Sales Voucher in Invoice Mode go to Gateway ot Tally > Accounting Voucher > Press
F8 or click on Sales Button from Right Side Button Menu.
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Sales Voucher also has two modes:
Sales Invoice As Account Invoice

Sales invoice as account invoice is used to record sales transaction without Inventory. It is generally
used by professionals such as doctors, advocates, chartered accountants etc for their service charges.
They don't use inventory features.

Sales Invoice As Item Invoice

Sales invoice as Item Invoice is used to record sales transaction with Inventory. It is generally used
for Trading, Manufacturing companies.

6. Purchase Voucher:

Purchase Voucher is used to record Purchase Transaction whether its Cash or Credit.
Purchase Voucher also has two modes:

Purchase Invoice as Account Invoice

Purchase Invoice as account invoice is used to record Purchase transactions without Inventory. It is
generally used in service industries or by professionals such as doctors, advocates, chartered
accountants etc for their service charges. They don't use inventory features.

Purchase Invoice as Item Invoice

Purchase invoice as Item Invoice is used to record Purchase transaction with Inventory. It is generally
used for Trading, Manufacturing companies.

7. Debit Note (CTRL + F9)

Debit Note is used to Debit the ledger / account of party for purchase return or escalation / de-
escalation in price or any other reason but mainly it is used for purchase return only.

8. Credit Note (CTRL + F8)

Credit Note is used to Credit the ledger / account of party for Sales return or escalation / de-escalation
in price or any other reason but mainly it is used for Sales Return only.

9. Memo Voucher:

These are non-accounting vouchers and do not affect the account at any cost. The enteries are not
specified in ledger. It can be created by configration of option of F11

11.4.2 Invoices:

An invoice, bill or tab is a commercial document issued by a seller to a buyer, relating to a sale
transaction and indicating the product, quantities, and agreed prices for products or services provided
by seller to the buyer.

Payment terms are stated on the invoice. These may specify that the buyer has a maximum number of
days in which to pay, and is sometimes offered a discount if paid before the due date. The buyer could
have already paid for the products or services listed on the invoice.

In the rental industry, an invoice must include a specific reference to the duration of the time being
billed, so in addition to quantity, price and discount the invoicing amount is also based on duration.
Generally each line of a rental invoice will refer to the actual hours, days, weeks, months, etc, being
billed.

A Typical Invoice Contains:
e The word invoice (or Tax Invoice).
e A unique reference number (in case of correspondence about the invoice)
e Date of the invoice.
e Credit terms.
e Tax payments if relevant (e.g. GST or VAT)
e Name and contact details of the seller
e Tax or company registration details of seller
e Name and contact details of the buyer
e Date that the goods or service was sent or delivered
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Purchase order number (or similar tracking numbers requested by the buyer to be mentioned
on the invoice)
Description of the product(s)
Unit price(s) of the product(s) (if relevant)
Total amount charged (optionally with breakdown of taxes, if relevant)

Payment terms (including method of payment, date of payment, and details about charges for
late payment)

There are different types of invoices:
1. Proforma invoice:

Proforma invoice is a document that states a commitment from the seller to provide specified
goods to the buyer at specific prices. It is often used to declare value for customs. It is not an
actual invoice, and thus the seller does not record a pro forma invoice as an account
receivable and the buyer does not record a pro forma invoice as an account payable. A pro
forma invoice is not issued by the seller until the seller and buyer have agreed to the terms of
the order. In some cases, a pro forma invoice is issued to request advance payments from the
buyer, either to allow production to start or for security of the goods produced.

2. Credit Memo:

When buyer returns the goods, the seller usually issues a credit memo for the same or lower
amount than the invoice, and then refunds the money to the buyer, or the buyer can apply that
credit memo to another invoice.

3. Commercial invoice:

This invoice is a custom declaration form used in international trade that describes the
parties involved in the shipping transaction, the goods being transported, and the value of
the goods. It is the primary document used by customs, and must meet specific customs
requirements, such as the Harmonized System number and the country of manufacture. It
is used to calculate tariffs.

4. Debit memo:

When a company fails to pay or short-pays an invoice, then it is common practice to issue
a debit memo for the balance and any late fees owed. Debit memos are identical to
invoices in function.
Self-billing invoice:

A self billing invoice is when the buyer issues the invoice to himself (e.g. according to
the consumption levels he is taking out of a vendor-managed inventory stock). The buyer
(i.e. the issuer) should treat the invoice as an account payable, and the seller should treat
it as an account receivable. If there is tax on the sale, e.g. VAT or GST, then buyer and
seller may need to adjust their tax accounts in accordance with tax legislation.

Evaluated receipt settlement (ERS):

ERS is a process of paying for goods and services from a packing slip rather than from a
separate invoice document. The payee uses data in the packing slip to apply the
payments. "In an ERS transaction, the supplier ships goods based upon an Advance
Shipping Notice (ASN), and the purchaser, upon receipt, confirms the existence of a
corresponding purchase order or contract, verifies the identity and quantity of the goods,
and then pays the supplier.

Timesheet:

Invoices for hourly services issued by businesses such as lawyers often pull data from a
timesheet. A timesheet invoice may also be generated by Operated equipment rental
companies where the invoice will be a combination of timesheet based charges and
equipment rental charges.

Statement:

A periodic customer statement includes opening balance, invoices, payments, credit
memos, debit memos, and ending balance for the customer's account during a specified
period. A monthly statement can be used as a summary invoice to request a single
payment for accrued monthly charges.
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9. Progress billing:

It is used to obtain partial payment on extended contracts, particularly in the construction
industry.

11.5 CREATION OF PAYROLL STATEMENT

Tally ERP9 performs all those functions which are necessary for any salary department. In Tally,
error free salary statement can be created without any special effort. A Salary slip can be created by
following steps:

Creation of Employee master: It consists all necessary information about the employee such as
department, date of joining, date of leaving, identity card number, place of joining, details of bank
account, passport details etc.

Creation of Payroll Master: This is based on payroll unit. And payroll unit consists information
related to calculation of pay head i.e. where the pay head calculation have been done.
Creation of Pay head: It consist the details about earning and deductions of employees. Some

example of pay head are basic pay, Dearness Allowance, uniform allowance etc. and deductions are
like ESI, TDS etc. Tally consists following details on Pay head:

- Earning by Employees - Bonus

- Deductions from Employees - QGratuity

- Employee’s Statutory Deduction - Loans and Advances

- Employee’s Statutory Contribution - Reimbursement to Employees

- Employee’s other Charges

Creation of Salary Statement: It consists of various information in salary details master such as
department of employee, salary of employee, earning and deduction etc.

Process of Payroll: It consists various vouchers for proper functioning as payroll voucher, payment
voucher etc. all the entries related to payroll are specified in these vouchers. These vouchers act as
input in the process of preparation of payroll.

PAY-SLIP:

Pay slip specifies the detail of salary of employee given to them from employer side. It consists the
details about earning and deductions of employees.

Pay-slip is created as:
Gateway of Tally > Display > Payroll reports > Statement of Payroll > Pay slip > Single Pay Slip
Then click the name of employee.

11.6 MAINTENANCE OF INVENTORY RECORDS

Any Business activity is specified by accepting and giving of items. In these items, different kinds of
things are included such as raw material, prepared and non prepared things etc.

Inventory Info menu consists following options:

- Stock Group: This is the group of things such as raw material.

- Stock Items: It consists the preparation of stock items such as TV, music system etc.

- Voucher Types: creation of vouchers is specified.

- Measurement of Units: It consist the information about measurement units as litre, meter, box etc.
- Quit: This is the option for quitting the menu.

It is necessary to get the information about stock group, stock items and measurement units before
creation of Inventory Info menu

» MEASUREMENT UNIT:
These are of two types: Single and Mixed unit
- Single Unit: When a single unit is used for stock item, then that is single unit.
- Mixed Unit: When two different units are used for stock item, then that is mixed unit.
» CREATION OF SINGLE STOCK GROUP:
Gateway of Tally.ERP9 > Inventory Info > Single Stock Group > Create
- Enter the name of Group.
- Select the name of categorized group
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Alteration of Single Group:
Gateway of Tally.ERP9 > Inventory Info > Single Stock Group > Alter
Display of Stock Group:
Gateway of Tally.ERP9 > Inventory Info > Single Stock Group > Display
Deletion of Single Group:
Gateway of Tally.ERP9 > Inventory Info > Single Stock Group > Alter

- Press Alt+D on keyboard

B Taliy. B2 8

ge ¥ Keyboand K: Control Centre | - Suppod Cenlre H: Help
Cunent Date:
142911 103132015 Tuesday, 1 Aps, 2014
List of Selected Companies
Name of Company Date of Last Erty
Siya Ras Ltd 1-Apr-2014

ateway of Tall .
Inventory Infa.

Stock Groups:
Stock ems
unis of Measure

Voucher Types

Quit

-ty MAIN — > Gabeway of Tally —> Imvenbary Info

PR T —

Creation of Multiple Stock group:
Gateway of Tally.ERP9 > Inventory Info > Single Stock Group > Create
- Select the Group, press Alt+c
- Enter the name of Groups.
Creation of Stock Unit:
Gateway of Tally.ERP9 > Inventory Info > Units of Measure > Create
Modify the Stock Unit:
Gateway of Tally.ERP9 > Inventory Info > Single Stock Group > Alter
This can be done also by pressing Alt+D
» STOCK ITEMS:
» These can be created as follows:

Gateway of Tally.ERP9 > Inventory Info > Stock items > Create

A new group or unit can be added by pressing Alt+C at that place where cursor is present.



Introduction to Tally

B ey 9 9

K: Keyboard K: Conisal Cenire| H- Suppor Cenire| H: Help

Hom

Steck Ibemn Creal

Mame : SHIRT
(adias)
Under © O Peimary Tax lsfsamation
L= S Tarff Clacsification - O Mot Applicable
Rate of Duty (eg 5) ]
Quantity Rate per Vabue
Opening Balarce 500 Pes 450000 Pos TN

{och T-ahy Soktions Pyt Lid, 1986-2012  Thu, 26Mar, 2005 (721212

@ B [ Thealy project -Moroso... | B kally projet pic B tabvere e "Bz soces win....

Alteration Of Stock Item
Gateway of Tally.ERP9 > Inventory Info > Stock items > Single Alter or Press Alt+D
11.7 MAINTENANCE OF ACCOUNTING BOOKS AND FINAL ACCOUNTS
Final accounts are created to calculate the profit and loss in a specific time period.
11.7.1 Modification in Report:

When report is displayed on screen after selection then modifications can be done on that report. It
can be done by pressing Alt+F1: Detailed/ Condensed. This is used to make the changes in reports.

F2: Period: This is used to modify the time period.

F3: Company: Used to select more than one company and to show the content of present selected
company.

F4-F10: functioning can be changed according to reports.

F11: Company Features: Used to select the option for voucher entries.

F12: Configure: Used to configure the report.

Alt+12: Range: Used to filter the information of data.

Ctrl+F12: Value: Used to select the type of voucher for calculation.

New Column: New Column can be added to compare the data of any company.

Delete Column: used to delete the column.

11.7.2 Day Book

It consist the entries of whole day. It is set for current date by default. All types of vouchers are
included for day book’s entries. Day book is created as follows:

Gateway of Tally.ERP9 > Display > Day Book
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10.7.3 Accounts Book
There are number of account books in Tally which are used in daily working. These are following:

9 E

- Cash book - Journal - Balance Sheet

- Petty Cash book - Sale register - Trial Balance

- Bank book - Purchase register - Profit and Loss account
- Ledger - Stock summary - Day book

- Group register - Stock item

10.7.4 Preparation of Financial Reports
There are various financial reports in Tally which are as follows:

- Trial balance: It is a list of all the general ledger account contained in the ledger of business.
It defines the closing balance of ledger account on a specific date it is prepared at the end of
accounting period to prepare the drafting of financial statement. It is created as follows:

Gateway of Tally. ERP9 > Display > Trial Balance

B Taly. 50 9
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- Balance Sheet: Balance sheet is a final financial statement that reveals the state of affair of
the company as on the data of report. Asset side list what the company owns and liabilities
side lists what the company owes.
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Balance sheet is specified as:

Gateway of Tally.ERP9 > Balance Sheet > F12: Configure

Liabilities as & 1-Apr214
Capital Accosst [T Fixed Assets
Capial 2,00,000.00 Fumiwe 20.000.00
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Current Assets 295080
Closing Stock
Sundry Debtors 9,000,600
Cashin-hand 14,050 00
Profit Loss A'c 205080
Opening
Cument Feriod 2.080.00
2,.2000000] Total
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- Profit and Loss account: The profit and loss a/c displays the figure of all nominal accounts

and the net profit/loss.
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10.7.5 Stock Summary

It specifies the available stock on a specific date. It does not have date with entries. So

user can see it any time.
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11.8 Value Added Tax (VAT) in Tally.ERP9
1. Introduction

2. VAT calculation
3. Salient Features of VAT in Tally.ERP9
4. VAT in Tally.ERPY:
4.1 Create a Company
4.2Enable VAT in Tally.ERP9
4.3 Create a Stock Item
4.4 Create a Supplier Ledger
4.5 Create a Customer Ledger
4.6 Create a Purchase Ledger
4.7 Create a sales Ledger
4.8 Create a VAT Ledger
5 Transaction for VAT calculation
6 VAT Reports
7 Payment

Value Added Tax (VAT)

1. Introduction
Value Added Tax (VAT) is defined as the tax that is levied at every stage of value
addition to the stock item. In India value added tax (VAT) was made implemented from
01-04-2005. The introduction of VAT replaced existing general sales tax.Input Tax Credit
is actually the sum paid as tax for acquiring the items. When this item is sold, the VAT
payable got adjusted against the input tax credit and the remaining balance is paid as the
VAT.

2. VAT Calculation
Input Tax: The tax paid which is paid on purchases.

Output Tax: The tax which is payable on sales.
Then the VAT Payable = Output Tax — Input Tax
Example:

Mr. Ravi, a registered dealer, purchased a stock item at 3500 by paying 5% tax on it,
that is, ¥25. Then he did a value addition of 250 on it & sold it. The total VAT
liability became X37.5 (5% on X750).

Thus, net VAT liability of Mr. Ravi for this stock item = 37.5 - 25 =12.5

There may be situation where the Input Tax paid for purchases is more than the Output
Tax, then the dealer will have two options. Either he can carry forward the excess amount
or can claim it as refund.

3. Salient Features of VAT in Tally. ERP9
1. A very simple and easy to use process.
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ii.  Facility of flexibility to create and change tax rates with dates.

iii.  Facility to define tax rates in VAT at various levels like that of company level,
group Level, ledger level, etc.

iv.  We can calculate tax in both the cases when MRP is either inclusive or exclusive.
v.  We can view all the tax payments with the challan details.

vi.  From the VAT returns, payment voucher can be made.

vii.  Tax invoice can be printed.

viii.  All the transactions can be tracked and categorized as Included, Excluded and
Uncertain.

ix. VAT return can be generated at any time.
x.  We can view the return summary.
xi.  Various required annexures can be generated.

|
Tally ERP9 has been updated for state specific VAT taxation with some added modules like
tax rates at Company Level, Group Level and Ledger or Item Level.

4. VAT in Tally.ERP9:

4.1 How to Create a Company?

Go to Tally --------- >F3: Company Information --- ------ >Create a Company

i.  Write the desired name in the Company Name
ii.  Fill the Address details
iii. In Statutory Compliance select India
iv.  Select State
v. Enter the Pin code, Contact details and E-Mail details
vi. Enable Auto Backup
vii.  Select Accounts with Inventory (Maintain field)
viii.  After entering all the details, the Company Creation screen
ix. Press Y or Enter to accept and save.

We will understand the concept with defining tax rate at ledger or item level.
The information of an already created company can be altered as follow:
Gateway of Tally 2 Alt+F3-> Co. info - Alter
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'—
Mailing Mame : Shisana Technology E
Address - Kunnil House Bakkalam, PO Kanul, Kannur
Country - India L
State d Karnataka | (
Pincode - 670562

4.2 How to enable VAT in Tally.ERP9?

Gateway of Tally ---—-- >F11 —---

i.  Enable Value Added Tax (VAT)

> Statutory & Taxation

Company: Shisana Technology

Statutory and Taxation

Enable Value Added Tax (VAT) ? Yes nable Tax Collected at &
Set/alter VAT details el Yos | Set/alter TCS details
B
ii.  Set Set/alter VAT details to yes.
VAT Details

State : Karnataka

TIM : 321210425355

Inter-state Sales Tax Number

Set/alter tax/rate details 7 Mo

Define VAT commodity and tax details as masters 7 [NEN

iii.  Save main screen and sub screens.

4.3 How to create a Stock Item?

Create STOCK ITEM e.g. ‘Computer’ where VAT @4%

Gateway of Tally ----- >Inventory Information

------- > Stock Items ------> Create



Introduction to Tally

Stock Item Creation
Name : Computer

(alias)

Under - 4 Primary Statutory Information

Units - Nos

VAT Applicable

olicab -1 Applicable
| Setfalter VAT details ?ﬁ| !

Quantity Rate per Value
Opening Balance

i.  Enter the details like name, etc. in the respective fields.
ii.  Set VAT applicable to applicable.
iii.  Set Set/Alter Vat Details to Yes
iv.  In the next screen, Tax/rate details Enter VAT Rate as 4%.

v.  Tax Type will be seen as ‘Taxable’ automatically, and will be displayed as ‘exempt’

if there is no tax rate.

Tax/Rate details

VAT Rate

Tax rate 84% |

(From 1-Apr-2013)
Tax type . Taxable

vi.  Click on enter and save the screen.
4.4 How to create a Supplier Ledger whose name is ‘Computer Solution’?

Gateway of Tally ------ >Accounts Info. - --- >Ledgers ------ > Create

i.  Submit all the details of creditor (Shown in image).
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Hame Compuier Solutions Total Op. Bal. |
{alias)
S0, 000 D
Diffevsrice
T ST il Mailing Details |
nder undry Creditors H
{Curment Liabifites) Pl fé:nm;’mahrre Somtiune |
Maintam bafancas bel-by-bill 7 Yos
Default credit period
Check for credit days duning voucher ey 7 Mo .
- Country India
Imventary values ars affected Ho State Nariscalis Piricods
Provide bank details No

Tax Reqistration Details
PAN /T No._ . AGCGDT256F
Satiflter VAT Details 7 FEE

Opening Balance | on 1-Apr-2015) :
0Q: Quit | & Accep D2 Dlislat | | ] | |

ii.  Set Set/Alter VAT Details to Yes
iii.  Submit the VAT details of supplier.
iv.  Enter Type of Dealer as Regular.

v.  Enter the valid TIN number of the dealer.

VAT Details
Type of Dealer : Regular
WAT TIM Mo o 20931245561

vi.  Press enter key and save the created Supplier Ledger with name of “computer
Solutions”.

4.5 How to create a Customer Ledger with the name of “Computer Point”?
Gateway of Tally ----- > Accounts Information ------ > Ledger ------ > Create

1. Enter all the required details of the customer.
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Ledger Alteration Shisana Techrolag,
Hame Computer Point _Total Op. Bal.
(alas)
50,000 00 D
Difference
50,000.00 Dr
Mailing Details
Under Sundry D"‘b'“"l’ ; Hame Computer Paint
(Currant Assels] Addrass
Maintain balances ball-by-bell T Yes
Default credit pariod :
Chack for credit days dunng voucher antry 7 No
Country India
vt 2l fected TN
ik Ak i g State Karnataka Pincods
Provide bank details Ho

PAN /T No
SetfAlter VAT Details

Tax Reqistration Details
3214456565
7 Yas

Opening Balance  { on 1-4pr-2015) : NI

The State name appeared automatically in case of creating customer ledger.

ii.  Set Set/Alter VAT details to Yes.
iii.  Then submit the required VAT details of the customer.
VAT Details
Type of Dealer : Regular
VAT TIN No. 8 3214552414, ]
iv.  Press Enter key and save the customer ledger with the name of ‘Computer Point’.
4.6 How to create a Purchase Ledger?
Gateway of Tally ------ > Accounts Information ------ > Ledgers ------ > Create
1. Enter all the details of purchase in this screen for purchase ledger creation.

223

Remarks



224

Remarks

Computer Applications in Business

| K: Keybaoand

| 1§: Gontral €

Touai . Bal

-.-dmu- Croation
Nama Purchase @4%
(alias]
540,000.00
Difference
S0 OO0 0
Mailing Details
WUnclar Purchase Accounts Marma
Address
Iventorny values are afected T Yes
Type of Ledgsr 7 4 Mot Applicable
Piowvede bank details Ho
Siatutory Information
Is VATICST Applicable 7 4 Applicable Tax Registralion Hatails
@ PAN T Mo

SevAler VAT Details

Set the Set/Alter VAT Details to No here.

il.
iii.  Press enter key and save the purchase ledger.
4.7 How to create a sales Ledger?
Gateway of Tally ------ > Accounts Info. ------ > Ledgers ------ > Create

A separate ledger for Sales @4% needs to be created.

1.
Ledger Creation
Nams Sales@d% Total Op. Bal.
{ahaz)
50,000.00 Dr
Lifference
50,000.00 Dr
Mailing Details
Under Sales Accounts Namna
Mddress
Imventony values are affected ? Yes
Type of Ledger 7 4 Hot Applicable
Prowvide bank details No
Statutory Information
Is VAT/CST Applicable 7 Applicable Tax Reqistration Details
7 AN | IT Mo :

Setislter VAT Details

{ on 1-Apr-2015) ;

Opening Balance
[ Chiskat |

0 Quit | Accepl
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iil.

1v.

Set the Set/Alter Vat Details to Yes

Set the Tax rate 4% in the new window

It is to be noted that Tax type will automatically be appeared as “Taxable”.

Tax/Rate details

Transaction Info
Nature of transaction 4 Undefined

VAT Rate
Tax rate
{From 1-Apr-201.5)
Tax type Taxable

6. Then enter the correct tax rate (with displaying applicable date)
7. Press the Enter key and save the screen. And at last save the newly created Sales Ledger.
4.8 How to create a VAT Ledger?

Gateway of Tally = Accounts Information - Ledgers = Create
Select Duties & Taxes in ‘Under”

Enter VAT in Type of duty/tax

1.
ii.
iii.
iv.

Enter Percentage of calculation: 0 %
Enter all other required details.
Name VAT Jotal Op. Bal.
(alas]
50,000.00 Dr
Difference
S0,000.00 Dr
Mailing Details
Undar Duties & Taxes Name S
(Current Liablities) Address
Type of dutytax VAT
Irvventony valuas are affecied 7 No
Percantage of Calculation (sg 5) T 0%
(0% for comman fedger]
Prowde bank details No
Statutory Information Tax Registration Details
PAN T Na.
Accapt 7

g Qull

s Aocet

Opening Balance | on 1-Apr2015) :
|

Yo o Mo
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v.  Press the enter key and save the newly created VAT ledger.
5 Transaction for VAT calculation
There may be described two types of transaction required for VAT calculation:
A. Purchase Transaction
B. Sales Transaction
A. Purchase Transaction for VAT Calculation
E.g. 10 computers were purchased from “computer solutions” at the rate of Rs. 25000
per computer.To create this purchase transaction, follow as:
Gateway of Tally ----> Accounting Vouchers ------ > F9: Purchases

i.  Then enter the details like Transaction date, Supplier Invoice Number & Name,
Product Name, Quantity or Number, Price Rate, etc.

ii.  After this when Enter in VAT ledger, Total Amount and Tax Amount will be
calculated automatically.

iii.  Set the provided VAT Details to Yes in the bottom
iv.  Thereafter a new form will appear for submitting the required additional details of the
purchase tax (Input Tax)

v. e-Sugam Number: When the e-Sugam-XML file generated from Tally.ERP9 is
submitted to the Department website, a unique acknowledgement number which is
called e-Sugam number is generated which has to be entered here.

vi.  Invoice Delivery Date is displayed here.
vii.  Dispatch and delivery place have to be entered.
viii. VAT Category Types enlisted for e-Sugam is displayed as a list from which one has
to be selected on the basis of the nature of transaction.
ix.  Document Type: The required document has to be selected here on the basis of nature

of transaction.
Additional Details : Purchase Taxable
Inwaice no CS 5689 [Date 1 lpr2015
e-Sugam Details
a-Sugam Numbet KA1 54565
Imvarce Delvary Diate 1-Apr-2015
From Flace Bommasandra To FlaceiDestination) Bangalore City
Category of Transaction V.A After Sale
Document Type INV Invoice
Trensporier Mame(Camer NamedAgent) . KRS Vehicle NumbenDespatch through)  KA-05.2564
Bill of lading/LR-RR Mo 456 Date 1-Apr-2015
Quantity with Units

X. Save this.
B. Sales transaction
E.g. 5 computers were sold at the rate of Rs. 27000 per computer with 4% VAT
which are purchased by the ‘Computer Point’.
To create this sales transaction follow the below given path:
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Gateway of Tally ----- > Accounting Vouchers ------ > F8: Sales
1. Set VAT details to Yes

2. Enter the required VAT details.
3. Enter the quantity and other required details.

e-Sugam Details
e-Sugam Number KA46556
Invoice Delvery Data - 1-Apr2015
From Place Bangalore City To Place{Destination) Mangalore
Category of Transaction VL To His Shop/Godonnl Storage
Documernit Type STM Stock Transfer Memo
Transporter Name(Carier MamafAgent) . VRL Vehicle Nurber{Despatchthrough) - KA 18 B 4565
Bill of lading/LR-RR No LR 265544 Date 1-Apr-2013
Quantity with Uinits

4. Press Enter key and save this newly created Sales Transaction.

6 VAT Reports
To view the VAT reports, follow the below given path:
Gateway of Tally ----> Display ----> Statutory Reports ----> Form VAT 100

i.  The information like Assessable Value, total Tax amount, net tax payable amount,
etc. will be displayed in this report.

|72 Peru & Espan A = Upinad | 5 Shap i Longaugs K B Conued Cemna | | Bupyon Comrs 18- Hafp
| Farm VAT 1040 1-Age2015 10 W Apr- 2015
| Sntintics of Vo hars

fisial ftwmbsor ol | remociom

0
2
L

Wiahor Tax Amaunl
__ngmogo
4.70,609.56
| Tanal 3,70,300.00 B4
|Purchasas :
gl.vnlpw:luu: 250,000,040
Taxatsa 3.50 003 00
Total 1.50.000.00
| Payabla
Detaliy T-Ape 2085 40 30-Apy-2015
| Tx parymiend (echuded)
| Tax payments {rdl ischadediuncerta)
INATICET Paid
[Balanen VATAL ST Payatin
| G

it .
| Fisly MUK —= vy ol Ty -~ Dopliry Mevws --= Statinesy Papsoris —+ VAT Bgo = Foom VAT 109 frh Ty Sodpteares Pt 08, LRE- P00 Fru k2 Feby, 2014 LE ]

ii. Payable VAT amount should be paid in the subsequent month.

ili. By pressing ALT+P, VAT computation report can be obtained (sample is given
below).
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1 2 3 F 5 [ 7 5 1 1 11 1z 13 " 15 18 17 ] i3 b 4|
Remarks s sl biadin oshtssdast st badiamdsasad i mdaiedwiss bt b by

=

- Shisana Technology
g = Funnil House Bakkalan PO Kanul Kannur

= VAT Computation
i 1-Apr-2015 to 30-Apr-2015

z Page 1
‘- Stafistics of Vouchers

= Total Number of Transactions 2
§o—= Included Transactions 2

: Annexure Ready [

Annexure Emors 2

= Man Annexure Vouchers 1]

= Excluded Transactions 0
= Uneerain Transactions 0

= Particulars Assessable Value Tax Amount

= S5ales :
L Local sales 2,70,000.00 10,800.00

E Taxable 2 70.000.00 10,800.00
i Total 2,70,000.00 10,200.00

Purchases :

z Local purchasas 2,50,000.00 10,000.00
10— Taxable 2.50,000/00 10,000.00

3 Total 2.50,000.00 10,000.00
Ll Payable B00.00

E Payment Detail s 1-Apr-2015.10 J0-Apr-2015
12— Tax payment (induded)

= Tax payments (not includediunceriain)
13— VATICST Paid

3 Baance VATICST Payable 200,00
7 Payment

For payment, VAT returns in prescribed formats (according to states) are to be
submitted.
Gateway of Tally ---> Accounting Vouchers---> F5: Payment

A= Hirgtaaid B Comrd Coure | 1) Guppon Camus | 15 Halg

P -
TeMIyPE
Actowd  Bale Bank of India
Cor Sa' SO0 Cr
Famieulary Arsnung
VAT
Cor el 000 Dr
HarTahod
t 1
e vk pele P Ty oI OF Apnd X115 Acewp 7
Wi = Blir
Q) et o Accept AT | Camcel
Ty M -~ = Gitdwary of Tally - AITDamag Veuits? ARavaan Tef Tadly Sokiteane Pt (d, F388-2000 Fr, L1 Feb, 2016 Lduling
=

After the successful payment, VAT liability becomes nil. The VAT Ledger also
becomes Zero.

SUMMARY OF THE LESSON
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You learnt the following in this lesson:

e Tally.ERP9 is accounting software that is easy to use.

e Tally is used to create different types of vouchers and invoices.

e Tally is used to check the profit and loss in any business.

e Management accounting performs the functioning of data collection, arrangement and
analysis.

e Trial balance, Balance sheet and profit and loss statements are the part of financial
accounting.

e Debit and Credit are the basic terminology used in accounting.

o Tally consist Startup and Quit activities for the processing.

o Entry, capital, assets, debtor, and liabilities etc. are the keywords used in accounting.

o To specify the credit of any party, credit note is used.

e To define the debit of any company, debit note is used.

e Purchase Voucher is used to record Purchase Transaction whether its Cash or Credit.

e Sales Voucher is used to record sales transaction whether its Cash or Credit. Sales voucher
can be enter

¢ Inventory menu consist different options such as stock group, stock item, types of vouchers,
measurement units and quit etc.

e Trial balance is a list of all the general ledger account contained in the ledger of business. It
defines the closing balance of ledger account on a specific date

e Balance sheet is a final financial statement that reveals the state of affair of the company as
on the data of report.

e Stock summary specifies the available stock on a specific date. It does not have date with
entries.

SELF ASSESSMENT QUESTIONS AND EXERCISES
Discuss the categories of accounting.
Name the documents used in financial accounting.

How personal account is categorized?
Discuss the features of Tally.ERP9.
What is the use of title bar in TallyERP9?
Differentiate payment and journal voucher.
What are the schemes of adjustment in receipt voucher?
Why sales voucher is used?
What is stock summary?
. How single unit ledgers are created?

A N o

—_
— O

. Differentiate stock item and stock group.
. What are components of Tally.ERP window?

—_
W N

. Discuss the way of creation of single stock group.
. Discuss the concept of financial reports with its different types.
. Outline the process of creation of payroll statement

—_
(SN




CHAPTER-12

INTRODUCTION TO STATISTICAL PACKAGES
OBJECTIVES OF THIS LESSON
This lesson is aimed to make you understand the concepts of statistical packages. Readers will be able
to understand the following:
e Concept and features of SPSS as Statistical package and its uses.
e Concept of SYSTAT as powerful and statistical graphical software.

e Use of SYSTAT for analysis of complex statistical calculations.

STRUCTURE OF THIS LESSON

11.1  Introduction
11.2  SPSS (Statistical Package for the Social Sciences)
11.3  Version History
11.4  Opening SPSS
11.5 Layout of SPSS
11.6  Exiting SPSS
11.7  Systat
11.8  Starting Systat
11.9  Using Gui in Systat

Summary of the Lesson

Self Assessment Questions and Exercises

12.1 INTRODUCTION

Statistical package is a computer program that has the capability to perform statistical analysis. This
package specifies the results of statistical techniques. There are a number of statistical packages
available in market such as ADMB, DAP, JAGS, SOFA statistics, SYSTAT, SPSS etc.

SPSS is window based program that is used to explain statistical data. It is also used for making
tables and graphs. SYSTAT is also used for statistical work and it consist presentations of desktop
statistics package.

12.2 SPSS (STATISTICAL PACKAGE FOR THE SOCIAL SCIENCES)

SPSS, (the Statistical Package for the Social Sciences) has been developed by three students at the
University of Stanford ( Norman H. Nie, C. Hadlai (Tex) Hull and Dale H. Bent). Initially not meant
for distribution outside their home university, the publication of the first manual made SPSS widely
known and used. Initially developed for IBM mainframe computers, versions for most other
important mainframe brands (Univac, CDC, Honeywell...,) and later for so-called minicomputers
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(like DEC, PRIME) were available. SPSS Inc. was the founded in 1975. In 2009 IBM acquired
SPSS; it is now fully integrated into the IBM Corporation Business Analytics Software portfolio.

The software name originally stood for Statistical Package for the Social Sciences (SPSS), reflecting
the original market, although the software is now popular in other fields as well, including the health
sciences and marketing.

SPSS is a Windows based program that can be used to perform data entry and analysis and to create
tables and graphs. SPSS is capable of handling large amounts of data and can perform all of the
analyses. SPSS is commonly used in the Social Sciences and in the business world.

SPSS is a widely used program for statistical analysis in social science. It is also used by market
researchers, health researchers, survey companies, government, education researchers, marketing
organizations, data miners, and others. In addition to statistical analysis, data management (case
selection, file reshaping, creating derived data) and data documentation (a metadata dictionary was
stored in the datafile) are features of the base software.

Statistics included in the base software:

e Descriptive statistics: Cross tabulation, Frequencies, Descriptives, Explore, Descriptive Ratio
Statistics

e Bivariate statistics: Means, t-test, ANOVA, Correlation (bivariate, partial, distances),
Nonparametric tests

e Prediction for numerical outcomes: Linear regression

e Prediction for identifying groups: Factor analysis, cluster analysis (two-step, K-means,
hierarchical), Discriminant

The many features of SPSS Statistics are accessible via pull-down menus or can be programmed with
a proprietary 4GL command syntax language. Command syntax programming has the benefits of
reproducibility, simplifying repetitive tasks, and handling complex data manipulations and analyses.
Additionally, some complex applications can only be programmed in syntax and are not accessible
through the menu structure. The pull-down menu interface also generates command syntax: this can
be displayed in the output, although the default settings have to be changed to make the syntax visible
to the user. They can also be pasted into a syntax file using the "paste" button present in each menu.
Programs can be run interactively or unattended, using the supplied Production Job Facility.

Additionally a "macro" language can be used to write command language subroutines. A Python
programmability extension can access the information in the data dictionary and data and dynamically
build command syntax programs. SPSS Statistics places constraints on internal file structure, data
types, data processing, and matching files, which together considerably simplify programming. SPSS
datasets have a two-dimensional table structure, where the rows typically represent cases (such as
individuals or households) and the columns represent measurements (such as age, sex, or household
income). Only two data types are defined: numeric and text (or "string"). All data processing occurs
sequentially case-by-case through the file. Files can be matched one-to-one and one-to-many, but not
many-to-many.

The graphical user interface has two views which can be toggled by clicking on one of the two tabs in
the bottom left of the SPSS Statistics window. The 'Data View' shows a spreadsheet view of the cases
(rows) and variables (columns). Unlike spreadsheets, the data cells can only contain numbers or text,
and formulas cannot be stored in these cells. The "Variable View' displays the metadata dictionary
where each row represents a variable and shows the variable name, variable label, value label(s), print
width, measurement type, and a variety of other characteristics. Cells in both views can be manually
edited, defining the file structure and allowing data entry without using command syntax. This may
be sufficient for small datasets. Larger datasets such as statistical surveys are more often created in
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data entry software, or entered during computer-assisted personal interviewing, by scanning and using
optical character recognition and optical mark recognition software, or by direct capture from online
questionnaires. These datasets are then read into SPSS.

SPSS Statistics can read and write data from ASCII text files (including hierarchical files), other
statistics packages, spreadsheets and databases. SPSS Statistics can read and write to external
relational database tables via ODBC and SQL.

Statistical output is to a proprietary file format (*.spv file, supporting pivot tables) for which, in
addition to the in-package viewer, a stand-alone reader can be downloaded. The proprietary output
can be exported to text or Microsoft Word, PDF, Excel, and other formats. Alternatively, output can
be captured as data (using the OMS command), as text, tab-delimited text, PDF, XLS, HTML, XML,
SPSS dataset or a variety of graphic image formats (JPEG, PNG, BMP and EMF).

SPSS Statistics Server is a version of SPSS Statistics with a client/server architecture. It had some
features not available in the desktop version, such as scoring functions. (Scoring functions are
included in the desktop version from version 19.)

12.3 VERSION HISTORY
e SPSS6(1968),7,8,9

o SPSS* (1983) (the X standing for version 10) was a major revision, SPSS* 2 and 3 followed,

then the * was dropped and numbering of new versions continued SPSS 4,5,6
e SPSS7,8,.... 15: Version 7, at least on some computers, had an interactive user interface

e SPSS Statistics (2008) 16, 17.0: major revision, user interface rewritten in Java (solved the
problem of having different versions on different platforms, now the Windows, Mac and
Linux versions are published at the same time. SPSS also added "Statistics" to the name of

the product formerly simply called SPSS.

e PASW Statistics (2009) 17.02 and version 18:: name change to Predictive Analytics Software
Statistics [note that on the SPSS Website PASW and SPSS Statistics are used

interchangeably]

e IBM SPSS Statistics (2010): After SPSS Inc has been acquired by IBM, the new official
name is IBM SPSS Statistics

12.4 OPENING SPSS

We can open SPSS in one of two ways.

1. If there is an SPSS shortcut icon on the desktop, simply put the cursor on it and double click the
left mouse button.
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2. Click on the start button, then All Programs. Select SPSS for Windows.

Seven Tl P e tmis LT ——

B EM Yew [oin [raeshem dubve (g Nies  hogns  fndes  Hep
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File: includes all of the options we typically use in other programs, such as open, save, exit.

Utilities: allows you to list file information which is a list of all variables, there labels, values,
locations in the data file, and type.

Edit: includes the typical cut, copy, and paste commands, and allows to specify various options for
displaying data and output.

View:allows you to select which toolbars you want to show, select font size, add or remove the
gridlines that separate each piece of data, and to select whether or not to display your raw data or the
data labels.

Data: allows you to select several options ranging from displaying data that is sorted by a specific
variable to selecting certain cases for subsequent analyses.

Transform: includes several options to change current variables.

Analyze: includes all of the commands to carry out statistical analyses and to calculate descriptive
statistics.

Graphs: includes the commands to create various types of graphs including box plots, histograms,
line graphs, and bar charts.

Add-ons: are programs that can be added to the base SPSS package.

Window: can be used to select which window you want to view (i.e., Data Editor, Output Viewer, or
Syntax).
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Help: has many useful options including a link to the SPSS homepage, a statistics coach, and a
syntax guide.

12.5 LAYOUT OF SPSS

The Data Editor window has two views that can be selected from the lower left hand side of the
screen. Data View is where you see the data you are using. Variable View is where you can specify
the format of your data when you are creating a file or where you can check the format of a pre-
existing file. The data in the Data Editor is saved in a file with the extension .sav. The other most
commonly used SPSS window is the SPSS Viewer window which displays the output from any
analyses that have been run and any error messages. Information from the Output Viewer is saved in
a file with the extension .spo.

One of the primary ways of looking at data file is in Data View, so that you can see each row as a
source of data and each column as a variable (e.g., characteristic or property of each data source).

We click on the Data View tab so that we can enter and edit the data points themselves. Typically, we
enter the data (and certainly edit the data) after establishing the names and other properties of the
variables in a data set explained below under Variable View.

IF DATA1.sav - SPSS Data Editor
Hile Edit View Data Irensform Analyze Graphs Uliities Window Help
EfEE R EE e = E TS
]1 1 :gender I
subjnum | gender ig var var var var =
1 101 Male 115.00
2 102 Male 118.00
3 103 Male 12000
1 104 Male 125.00
5 105 Wiale 122.00
& 106] Female 125.00
7 107| Female 122.00
8 108| Female 118.00
9 109 Female 115.00
10| 10| Female 120.00
i1
12
(3
14
15
16
-
, Data View blE ViEw /. e | Ll_i
[SPSS Processor is ready [ 7

SPSS Data in Variable View

We click on the Variable View tab to define or change the names and other properties of each
variable in the data set:
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I DATA1.sav - SPSS Data Editor I (] P2

File Edit View Data Transform Analyze Graphs Utiliies Window Help

R EERE R

MName Type Width Decimals: Label Values Missing =
1 [subjnum Mumeric g il Participant Mumber|Mone Mone
2|gender Mumeric g 1] Gender 1, Male}. . Mone
3liq Numeric 3 2 1Q Score MNone Mone
4
5
f
i
] ]
9
10
i
2
12
14
15
16

3] T —

= 8 %
4 [+ [\ Data Vighy ) variable View / [N | Ll
[SPSS Processor is ready \ | 4

In this view, each variable is represented as a row, and various properties of the variable are
represented as columns, allowing us to change the properties of existing variables or establish
properties for new variables.

The variable properties and their functions are:

Name -- the unique variable name

Type -- the kind of data to be recorded (e.g., strings of characters, numeric values, or special
numbers like dates)

Width -- the number of characters used to display the data
Decimals -- the number of decimal places displayed

Label -- a text entry to describe the data provided by the variable, which can be much longer
than the variable name and may include spaces. With questionnaires, for example, the label is
usually the text of the question.

Values -- if specific numeric values have a non-intuitive meaning, these values can be labeled
(e.g., 1 =male and 2 = female)

Columns -- determines how wide the variable column should be in Data View mode
Align -- determines whether the data should be left-justified, right-justified, or centered

Measure -- describes the level of measurement (e.g., nominal, ordinal, or scale)

Navigating SPSS Output

The SPSS output window is split into two frames. There is a navigation frame on the left and the
output itself in a frame on the right.
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I Output1 - SPSS Viewer 1 ] 3
File Edit View Inssrt Format Analyze Graphs Ufiifies Window Help
=R R
e[| +|-] io] =[=(5]
B8] output a
=) E Descriptives [~
[ Title
Iy Mt Tt i
e De::r\pt\ve Statistics Descrl ptlves
=} E Freguencies
-((] Title
MNotes
- L Statistics Descriptive Statistics
[B Gender
Std.
N Minimum | Maximum Mean Deviation
12 Score 10 11500 12500 | 1200000 350801
Walid M {listwise) 10
% Frequencies
Statistics
Gender —
Mo Walid 10
Missing 0
Gender -
KAl | LH
[¥ [SPSS Processar is ready [ I 4
12.6 EXITING SPSS

To close SPSS, we can either left click on the close button located on the upper right hand corner of
the screen or select Exit from the File menu.

12.7 SYSTAT

SYSTAT is a statistics and statistical graphics software package, developed by Leland Wilkinson in
the late 1970s, who was at the time an assistant professor of psychology at the University of Illinois at
Chicago. SYSTAT was incorporated in 1983 and grew to over 50 employees.

In 1995 SYSTAT was sold to SPSS Inc., who marketed the product to a scientific audience under the
SPSS Science division. By 2002, SPSS had changed its focus to business analytics and decided to sell
SYSTAT to Cranes Software in Bangalore, India. Cranes formed Systat Software, Inc. to market and
distribute SYSTAT in the US, and a number of other divisions for global distribution. The
headquarters are in Chicago, Illinois.

By 2005, SYSTAT was in its eleventh version having a revamped codebase completely changed from
Fortran into C++. Version 13 came out in 2009, with improvements in the user interface and several
new features.

System requirements

» Windows 32 bit (Vista, XP, 2000) * Pentium-level 32 bit processor

* 128 MB RAM (512 recommended) * 220 MB free disk space (inclusive of manual

PDFs, 85 MB)
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* CD-ROM drive * Internet Explorer 6
* SVGA adapter and monitor

12.8 STARTING SYSTAT

To start SYSTAT for Windows NT4, 98, 2000, ME and XP:

Choose: Start —All Programs—SYSTAT 12

Creating Data/Importing/Saving Data

To create data, click File->New->Data, and enter the dataset. You can also import data by using File-
>QOpen->Data. The supported file formats for import include Excel, SPSS, SAS, MINITAB, and JMP.
Once inputted, data can be saved in the SYSTAT file format.

The SYSTAT user interface

The organization of the user interface is somewhat complicated. The command window is a .syc file
that appears at the bottom of the screen. SYSTAT outputs the results of commands in a .syo file,

MYSTAT: A Student Yersion of SYSTAT - [Untitled.syo] g@[zl
=

i File Edit view Data Ufiliies Graph Analze QuickAccess Window Help o
LEdd sBe SR OFRR R e R i 0 @ L i B ]
| PTimesNewRomac- 30 - |E /B 7 0@ EE === @A A @ &5
x
. " %
+|lMVSTAT}AstUdBHtVE Startpage - Untitled.syo® | Temperature syz Graphl
A
o
a
a o
a0 o o
- s o -
o a o a
Qo
E o a
=] fes]
= )
> L O
- ] I3
[oe nlle vae]
9, (=) k=
0+ o o -
=]
(=l =
o
<
<
0 \ \ L L \
< » 10 20 30 40 50 60 70
Outp... Exam... Dyna.. JANTEMP &
X USE Tewperature.syz
LIST JULYTEMP
QPLOT JULYTEMF JANTEMP
PLOT JULYTEMP*JANTEHNP
Interactive | Log |Untitledl.syc® | Untitled syc® - X
Dong QGRAPH | HTM UM

which is accessible by clicking on a tab toward the top of the screen. Any graphics are also outputted
to a separate tab. SYSTAT stores the results of user commands in the Workspace window on the left
of the screen.

The user has two options for analysis with SYSTAT: using the GUI, or using the command line.

To run a command, right click in the .syc file. You then can choose to run the current line or to run
the commands from the current line to the end. To specify a specific data set to use, type “USE
FileName.extension”.

Here’s an example of running commands on the SYTAT user interface.

The SYSTAT user interface
The user interface of SYSTAT is organized into three spaces:
I. Viewspace
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II. Workspace

1. Commandspace

Viewspace has the following tabs

Output Editor: Graphs and statistical results appear in the Output Editor. You can edit, print and
save the output displayed in the Output Editor.

Data Editor: The Data Editor displays the data in a row-by-column format. Each row is acase and
each column is a variable. You can enter, edit, view, and save data in the DataEditor.

Graph Editor: You can edit and save graphs in the Graph Editor.
Startpage: Startpage window appears in Viewspace as you open SYSTAT. It has five sub-

windows.

1.Recent Files 1v. Manuals
ii. Tips v. Scratchpad
111. Themes

Workspace has the following tabs

Output Organizer: The Output Organizer tab helps primarily to navigate through the results of your
statistical analysis. You can quickly navigate to specific portions of output without having to use the
Output Editor scrollbars.

Dynamic Explorer: The Dynamic Explorer can be used to rotate 3-D graphs, apply power
transformations to values on one or more axes, and change the confidence intervals, ellipses, and
kernels in scatter plots.

Command space has the following tabs

Interactive: In the Interactive tab, you can enter commands at the command prompt (>) and issue
them by pressing the Enter key.

Untitled: The Untitled tab enables you to run the commands in the batch mode. You can open, edit,
submit and save SYSTAT command file (.syc or .cmd)

Log: In the Log tab, you can view the record of the commands issued during the SYSTAT session
(through Dialog or in the Interactive mode).

SYSTAT Data, Command and Output files
Data files:

You can save data files with (.SYZ) extension.
Command files:

A command file is a text file that contains SYSTAT commands. Saving your analyses in a command
file allows you to repeat them at a later date. These files are saved with (.SYC) extension.

Output files:

SYSTAT displays statistical and graphical output in the output Editor. You can save the output in
(.SYO), Rich Text format (.RTF) and HyperText Markup Language format (*.HTM).

The Data Editor
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The Data Editor is used for entering, editing, and saving data. Entering data is a straightforward
process. Editing data includes changing variable names or attributes, adding and deleting cases or
variables, moving variables or cases, and correcting data errors.

SYSTAT imports and exports data in all popular formats, including Excel, ASCII Text, Lotus, BMDP
Data, SPSS, SAS, StatView, Stata, Statistica, JMP, Minitab and S-Plus as well as from any ODBC
compliant application.

12.9 USING GUI IN SYSTAT

Basic statistics can be found under the Analyze tab. To analyze column variables, click Analyze-
>Basic Statistics. To analyze row variables, click Analyze->Row Statistics. You can also use the
Analyze bar to get contingency tables, scatter plot matrices and correlation matrices, and stem-and-
leaf plots. To get basic graphs, use the Graph tab. Options include histograms

L= (O]

File Edit View Data Ulililies Graph Anahze GQuickAccess Window Help o
DEEG 2R S0 0ERmIFE | e b K Akon. oH |k & @ w5 L B v
E - - JEIB £ UR|E Y
m = Startpage /Llntitlad.syn* )/Temperature.syz I/Graphl/l/TastE.syz ] X
1 A Student Wersion of S¥ST
itled.syz CITY$ | JANTERD (TEMP iR B R | VAR VAR )
AYSTAT 12\Datal Temperatur “ 4 . S 1
nalyze: Regression: Least Squares
AYSTAT 12\DatalTemperatur ; Alkbm”' C;Hh | PR !
any-Schen e
Bar Chart ¥ Model | Estimation | Options | Predict| Fesampling
AYSTAT 12\Datal Taste, svz 3 Wlentown, Bet...
AYSTAT 12\DatalTaste. syz 4 |atlanta, GA Available variable(s): Dependent
List Cases - JANTEMP 8 [Birmingham, AL ALICIEME
Hypothesis Testing: Paired b T [Boston, hiA Independent(s).
Paired t-test i i JULYTEMP
) & (Bridge port-wilt. Add -
Hypothesis Testing: Paired b
Paired t-test 8 Buffalo, N
10 |Canton, OH
11 |Chattanooga, ...
Incude constant
12 lonicago, I = ]
13 [Cincinnati, OH... [5ave
14 |Cleveland, OH
15 |Columbus, OH
16 Dallas, TX
I (CTEC
18 Denver, CO 2
£ bl B3 >
Out Exa.. | D¥N... |pata variable
* LIST SCORE A
HNELN SCORE
LIST JAWNTENF
TESTING
TTEST JANTEMF JULYTEMP
E Interactive | Log |Untitled.syc* X
IFnr Help, press Fi. QGRAPH HTM UM

We can also do a regression analysis using the GUI. Click Analyze->Regression and choose what
type of regression you want to do. Options include least squares and logit regression. SYSTAT will
output summary information, including residual plots. Some of the regression output will show up on
in the Workspace window toward the left of the screen. Other options include bootstrapping and
normality tests.

Using the GUI for Least Squares regression
We can also do ANOVA using the GUI. Click Analyze->Analysis of Variance.
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Basic command lines in SYSTAT

Construct a qqplot QPLOT varname

Plot Y*X PLOT VarY*VarX

Sort by a variable SORT varname

Normality test CSTATISTICS varname/ ADTEST SWTEST
Ttest TESTING

TTEST varl var2

Bootstrap from a dataset | USE Filename.extension

SAMPLE BOOT (nsamples,sample_size)/ MEAN MEDIAN
CSTATISTICS variablel variable2

Summary statistics CSTATISTICS varname

Features of SYSTAT

e Unmatched Graphics Made Easier to Use

SYSTAT provides a large variety of scientific and technical graphing types, which helps to produce
the right type of graph for every need. Its Interactive Graphics Dialog can be used to change multiple
aspects of your graphics using a single integrated dialog. We can compare subgroups, overlay charts,
transform coordinates, add geographic projections, change colors, symbols, and more, to create
insightful presentations. You can change graph locations, point- and- click to alter axis labels, scales,
colors and symbols.

e Powerful New Data Manipulation Features

SYSTAT provides innumerable data manipulation features to get data in the right form for the
intended analysis. With a simple menu - dialog we can transform, sort, trim, center, standardize,
select, rank, label, group, reshape, or weight your data.Tha data file’s value can be enhanced with
additional information such as study details, variable information, variable labels, value labels,
processing conditions, etc. We can save effort using undo and redo in the Data Editor up to 32 steps
in the same session. We can increase data accuracy with widened data field of (23, 15). We can name
your variables, including string variables, using up to 256 characters. We can obtain basic variable
statistics and histogram from the Variable Properties dialog.

e Analyze Larger Data Sets with Greater Speed

When we use SYSTAT, we are allowed to work on very large amount of data. The software does
very fast processing of that data in very small amount of time. This saves user time.

o Less efforts and more results

SYSTAT software saves efforts of user in terms of defining the data and kind of processing to be
done. There are many options for statistical processing.

SUMMARY OF THE LESSON
You learnt the following in this lesson:

o SPSS, (the Statistical Package for the Social Sciences) has been developed by three students at
the University of Stanford ( Norman H. Nie, C. Hadlai (Tex) Hull and Dale H. Bent).

e SPSS base software includes Descriptive statistics, bivariate statistics, Prediction for numerical
outcomes and Prediction for identifying groups.
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SPSS Statistics can read and write data from ASCII text files (including hierarchical files), other
statistics packages, spreadsheets and databases.

SPSS Statistics can read and write to external relational database tables via ODBC and SQL.
The data in the Data Editor is saved in a file with the extension .sav.

SPSS supports many statistical features for data processing.

SYSTAT is computer software used for statistical processing of data.

SYSTAT base software includes features for data processing, power analysis, creating many
types of charts and graphs etc.

This software component was basically designed for statistical processing, but now a days it is
extended to be used in multiple application areas.

User interface of SYSTAT is defined in 3 spaces:
a. View space
b.Work space
c. Command space

SYSTAT data file is a file which contains data. This file can be created, edited and saved for
future reference. The extension of data file in SYSTAT is .syz.

The very important feature of SYSTAT is that it includes very high graphics capabilities which
allows a user to analyze and process data in any format.

SELF ASSESSMENT QUESTIONS AND EXERCISES

—

What are the statistics included in SPSS base software?

What are the views available in Graphical User Interface (GUI) of SPSS?
Explain different ways to open SPSS.

Differentiate between Data View and Variable view.

What is the functionality of variable view?

Describe the history of SPSS.

What do you mean by SYSTAT software?

Explain the version history of SYSTAT.

A e A U o

What are the software requirements of using SYSTAT?

—
(=)

. How the user interface is designed in SYSTAT?
. What are data files? Explain the role of data files in SYSTAT.

=
N =

. Describe the main features of SYSTAT that makes it different from other statistical

softwares.
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